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Chapter : 1.1 Objectives 

 

Objectives 

 At the end of the course the user will be able to 

 Understand, how the computer works? 

 Know the different characteristics and components. 

 Understand the computer-number system. 

 Know the ASCII code and UNICODE. 
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Chapter: 1.2 What is Computer 

Topic: 1.2.1 Introduction to Computer 

 

Introduction to Computer 

 The term "Computer" is derived from the Latin word "Computare" which means 

"to compute" or "to calculate." 

 Computers are machines that perform tasks or calculations according to a set of 

instructions or programs. 

 It is an electronic device used to store data and gives the results accurately 

within a fraction of second. 

 

FIG 1.1: Computer 

 Computers are extensively used everywhere. 

 It mainly consist of four basic unit such as, 

 Input Unit 

 Storage Unit 

 CPU 

 Output Unit 
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 Classification of Computer 

 Analog Computer 

 Hybrid Computer 

 Digital Computer 

 

FIG 1.2: Types of Computer 

Analog Computer 

 An analog computer represents the data as physical quantities and operates on 

the data by manipulating the quantities. 

 It is designed to process data in which the variable quantities vary continuously. 

 

FIG 1.3: Analog Computer 
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Hybrid Computer 

 A hybrid is a combination of digital and analog computers. 

 It combines the best features of both types of computers, i.e. It has the speed of 

an analog computer and the memory and accuracy of digital computer. 

 It accepts analog signals, converts them into digital and processes them in digital 

form. 

 A hybrid computer may use or produce analog data or digital data. 

 It accepts a continuously varying input, which is then converted into a set of 

discrete values for digital processing. 

 

FIG 1.4: Hybrid computer 

Digital Computer 

 A digital computer is designed to process the data in numerical form, its circuits 

perform mathematical operations of addition, subtraction, multiplication and 

division. 

  The numbers operated on by a digital computer are expressed in the binary 

system. 
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 Digital Computers are generally classified by size and power as follows 

 Micro Computer 

 Mini Computer 

 Mainframe Computer 

 Super Computer 

 Micro Computer 

 Micro Computer is a small, relatively inexpensive computer with a 

microprocessor as its CPU. 

 The invention of the microprocessor (single chip CPU) gave birth to the much 

cheaper microcomputers. 

 

FIG 1.5: Micro Computer 

 Micro Computers are commonly divided into four types such as 

 Desktop 

 Laptop 

 Notebook 

 PDA (Personal Digital Assistant) 
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 Desktop Computer 

 A desktop computer is a personal computer (PC) in a form intended for 

regular use at a single location. 

 Early desktop computers are designed to lie flat on the desk, while 

modern towers stand upright. 

 Most modern desktop computers have separate screens and keyboards. 

 

FIG 1.6: Desktop Computer 

 Laptop Computer 

 A laptop is a portable computer that has same capabilities as a desktop, 

but is small enough for easy mobility. 

 

FIG 1.7: Laptop computer 

 



E-Content of 

IT TOOLS AND BUSINESS SYSTEM 

Page | 9  
 

 Notebook Computer 

 A notebook computer has a keyboard with an attached screen. 

 A notebook's screen is thinner than the usual desktop computer monitor 

because the machine is designed to be portable, which is why the 

notebook itself is small, compact, and lightweight. 

 

FIG 1.8: Notebook Computer 

 Personal Digital Assistant (PDA) 

 Personal Digital Assistant (PDA) is a device similar to a computer that fits 

in the palm of users hand and allows them to collect information such as 

contacts, appointments, files, programs, and more. 

 

FIG 1.9: PDA 
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 Mini Computer 

 Mini computers were designed for control, instrumentation, human interaction, 

and communication switching as it is distinct from calculation and record 

keeping. 

 

FIG 1.10: Mini Computers 

 A small, multi-user computer that can support 10 to hundred users 

simultaneously. 
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 Mainframe Computers 

 Mainframe Computers is a powerful multi-user computer that can support 

thousand users simultaneously. 

 Mainframe computers can also process data at very high speeds, i.e., 

hundreds of million instructions per second and they are also quite expensive. 

 Normally, they are used in banking, airlines and railways, etc. for their 

applications. 

 

FIG 1.11: Mainframe Computers 

 Super Computer 

 Super Computers are best in terms of processing capacity and also the most 

expensive one. 

 An extremely fast computer that can perform hundreds of millions instructions 

per second. 

 

 

FIG 1.12: Super Computer 
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Chapter: 1.3 Characteristics of Computer 

Topic: 1.3.1 Characteristics of Computer 

 

Characteristics of Computer 

 Computers have some important features which have made them so popular. 

 A Computer can be categorized according to 

 Speed 

 Accuracy 

 Versatility 

 Reliability 

 Power of remembering 

 Diligence 

 Storage 

 Speed 

 Computers work at an incredible speed. 

 It can carry out instructions at a very high speed. 

 A powerful computer is capable of performing about 3-4 million simple 

instructions per second. 

 It can perform arithmetic and logical operations within a fraction of second. 

 Accuracy 

 Computer provides a high degree of accuracy. 

 Computers perform all jobs with 100% accuracy. 

 The degree of accuracy of a computer depends on the instruction and 

processor type. 

 

 

 Versatility 

 Computer is versatile in nature. 
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 It can perform different types of task easily. 

 At one moment user can use the computer to prepare a letter document and 

in the next moment they may play music or print a document. 

 Power of remembering 

 A computer can store and recall any information because it has secondary 

storage. 

 All information can be retained as long as desired by the user and that can be 

recalled almost simultaneously and accurately even after several years. 

 Diligence 

 Computers can perform long and complex calculations with the same speed 

and accuracy from the start till the end. 

 Being a machine, a computer does not suffer from the human traits of 

tiredness and lack of concentration. 

 Storage 

 Large volume of data and information can be stored in the computer and also 

retrieved whenever required. 

 Computer has two types of storage. They are Primary storage and Secondary 

storage. 

 In Primary Storage, a limited amount of data can be stored temporarily like 

RAM, ROM. 

 Secondary storage can store a large amount of data permanently like floppy 

and compact disk.  
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Chapter: 1.4 Components of Computer System 

Topic: 1.4.1 Components of Computer System 

 

Components of Computer System 

 The computer is an electronic device that accepts (reads) data from the user and 

processes the data by performing calculations and operations on it, and 

generates (writes) the desired output. 

 A computer consists of four major components such as 

 Input Devices (Input Unit) 

 CPU (Processing Unit) 

 Memory (Storage Unit) 

 Output Devices (Output Unit) 

 

FIG 1.13: Components of Computer 

Input Unit 

 An input device is a hardware or peripheral device used to send data to a 

computer. 

 An input device allows users to communicate and feed instructions and data to 

computers for processing, display, storage and/or transmission. 

 The important and most commonly used input devices are 

 Keyboard 

 Mouse 

 

 Other input devices are 
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 Joystick 

 Scanner 

 Barcode Reader 

 

CPU (Processing Unit) 

 The CPU is the heart of the computer, it is the part of a computer which interprets 

and executes instruction. 

Functional block of CPU 

 The two components in CPU are 

 Arithmetic and logic unit (ALU) 

 Control Unit (CU) 

 

 

 

FIG 1.14: Functional block of CPU 

 

 

 Arithmetic and logic unit (ALU) 

 The ALU performs arithmetic and logical operations. 

 Arithmetic operations include addition, subtraction, multiplication and division. 
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 Logical operations include comparing numbers, letters and special 

characters. 

 The ALU is a fundamental building block of the Central Processing Unit of a 

computer. 

 Control Unit (CU) 

 A Control Unit (CU) handles all processor control signals. 

 It directs all input and output flow, fetches code for instructions from micro-

programs and directs other units and models by providing control and timing 

signals. 

Memory Unit 
 

 Computer memory is a device that stores computer's data and programs. 

 

FIG 1.15: Computer Memory (RAM) 

 It stores program, data results or any kind of information. 

 Memory stores binary information, i.e. 0's and 1's in internal storage areas in 

the computer. 

 Moreover, the term memory is usually used as shorthand for physical memory, 

which refers to the actual chips capable of holding data. 

 

 Some computers also use virtual memory, which expands physical memory onto 

a hard disk. 
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Output Unit 

 Output devices are peripheral equipment that converts a computer's output to a 

form that can be seen, heard or used as an input for another device, process or 

system. 

 The important output devices, which are used in computer systems are 

 Monitors 

 Printer 

 Graphic Plotter 
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Chapter: 1.5 Computer-Number System 

Topic: 1.5.1  Computer-Number System 

 
Computer - Number System 

 A computer can understand positional number system where they are only in the 

form of digits, alphabet, symbols, video, audio, etc., 

 But the computer can understand only 0s and 1s, so it converts all data into 0s 

and 1s. 

 A value of each digit in a number can be determined using 

 The digit 

 The position of the digit in the number 

 The base of the number system (where base is defined as the total number of 

digits available in the number system). 

 Number system used in the computer is classified into 

 Binary number system 

 Decimal number system 

 Octal number system 

 Hexadecimal number system 

 

FIG 1.16: Classification of Number System 
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Chapter: 1.5 Computer-Number System 

Topic: 1.5.1A Binary Number System 

 

Binary number system 

 The binary number system is a numbering system that represents numeric 

values using two unique digits (0 and 1). 

 

FIG 1.17: Binary and Decimal Numbers 

 It is also called as base (2) number system. 

 Each position in a binary number represents a 0 power of the base (2), that is, 20. 

 The last position in a binary number represents x power of the base (2), that is, 

2x where x represents the last position 1. For e.g. 1101.101(2) 
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FIG 1.18: Digits Representation of Binary Number 

 

 The leftmost bit is called Most Significant Bit (MSB) and the rightmost bit is called 

Least Significant Bit (LSB). 

 

 

FIG 1.19: MSB and LSB 

Example 
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Chapter: 1.5 Computer-Number System 

Topic: 1.5.1B Decimal Number System 

 

Decimal Number System 

 The number system that we use in our day-to-day life is the decimal number 

system. 

 The decimal number system has a base 10 as it uses 10 digits from 0 to 9. 

 In decimal number system, to the left of the decimal point represent units, tens, 

hundreds, thousands and so on. 

 Each position represents a specific power of the base (10). 

 

 

FIG 1.20:  Representation of Place Values 

 

 

 

FIG 1.21: Digits Representation of Decimal Number 

 

Example 



E-Content of 

IT TOOLS AND BUSINESS SYSTEM 

Page | 22  
 

 

 

 The above example shows that, decimal number 5319(10), weight of each digit is 

power of 10. 

 Each digit has position number is from right(0) to left(3).That is first digit on right 

is zero, the second digit on the right is 1 and so on up to 3. 
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Chapter: 1.6 Conversion to and from other number systems 

Topic: 1.6.1 Conversion to and from other number systems 

 

Binary to Decimal Conversion 

 Multiply each bit by 2n, where n is "weight" of bit. 

 The weight is position of the bit, which starts from 0 on right, then 1 and goes on. 

 Add the result. 

Example 

 The decimal equivalent of 100111 (2) is 3910) 

 

 

Decimal to Binary Conversions 

 The easiest way to convert decimal to its binary equivalent is to use division 

algorithm. 

 Divide by two, keep track of remainder at each step. 

 Put remainder bit as 0, if that number gets divided by two. 

 Put remainder bit as 1, if that number is not divided by two. 
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Example 

 The Binary equivalent of 25(10)  is 11001(2) 
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Chapter: 1.7 ASCII Code 

Topic: 1.7.1 ASCII Code 

 

Introduction to ASCII Code 

 ASCII stands for "American Standard Code for Information Interchange". 

 ASCII character encoding provides a standard way to represent characters using 

numeric codes. 

 These include upper and lower-case alphabetic characters, numbers, and 

punctuation symbols. 

 ASCII was actually designed for use with teletypes and so the descriptions are 

somewhat obscure. 

 ASCII codes are broadly classified into three groups 

 Non printable ASCII codes 

 Printable ASCII codes 

 Extended ASCII codes 

 Non printable ASCII codes 

 33 non printable special characters. The first 32 characters (decimal value 

from 0 to 31) which represent letters, digits, punctuation marks and a few 

miscellaneous symbols. 
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FIG 1.22: Non-Printable ASCII characters (Codes) 

 Printable ASCII codes 

 94 standard printable characters (decimal value range from 33 to 126) which 

represent letters, digits, punctuation marks and a few miscellaneous symbols. 

 The following table originates from the older, American systems, which 

worked on 7-bit character tables. 
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FIG 1.23: Standard or Lower ASCII characters and codes 

 

 Extended ASCII codes 

 Extended ASCII uses eight instead of seven bits, which adds 128 additional 

characters. 

 This gives extended ASCII the ability for extra characters, such as special 

symbols, foreign language letters and drawing characters. 

 Some important things to note about ASCII codes 
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 The numeric digits, 0-9, are encoded in sequence starting at 30h (HEX). 

 The upper case alphabetic characters are sequential beginning at 41h. 

 The lower case alphabetic characters are sequential beginning at 61h. 

 The first 32 characters (codes 0-1Fh) and 7Fh are control characters. 

 Most keyboards generate the control characters by holding down a control 

key (CTRL) and simultaneously pressing an alphabetic character key. 

 

               

FIG 1.24: Extended or Higher ASCII characters and codes 
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Chapter: 1.8 Unicode 

Topic: 1.8.1 Unicode 

 

Unicode 

 Unicode is a universal character encoding standard. 

 It defines the way individual characters are represented in text files, web pages 

and other types of documents. 

 ASCII, which was designed to represent only basic English characters, but 

Unicode was designed to support characters from all languages around the 

world. 

 The standard ASCII character set supports only supports 128 characters, while 

Unicode can support roughly 1,000,000 characters. 

 While ASCII uses only one byte to represent each character, Unicode supports 

up to 4 bytes for each character. 

 The Unicode chart contains U+0000 to U+FFFF Unicode characters. 

 The table shows the range of U+0000 to U+0BFF Unicode characters, decimal 

values from 0 to 3071 and the name of Unicode characters from Basic Latin to 

Tamil. 
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FIG 1.25: Unicode Characters 
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Chapter : 1.9 Summary 

Topic : Summary 

 

 In this class, user have learnt about 

 basics of computer 

 characteristics of computer 

 components of computer system 

 concept of computer number system 

 ASCII code 

 Unicode 
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Chapter : 1.10 Model Questions 

Topic : Model Questions 

 

 Describe basic units of computer. 

 Explain different types of computer. 

 Write about the advantages of computer. 

 Describe Memory Unit. 

 What is the concept of Computer-Number system? Explain it. 

 What are the three different sections in ASCII code? 

 Describe Unicode characters with chart. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 



E-Content of 

IT TOOLS AND BUSINESS SYSTEM 

Page | 33  
 

                                                      Assessment 1  
 

1. A ________________ is a combination of digital and analog computers. 

a) Microcomputer 

b) Hybrid computer 

c) Mainframe computer 

d) Mini computer 

 

2. Which of the following are components of Central Processing Unit (CPU)” 

a) Arithmetic logic unit, Mouse 

b) Arithmetic logic unit, Control unit 

c) Arithmetic logic unit, Integrated Circuits 

d) Control Unit, Monitor 

 

3. Which number system is also called as base (2) number system? 

a) Decimal  

b) Octal 

c) Hexadecimal 

d) Binary 

 

4. In which of the following form, data is stored in a computer ? 

a) Decimal  

b) Binary 

c) Hexadecimal 

d) Octal 
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5. The standard ASCII character set supports only supports _______ characters. 

a) 128  

b) 124 

c) 156 

d) 172 

Answers: 

1.b 

2.b 

3.d 

4.b 

5.a 
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Assessment 2  
 

1. Unicode was designed to support characters from all languages around the world. 

a) True 

b) False 

2. ASCII stands for "American Standard Code for Information Interpretors". 

a) True 

b) False 

3. The decimal number system has a base 10 as it uses 10 digits from 0 to 9. 

a) True 

b) False 

 

Answers: 

1.a 

2.b 

3.a 
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Chapter : 2.1 Objectives 

 

Objectives 

 At the end of the course the user will be able to  

 understand the processing unit 

 know different types of memory 

 understand, what is Multimedia? 

 know the relationship between software and hardware 

 know the concept of compiler 
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Chapter : 2.2 Introduction to Computer Organization 

Topic : 2.2.1 Introduction to Computer Organization 

 

Introduction to Computer Organization 

 Computer Organization refer to the operational units and their interconnection 

that realize the architectural specifications. 

 Computer Architecture refers to those attributes of a system visible to a 

programmer. 

 Architectural attributes that include instruction set, number of bits used to 

represent various data types (numbers, characters), I/O mechanism and 

techniques for addressing memory. 

 Organizational attributes that include those hardware details transparent to the 

programmer, such as control signals, interfaces between the computer and 

peripherals and the memory technology used. 

 

 

FIG 2.1: Processing of computer organization 
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Chapter : 2.3 Central Processing Unit (CPU) 

Topic : 2.3.1 What is CPU? 

 

What is CPU? 

 CPU stands for Central Processing Unit. 

 The Central Processing Unit (CPU) is the brain of the computer, it is a part of 

computer which interprets and executes instruction. 

    

 

FIG 2.2: Central Processing Unit 
 

 It is also known as microprocessor or processor. 

 

FIG 2.3: Processor 
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 The task of performing operations like arithmetic and logical operations is called 

processing.  

 The CPU takes data and instructions from the storage unit and makes all sorts of 

calculations based on the instructions given and the type of data provided. It is 

then sent back to the storage unit. 

 It processes the instructions that it collects by decoding the code in programs. 

 The CPU chip is usually in the shape of a square or rectangle and has one 

notched corner to help place the chip into the motherboard properly. 

 The main functions of CPU are to Fetch, Decode, Execute and Write back.  

 

 

FIG 2.4: CPU Processor in Motherboard 

 The CPU contains  

 Arithmetic and Logic Unit (ALU) 

 Control Unit (CU) 
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 Arithmetic and Logical Unit 

 The Arithmetic and Logic Unit performs arithmetic and logical operations. 

 Arithmetic operations include addition, subtraction, multiplication and division. 

 

 

 

FIG 2.5: Arithmetic Operations 

 Logic Unit 

 Logic Unit performs following operations such as AND, OR, NOT, XOR, NOR, 

NAND, etc. 

 

 

FIG 2.6: Logical Operations 
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 Control Unit 

 A Control Unit (CU) handles all processor control signals.  

 It generates timing signals such that the coordination among devices take 

place. 

 Control unit is designed in two ways such as 

 Hardwired control  

 Micro-program control 

 Hardwired control 

 The Design is based on a fixed architecture.  

 The CU is made up of flip-flops, logic gates, digital circuits and encoder & 

decoder. 

 Micro-programs 

 Micro-programs are stored in a special control memory and are based on 

flowcharts.  

 They are replaceable and ideal because of their simplicity. 

 It directs all input and output flow, fetches code for instructions from micro 

programs and directs other units and models by providing control and 

timing signals. 

 And also Central Processing Unit includes Arithmetic logic unit and control 

unit. It has five major operations such as 

o It accepts data as input. 

o It stores data and instruction. 

o It processes data as per instruction. 

o It controls all operations inside a computer. 

o It gives result in the form of output.  
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Chapter : 2.3 Central Processing Unit (CPU) 

Topic : 2.3.2 Processor Speed and Booting 

 

Processor Speed 

 A microprocessor (processor or CPU) is where the instructions of a program are 

processed. (show image) 

 The high level language that the programmer uses is transformed into a binary 

code that the CPU understands and creates an executable file that will launch 

the program when double-clicked.  

 A hertz is one cycle per second, 1 MHz is 1 million cycles per second and 1000 

MHz is 1 GHz( one billion cycles per second). (refer video) 

 If user have a CPU at 2 GHz(animation: that is 2000 MHz), it can do 2 billion 

program instructions per second. 

Steps to find the CPU speed in different operating system 

 To find the CPU speed in Windows XP “click the START button, then scroll go to 

my computer and right click on that and select Properties”. 

 User can also find the CPU speed by Help and Support Center. 

 To find the CPU speed in Vista and Windows 7 “click the START button and 

scroll to Control Panel then select the System and Security, in that click on the 

System”. 

 For checking CPU speed in Macs “ click on the apple menu and select About this 

Mac". 

 For advanced Windows users of Windows XP “click the START button and select 

RUN “. 

 

Booting 

 Booting is the initialization of the computerized system.  

 The booting process can be “hard” when electrical power to the CPU is switched 

from off to on.  
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 Soft booting can be initiated by hardware such as a button press, or by software 

command.  

 A boot loader is a computer program that loads an operating system or some 

other software for the computer. 

  

FIG 2.7: Boot Sector 

 Boot sector refers to a single sector (normally the first in the active partition) that 

contains the code to boot the operating system.  

 A sector of a hard disk, floppy disk or similar data storage device that contains 

code for booting programs (usually, but not necessarily, operating systems) 

stored in other parts of the disk.  

 Before the boot sector is read, the computer’s BIOS will call a small program 

called an MBR (Master Boot Record), which normally resides in the first record of 

the first disk.  

 The small program stored in the boot sector is then executed and the operating 

system will begin to load. 

 To be a valid boot sector, the two-byte hex word 0xAA55, called the boot sector 

signature, must exist at the end of the sector.  

 Otherwise, either the BIOS or MBR code will report an error message and halt 

any OS bootstrapping process. 
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Chapter : 2.4 Memory 

Topic : 2.4.1 Hierarchy Memory 

 

Memory  

 The Memory Unit is the part of the computer that holds data and instructions for 

processing. 

 It stores program results or any kind of information. 

 Memory stores binary information i.e. 0's and 1's. 

 Memory is measured in bytes. 

Types of Memory 

 The computer memory is divided into two types, they are 

 Primary or Main memory 

 Secondary memory (Secondary Storage Device) 

 

FIG 2.8: Types of Memory 
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Primary memory  

 Primary Memory is used for immediate access of data by the processor. 

 Most computer systems around the world use primary memory. 

 Primary memory can be divided into two types. 

 RAM (Random Access Memory) 

 ROM (Read Only Memory) 

 RAM (Random Access Memory) 

 Random Access Memory is the central storage unit in a computer system. 

 The information stored in the RAM is typically loaded from the computer's 

hard disk, and includes data related to the operating system and certain 

applications. 

 

FIG 2.9: RAM 

 There are primarily two forms of RAM  

 Static RAM (SRAM)  

 Dynamic RAM (DRAM) 

 

 Static RAM (SRAM) 

 In SRAM, a bit of data is stored using the state of a flip-flop. This is most 

expensive among other forms of RAMs, but is generally faster and 

requires less power than DRAM and, in modern computers, is often used 

as cache memory for the CPU. 

 

 Dynamic RAM (DRAM) 
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 Widely used in modern computers as primary memory, DRAM is slower 

than SRAM, but is inexpensive due to its one transistor-one capacitor 

paired assembly of memory storage. 

 ROM (Read Only Memory) 

 ROM stands for Read Only Memory. 

 The CPU can only fetch or read instructions from ROM. 

 ROM comes with instructions permanently stored inside. 

 

FIG 2.10: ROM 

 And these instructions cannot be over-written by the computer's CPU. 

 Types of  ROM 

 PROM – Programmable Read Only Memory 

 EPROM – Erasable Programmable Read Only Memory 

 EEPROM – Electrically Erasable Programmable Read Only Memory 

 PROM  

 PROM Stands for "Programmable Read-Only Memory," and is pronounced           

"p-rom," not "prom".  

 PROM is a type of  ROM  that is programmed after the memory is 

constructed. 

 PROM chips have several different applications, including cell phones, video 

game consoles, medical devices, and other electronics.  

 They provide a simple means of programming electronic devices. 
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 While PROM cannot be erased, two other versions of PROM have been 

developed that can be erased and reprogrammed. 

 EPROM  

 EPROM stands for Erasable Programmable Read-Only Memory. 

 This type of memory uses floating-gate transistors and can be erased by 

strong ultraviolet light. 

 EEPROM 

 EEPROM stands for Electrically Erasable Programmable Read-Only 

Memory.  

 EEPROM can be erased with an electrical charge and is used in flash 

memory. 

Secondary Memory (Secondary Storage Device) 

 Secondary Memory refers to storage devices, such as hard drives and Solid State 

Drives (SSD). 

  It may also refer to removable storage media, such as USB flash drives, CDs, 

and DVDs. 

 Secondary memory is much slower than primary memory, it typically offers a far 

greater storage capacity.  

 Secondary memory includes 

 Floppy disk 

 Hard disk drive 

 Optical disk 

 USB thumb drive 
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 Floppy disk 

 These are small removable disks that are plastic coated with magnetic 

recording material. 

 This portable storage device is a rewritable media and can be reused a 

number of times. 

 

FIG 2.11: Floppy Disk  

 

 Hard disk drive 

 Another form of auxiliary storage is a hard disk.  

 A hard disk consists of one or more rigid metal plates coated with a metal 

oxide material that allows data to be magnetically recorded on the surface of 

the platters. 

 

FIG 2.12: Hard Disk Drive 
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 Optical disk 

 An Optical disk is any storage media that hold content in digital format and is 

read using a laser assembly is considered as optical media.  

 The most common types of optical media are Blu-ray, CDs, and DVDs. 

 CDs can store up to 700 megabytes (MB) of data. 

 DVDs can store up to 8.5 GB of data. 

 Blu-ray discs, which are the newest type of optical media, can store up to 50 

GB of data. 

 

                         Blu-ray               CD              DVD 

 

FIG 2.13: Types of Optical Disk 

 CD 

 CD  is an abbreviation of compact disk, and is a form of data storage that can 

transfer data up to the speed of 7800 KB/s. 

  A standard 120 mm CD holds up to 700 MB of data, or about 70 minutes of 

audio.  

 There are two types of CD: CD-ROM and CD-RW. 

  CD-ROM are stands for CD-Read Only Memory and they function in the 

same way as Read Only Memory does.  

 CD-RW Stands for CD-Rewritable, these disks can be erased and rewritten at 

any time. 
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 DVD 

 DVD is an abbreviation of Digital Versatile Disc, and is an optical disc storage 

media format that can be used for data storage.  

 The DVD supports disks with capacities of 4.7 GB to 17 GB and access rates 

of 600 KBps to 1.3 MBps.  

 A standard DVD disc store up to 4.7 GB of data.  

 There are two types of DVD's 

 DVD-ROM  

 DVD-RW 

 DVD-ROM 

 DVD-ROM stands for DVD-Read Only Memory and they function in the 

same way as Read Only Memory does.  

 DVD-RW  

 DVD-RW stands for DVD-Rewritable, these disks can be erased and 

rewritten at any time. 

 USB Thumb Drive 

 A USB flash drive is a data storage device that includes flash memory with an 

integrated Universal Serial Bus (USB) interface. 

 USB flash drives are typically removable and rewritable, physically much 

smaller than an optical disc. 

 

FIG 2.14: USB Drive 

 USB drives that are often used for floppy disks were used, i.e., for storage, 

back-up and transfer of computer files. 

 They are smaller, faster and have thousands of times more capacity, durable 

and reliable. 
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Chapter : 2.4 Memory 

Topic : 2.4.2 Cache Memory 

 

Cache Memory 

 A CPU cache is a cache used to reduce the average time to access memory.  

 The cache is a smaller, faster memory which stores the copies of the data from 

frequently used main memory locations. 

 Most CPUs have different independent caches, including instruction and data 

caches, where the data cache is usually organized as a hierarchy of more cache 

levels (L1, L2 etc.). 

 

 

FIG 2.15: Cache Memory Processing 

 When the processor needs to read from or write to a location in main memory, it 

first checks whether a copy of that data is in the cache or not.  

 If so, the processor immediately reads from or writes to the cache, which is much 

faster than reading from or writing to main memory. 
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Cache Memory Entries 

 Data is transferred between memory and cache in blocks of fixed size, called 

cache lines.  

 When a cache line is copied from memory into the cache, a cache entry is 

created. 

  A cache entry will include the copied data as well as the requested memory 

location that is called tag. 

 When a processor needs to read or write a location in main memory, it first 

checks the corresponding entry in the cache.  

 The cache checks for the contents of the requested memory location in any 

cache lines that contain address.  

 Cache Hit 

 If the processor finds that the memory location is in the cache, a cache hit has 

occurred.  

 If cache hit, the processor immediately reads or writes the data in the cache 

line. 

 Cache Miss 

 If the processor does not find the memory location in the cache, a cache miss 

has occurred. 

 In cache miss, the cache allocates a new entry, copies data from main 

memory.  

 Then the request is fulfilled from the contents of the cache. 

 
Structure of the Cache Entry 

 Cache row entries usually have the following structure 

Tag data block flag bits 

 

FIG 2.16: Cache Memory Structure 
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 The data block (cache line) contains the actual data fetched from the main 

memory.  

 The tag contains (part of) the address of the actual data fetched from the main 

memory. 

 For each cache row entry an instruction cache requires only one flag bit that is a 

valid bit.  

 The valid bit indicates whether a cache block has been loaded with valid data or 

not. 

Cache performance 

 The proportion of accesses that result in a cache hit is known as the hit rate. 

 And it can be a measure of the effectiveness of the cache for a given program or 

algorithm. 

 Read misses delay execution because they require data to be transferred from 

memory much more slowly than the cache itself. 

 Write misses may occur without such penalty, since the processor can continue 

execution while data is copied to main memory in the background. 

Replacement policies 

 The cache may have to evict one of the existing entries, for the new entry on 

cache miss in order to make room.  

 It uses to choose the entry to evict is called the replacement policy.  

 The fundamental problem with any replacement policy is that it must predict 

which existing cache entry is least likely to be used in the future.  

 Predicting the future is difficult, so there is no perfect way to choose among the 

variety of replacement policies available. 
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Write Policies 

 If data is written to the cache, at some point it must also be written to main 

memory. 

  The timing of this write is known as the write policy. 

 In a write-through cache, every write to the cache causes a write to main memory 

 .Alternatively, in a write-back or copy-back cache, writes are not immediately 

mirrored to the main memory.  

 Instead, the cache tracks which locations have been written over (these locations 

are marked dirty). 

 The data in these locations are written back to the main memory only when that 

data is evicted from the cache. 
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Chapter : 2.5 Managing Disk Partition 

Topic : 2.5.1 Managing Disk Partition 

 

Managing Disk Partition 

 Disk partitioning is the act of dividing a Hard Disk Drive (HDD) into multiple 

logical storage units referred to as partitions. 

 When a hard drive is installed in a computer, it must be partitioned before user 

format and use it.  

 Partitioning a drive is when user divide the total storage of a drive into different 

pieces. 

How to manage the Disk Partition? 

 When partitions are made, user should specify the total amount of storage that 

user would like to allocate to that partition from the total size of the drive. 

 For example 

 If user have an 80 GB drive, then it would be possible to make one partition 

consisting of the entire 80 GB of available storage.  

 Alternatively, user could make two partitions consisting of a 20 GB partition 

that will be used for the operating system and programs. 

 And a 60 GB partition set aside for data, music, and images. 

 In the current PC architecture, there is a partition table in the drive's Master Boot 

Record (section of the hard drive that contains the commands necessary to start 

the operating system) or MBR. 

 MBR (Master Boot Record) lists information about the partitions on the hard 

drive.  

 This partition table is then further split into 4 partition table entries, with each 

entries corresponding to a partition.  

 These 4 partitions are typically known as primary partitions.  

 To overcome this restriction, system developers decided to add a new type of 

partition called the extended partition.  
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 By replacing one of the four primary partitions with an extended partition, user 

can then make an additional 24 logical partitions within the extended one. 

 The table below illustrates the partitions. 

Primary Partition #1 

Primary Partition #2 

Primary Partition #3 

Primary Partition #4 

(Extended Partition) 

Logical Partition #1 

Logical Partition #1 

 This partition table is broken up into 4 primary partitions.  

 The fourth partition, though, has been flagged as an extended partition.  

 It makes more logical partitions under that extended partition and therefore 

bypassing the 4 partition limit. 
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Chapter : 2.6 File System Input Devices 

Topic : 2.6.1 Keyboard 

 

Keyboard  

 The keyboard looks like a typewriter. Most common and very popular input 

device is keyboard. 

 

FIG 2.17: Keyboard 

 The keyboard helps in inputting the data to the computer. 

 Most of the keyboards have 80 to 110 keys. 

 Key types 

 Typing (Alphanumeric keys) 

 Function keys 

 Control keys 

 Cursor keys 

 Typing (Alphanumeric keys) 

 The typing keys include the letters of the alphabet, generally laid out in the 

same pattern used for typewriters. 

 These include same letter, number, punctuation, and symbol keys. 
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 Function keys 

 Keys that act as shortcuts for performing certain functions such as saving files 

or printing data.  

 Function keys usually are lined along the top of the keyboard labeled F1 

through F12. 

 Control keys 

 Control keys are used alone or in combination with other keys to perform 

certain actions. 

 The most using control keys are Insert, Home Pageup, Pagedown, Delete, 

End, Ctrl, Windows logo. 

 Some of the frequently used key combinations are 

 Ctrl+F4   -  Exit 

 Ctrl+A    -  Select all 

 Ctrl+C    -  Copy 

 Ctrl+V    -  Paste 

 Ctrl+B     - Bold 

 Ctrl+S     -  Save 

 Cursor keys 

 Cursor keys include a variety of keys which moves the cursor to different 

positions on the screen. Arrow keys are programmed to move the cursor in a 

specified direction. 

 Page Up and Page Down keys, scroll the page up and down. The Home 

key is used to return the cursor to the beginning of the line where the cursor is 

located; the End key puts the cursor at the end of the line. 

 Keyboard Types 

                                                 

  Standard      Laptop size       Handheld               Thumb-sized 

                                            FIG 2.18: Types of Keyboard 
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Chapter : 2.6 File System Input Devices 

Topic : 2.6.2 Mouse 

 

Mouse  

 Mouse is a pointing device which contains an optical in its base. 

 The mouse is an input device (control station) for computers.  

 The mouse is a device that allows you to control the movement of the insertion 

point on the screen. 

 

FIG 2.19: Mouse  

 The movement of the mouse, run with the hand on the table or a suitable base 

(flat surface) such as the mouse pad is received via a sensor in the mouse, 

digitized and transmitted via an interface to the connected computer.  

 The most conventional mouse has two buttons, the left one is used most 

frequently for clicking.  

 The left click lets the user click once to send a "Select" indication that provides 

the user with feedback that a particular position has been selected for further 

action.  

 The next click on a selected position or two quick clicks on it causes a particular 

action to take place on the selected object. 

 The right click, usually provides some less-frequently needed capability. 

 Use of right click. 
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 Right-clicking an item, usually displays a list of things user can do with the 

item.  

 For example, when user right-clicks the Recycle Bin on the desktop, user will 

see a menu with options to open it, empty it, delete it, or see its properties.  

                                      

FIG 2.20: Right clicking a mouse 

 If user ever unsure of what to do with something, right-click it. 
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Chapter : 2.6 File System Input Devices 

Topic : 2.6.3 Joystick 

 

Joystick 
 

 A joystick is an input device consisting of a stick that pivots on a base and 

reports its angle or direction of the device it is controlling.  

 

FIG 2.21:  Joystick 

 Joysticks are often used to control video games, and usually have one or more 

push-buttons whose state can also be read by the computer. 

Types of Joystick 

 The five types of joystick are 

 Digital joystick 

 Paddle joystick 

 Analog joystick 

 PC Analog joystick 

 Joy pads 

 Digital joysticks 

 It is used for PCs, employing simple left, right, up and down, firing commands. 

They are also called “Atari-style” digital joysticks.  

 Paddle joysticks 
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 It consists of one knob used to control the game and one firing button. 

 Analog joysticks 

 It combines both digital and paddle joysticks.  

 They control the game by digital joysticks, but also use potentiometers to 

measure the movements like paddle joysticks. 

 PC Analog joysticks 

 It is a simple analog-styled joystick with multiple buttons that is usually 

connected by an USB port.  

 Joy pads 

 Joy pads are joysticks without the sticks. Instead, they employ a directional 

pad (D-pad) to control the game. 

 Joy pads are considered a bit primitive, but they are still feature among the 

current video game controllers. 
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Chapter : 2.6 File System Input Devices 

Topic : 2.6.4 Scanner 

 
Scanner 
 

 A scanner is an input device that scans any documents such as photographs and 

pages of text. 

 Scanners are used to import a picture or document into the computer for sending 

or printing.  

 

FIG  2.22: Scanner 

 Scanner works by placing the object to be scanned on the glass surface.  

 While scanning a camera moves across the object, capturing the image and 

storing it on the computer. 

 When a document is scanned, it is converted into a digital format. 

 Scanners have become an important part of the home office over the last few 

years, where file can be sent over the internet at a faster speed. 

 The most commonly used  scanners are 

 Flat-bed scanner 

 Sheet-fed scanner/ Auto feeder 

 Hand held scanner 

 Drum scanner 
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 Flatbed scanner 
 

 A flatbed scanner is a type of scanner or copier that uses a flat, glass surface 

for scanning documents or other objects.                                         

 

FIG 2.23: Flatbed Scanner 

 Sheet-fed scanner / Auto feeder 

 

 A sheet fed scanner is a type of scanner that scans only one piece of paper at 

a time and it has no room for bulky objects like books and other material. 

 

FIG 2.24: Sheet-fed Scanner 

 Handheld scanner 

 

 A handheld scanner is a small scanning device used for digitizing images. 

 Handheld scanners use the same basic technology as a flatbed scanner, but 

rely on the user to move them instead of a motorized belt. 

 

FIG 2.25: Handheld Scanner 



E-Content of 

IT TOOLS AND BUSINESS SYSTEM 

Page | 33  
 

 Drum scanner 
 

 A drum scanner is a type of scanner used to capture the highest resolution of 

an image. 

 

FIG  2.26: Drum Scanner 

 Some other types of scanners are 

 Transparency Scanners 

 Video Digitizers 

 Miscellaneous 

 Photo CD 

 Digital Cameras 

 Stand-Alone Oversize Digitizers 
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Chapter : 2.6 File System Input Devices 

Topic : 2.6.5 Web Cam 

 

Web Cam 

 A webcam is a video camera that feeds its image to the computer. 

 

FIG 2.27: Web Cam 

 When the image is captured by the computer, the video stream may be saved or 

viewed or sent to other network via system such as the internet and email as an 

attachment.  

 A webcam is connected by a USB Cable, FireWire cable or built into the 

computer hardware such as laptop. 

 Webcams are known for their low manufacturing cost and flexibility, making them 

the lowest cost form of video telephony. 

Uses of Web Cam 

 Video links 

 Permitting computers to act as videophones.  

 Security surveillance 

 Computer vision 

 Video broadcasting and 

 Recording for social videos. 
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Chapter : 2.7 Output Devices 

Topic : 2.7.1 Monitors 

 

Monitors 

 A monitor or display (sometimes called a visual display unit) is an electronic 

visual display for computers.  

 The monitor comprises the display device, circuitry, and an enclosure. The 

display device in modern monitors is typically a thin film transistor liquid crystal 

display (TFT-LCD) thin panel, while older monitors use a cathode ray tube about 

as deep as the screen size. 

 Monitors available in 14", 15", 17" and even 21 to 30" in size. 

 It is used to get the data in the form of soft copy. Their functioning is exactly 

similar to the television. 

 It contains a Cathode-Ray Tube (CRT) which emits the electrons to trace a 

regular pattern of horizontal lines on the screen. 

 There are two kinds of viewing screen used for monitors such as 

 CRT Monitor 

 Flat-Panel Display 

 

                                              

                FIG 2.28: CRT Monitor                   FIG 2.29: Flat-Panel Display                                 
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Features of Monitor 

 

 Most modern monitors will switch to a power-saving mode if no video-input signal 

is received. 

 This allows modern operating systems to turn off a monitor after a specified 

period of inactivity. This not only saves power consumption; but also extends the 

monitor's service life. 

 The monitors having the highest resolution are often used in the Graphic arts and 

Film industries etc. 

 

Development changes in Monitor [From beginning until now] 

                                           

CRT monitor   →            LCD monitor  →       LED monitor  →    UHD monitor 

FIG 2.30: Stages of monitor 
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Chapter : 2.7 Output Devices 

Topic : 2.7.2 Printers 

 

Printers 

 A printer is an electromechanical device which converts the text and graphical 

documents from electronic form to the physical form and it used to print 

information on paper. 

 Generally they are the external peripheral devices which are connected with the 

computers or laptops through a cable or wirelessly to receive input data and print 

them on the papers. 

 A wide range of printers is available with a variety of features ranging from 

printing black and white text documents to high quality colored graphic images. 

 Quality of printer is identified by its features like color, quality, speed of printing, 

resolution etc. 

 Modern printers come with multipurpose function i.e. they are combination of 

printer, scanner, photocopier, fax, etc. 

Types of printer 

 There are different types of printers and most commonly used printers are 

 Dot matrix printer 

 Inkjet printer 

 Laser printer 

 Dot matrix printer 

 Dot Matrix Printer is a popular computer printer that prints text and graphics 

on the paper by using tiny dots to form the desired shapes. 

 It is a 2D matrix of dots that can represent images, symbols, or characters. 
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FIG 2.31: Dot Matrix Printer 

 

 They are used for electronic displays, such as computer monitors and LED 

screens, as well as printed output. 

 In a dot matrix display, the images are estimated using a discrete set of dots 

instead of lines and shapes. 

 If enough dots are used, the image will appear as a contiguous display rather 

than a group of dots.  

 

 Inkjet printer 

 Inkjet printing is a type of computer printer that creates a digital image by 

propelling droplets of ink onto paper, plastic, or other substrates. 

 

FIG 2.32: Inkjet Printer  

 The inkjet technology works by spraying very fine drops of ink on a sheet of 

paper.  
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 These droplets are "ionized" which allows them to be directed by magnetic 

plates in the ink's path.  

 As the paper is fed through the printer, the print head moves back and forth, 

spraying thousands of these small droplets on the page. 

 Laser printer 

 Laser printing is an electrostatic digital printing process that rapidly produces 

high quality text and graphics by passing a laser beam over a charged drum 

to define a differentially charged image. 

 

 

FIG 2.33: Laser Printer  

 A laser printer is a printer that uses a focused beam or light to transfer text 

and images onto paper. 

 Instead, as paper passes through the printer, the laser beam fires at the 

surface of a cylindrical drum called a photoreceptor.  

 A laser printer utilizes laser technology to print images on the paper. It is often 

used in school, corporate and other environment. 
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Chapter : 2.8 Multimedia Data Types 

Topic : 2.8.1 Multimedia Data Types 

 

What is multimedia? 

 A media which combines different content forms of text, audio, video, animation, 

interactive features, still images to get a finished product is defined as 

multimedia. 

 Multimedia is the integration of multiple forms of media. 

 Multimedia is used for display, play and record or accessed by information 

content processing devices, such as computerized and electronic devices, but 

can also be part of a live performance.  

 

 

FIG 2.34: Multimedia Resources 
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FIG 2.35: Multimedia 

Multimedia Data types 

 Text  

 Graphics 

 Animation 

 Audio 

 Images 

 Video 

Text 

 Text is most widely used and flexible means of presenting information on screen 

and conveying ideas. 

 The designer should not necessarily try to replace textual elements with pictures 

or sound, but they should consider how to present text in an acceptable way and 

supplementing it with other media.  

 Users also be put off by the display of large amounts of text and will find it hard to 

scan. 

 To present tourist information about a hotel, for example, information should be 

presented concisely under clear separate headings such as location, services 

available, prices, contact details etc. 

 An explanation of the abbreviations used in the system should be readily 

available to the user through on-line help facilities or at least through written 

documentation. 
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 All upper case can be used if a text item has to attract attention as in warnings 

and alarm messages. 

 The length of text lines should be no longer than around 60 characters to 

achieve optimal reading speed. 

 Only one third of a display should be filled with text. 

Graphics 

 Graphics are visual images or designs on some surface, such as a wall, canvas, 

screen, paper. 

 Images that are generated by a computer are called computer graphics. 

 Graphics often combine text, illustration, and color. Graphic design may consist 

of the deliberate selection, creation, or arrangement of typography alone, as in a 

brochure, flyer, poster, web site, or book without any other element. 

 Graphics can be functional or artistic.  

 The latter can be a recorded version, such as a photograph, or an interpretation 

by a scientist to highlight essential features, or an artist, in which case the 

distinction with imaginary graphics may become blurred. 

Types of graphics 

 Computer graphics 

 Web graphics 

 Uses 

 Business 

 Advertising  

 Political 

 Education 

 Film and animation 
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FIG 2.36: Graphics 

Animation 

 Animation is the illusion of movement created by a succession of still graphics 

that are shown rapidly to the eye. 

 It can be generated via a sequence of slightly changed graphics. 

 Every graphic is slightly different from the previous.  

 In path-based animation, a single still image moves along a mathematical pre-

defined path.  

 The important features of this definition are  

 Picture – an animation is a kind of pictorial representation. 

 Motion – an animation depicts apparent movement. 

 Simulated – an animation consists of objects that are artificially created 

through drawing. 

 

 

 

FIG 2.37: Animation  
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Usage of Animation 

 To attract attention 

 To inform about the state of process  

 Demonstrations  

 Interactive simulations 

Audio 

 Audio signals are continuous analog signals. 

 Audio on a computer is digital data representing sounds (voice, music, sound 

effects and background music).  

 Sound is a continuous wave that travels through the air. The wave is made up of 

pressure differences. 

 

FIG 2.38: Audio 

 Frequency represents the number of periods in a second.  

 Human hearing frequency range 20Hz-20 kHz (audio), voice is about 500Hz to 

2kHz. 

 There are two major types of digital sound, such as  

 Musical Instrument Digital Interface (MIDI) and  

 Digitized sound files.  

 Both types are used substantially in multimedia. 
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 Musical Instrument Digital Interface (MIDI) 

 MIDI files store digital descriptions of actual musical instruments within 

software/hardware and are predefined in their digital form.  

 MIDI does not store real-world sounds.  

 The data contains descriptions of the instrument, pitch, timing of each note 

and its duration. 

  Combination of multiple instruments is possible. 

  10 seconds of digitized sound takes up 1 MB, a 10 second MIDI file occupies 

approximately 4 KB. 

 Digitized Sound  

 A microphone records real-world sound. 

  The microphone has a mechanism that sound waves vibrate, converting to 

electric signals.  

 These signals are not suitable for a computer, as they are in analogue form 

(consists of changing frequencies and volumes). 

  An analogue-to-digital converter (ADC) chip can change the analogue signal 

into the binary system.  

 Converting any analogue signal to a digital tone is called digitizing. 

Image 

 Image file can be divided into two categories 

 Vector-based image  

 Bitmap image 

 

FIG 2.39:  Image 
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 Vector-based images 

 These images are defined by mathematical relationships between points and 

the paths connecting them to describe an image. 

 Bitmap images  

 These images are made of individual dots called pixels that are arranged and 

colored differently to form a pattern. 

 The individual squares that make up the total image can be seen when 

zoomed in.  

 However, from a greater distance the color and shape of a bitmap image 

appear continuous.  

 Since each pixel is colored individually, user can easily work with 

photographs with so many colors and can create photo-realistic effects such 

as shadowing and increasing color by manipulating select areas, one pixel at 

a time. 

Video 

 Analog Video is usually captured by a video camera and then digitized. 

 There are a variety of video (analog and digital) formats. 

 Video is composed of different story units such as shots, scenes and sequences 

arranged according to some logical structure. 

 Frames recorded sequentially from a shot, one or several related shots are 

combined in a scene, and a series of related scenes forms a sequence. 

 Multimedia video files can come in different formats. The most popular types of 

multimedia video formats are 

 Audio Video Interleave (AVI). 

 Moving Pictures Experts Group (MPEG). 

 Online streaming services – Flash Video (FLV), Windows Media Video 

(WMV) and 3rd Generation Partnership Project (3GP). 
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Chapter : 2.9 Multimedia Applications 

Topic : 2.9.1 Multimedia Applications 

 

Multimedia Applications  

 Multimedia can be used in a variety of ways and fields. 

 It is being used to create interactive websites. 

 It makes online user more interesting, because it uses different building to make 

a web page.  

 Some of the multimedia applications are  

 Multimedia in Education 

 Multimedia in Entertainment 

 Multimedia in Marketing 

Multimedia in Education 

 Multimedia is any combination of text, graphics, art, audio, animation, and video 

with links and tools. 

 When the user can able to control what and when these elements are delivered, 

it is interactive multimedia. 

 When a structure of linked elements through which the learner can navigate, 

interactive multimedia becomes hypermedia. 

 Multimedia educational computing is one of the fastest growing markets in 

today's world. 

 

FIG 2.40: Multimedia in Education  
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 Fueling this growth are advance in technology and price wars that have 

dramatically lowered the cost of multimedia computers. 

 The new tools are enabling educators to become developers.  

 Nothing how multimedia is used to enable individuals to create course material, 

that once required teams of specialists, individuals can now produce multimedia 

desktop video productions. 

 Commercial and educational available generic courseware to support 

commercial products are emerging.  

 For these reasons, it is important to share information about what goes into the 

development of multimedia and the appropriate use of multimedia. 

Multimedia in Entertainment 
 

 Entertainment sector is one of the major application drivers of multimedia 

technologies. 

 Multimedia entertainment application goals at diverting users and engaging them 

in amazing experiences such as reading a book, playing more games and 

listening to music.  

 Electronic games are already popular and their popularity will further increase, 

as applications may be presented over enhanced delivery media.  

 Examples include CD-ROM-based interactive games, multi-player games that 

are played over the Internet, games on mobile phones, etc., 

 Multimedia entertainment applications aim at diverting  users, engaging them in 

amazing experiences such as 

 Reading books 

 Listening to music 

 Enjoying videos 

 Playing game 
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 Reading Books 

 User can read novels and any kind of books just like real books, then able to 

click on links throughout the text. 

 Take a note and type directly on documents. 

 

 
 

FIG 2.41: Multimedia Books 

 Listening to Music 

 People use music as form of entertainment. 

 

FIG 2.42: Music 

 ITunes is the famous mobile application developed by Apple, it is used to 

download and play audios and videos. 

 VLC, MP3 Player, etc. are famous software used to listen music. 

 Devices used to listen music are mobile, headset, iPod, speaker, etc. 

 

 Enjoying videos 
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 Devices used to watch videos are monitor, Tabs, Laptops, etc. 

 VLC, Flash movie player, etc. are software used to play videos. 

 

FIG 2.43: Videos 

 Playing Games 

 

FIG 2.44: Playing Games 

 Flash is one of the best 2D animation software used to make 2D video 

games. 

 For e.g. Aladdin video game is created with the help of flash software. 

 

Note: Above mentioned software are of respective vendors. 
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Multimedia in Marketing  

 Many companies today use multimedia in their marketing communication, given 

that is a more interactive way to promote their new products to the consumers. 

 Real Estate Agents  

 Agents realized they could do more than just show pictures of a home.  

 They created virtual tours and copied them with CD and DVD duplicators.  

 Interior Decorators 

 Decorators use software that creates virtual rooms and make many copies 

with DVD duplicating technologies. 

 Shopping Software 

 Any company selling a customizable product such as a car or a computer 

system can use CD and DVD duplicators to make copies of a shopping 

application on disc.  

 Artistic Portfolios 

 A host of creative people can create compact portfolios to show off their work. 

 Bands can use CD duplicating to release their own albums or to create 

demos for distribution to potential performance venues.  

 Company Reports 

  Financial analysis aren't the most interesting reading, but they can be jazzed 

up with a full multimedia presentation and copied with CD and DVD 

duplicators.  
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FIG 2.45: Multimedia in Marketing 

 

 Interactive Manuals 

 DVD duplicating simplifies employee training by creating courses on disc. 

New workers can train at their own pace without tying up another person to 

act as instructor.  
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Chapter : 2.10 Multimedia File Formats 

Topic : 2.10.1 Multimedia File Formats 

 

Multimedia File Formats 

 Multimedia data and information must be stored in a disk file using formats 

similar to image file formats.  

 Such data includes text, image data, audio and video data, computer animations, 

and other forms of binary data, such as Musical Instrument Digital Interface 

(MIDI), control information, and graphical fonts. 

  Typical multimedia formats do not define new methods for storing these types of 

data.  

 Instead, they offer the ability to store data in one or more existing data formats 

that are already in general use. 

 Multimedia formats are also optimized for the types of data they store and the 

format of the medium on which they are stored.  

 Multimedia information is commonly stored on CD-ROM. 

 There are many types of CD-ROM devices and standards that may be used by 

multimedia applications. 

 CD-XA (also called the Yellow Book) allows the storage of both digital audio and 

data on a CD-ROM.  

 CD-I (Compact Disc-Interactive) standard defines the storage of interactive 

multimedia data. CD-I units allow the integration of fully interactive multimedia 

applications into home computer systems. 

 A still-evolving standard is CD-R (Compact Disc-Recordable or Compact Disc-

Write Once), which specifies a CD-ROM that may be written to by a personal 

desktop computer and read by any CD-ROM player. 

 

 

 



E-Content of 

IT TOOLS AND BUSINESS SYSTEM 

Page | 54  
 

Chapter : 2.11 Computer Software 

Topic : 2.11.1 Computer Software  

 

Computer Software  

 Computer software is also known as computer programs, is the non-tangible 

component of computers.  

 Computer software contrasts with computer hardware, which is the physical 

component of computers. 

 The information technology  stands firmly on two legs, such as 

 Hardware 

 Software 

 Computer hardware and software require each other and neither can be 

realistically used without the other. 

 Hardware 

 Hardware is formed as the physical components of computer system 

 All of the hardware parts may do different tasks. 

 Without the hardware, there is no computers. 

 Software 

 Software is basically a set of instructions grouped into programs that make 

the computer to function in the desired way. 

 It is collection of programs to perform a particular task. 

 There are so many different types of softwares available for different 

purposes. 

 Without the software, we cannot do any task using the computer. 

 Software is usually written in high-level programming languages that are 

easier and more efficient for humans to use than machine language. 

 

 

 

Types of Software 
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 The software is widely available and there may be vast and a variety of software. 

 Software are categorized into, 

 System Software 

 Application Software 

 

 

 

FIG 2.46: Computer Software  

System Software 

 Systems software is a set of instructions that serves primarily as an intermediary 

between computer hardware and application programs, and may also be directly 

manipulated by knowledgeable users. 

 It makes the operation of a computer system more effective and efficient. 

 Systems software provides important self-regulatory functions for computer 

systems, such as 

 Loading itself when the computer is turned on. 

 Managing hardware resources such as secondary storage for all applications.  
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 Providing commonly used sets of instructions for all applications to use. 

 Without using the system software, there may be no computer program that can 

run on a computer system. 

 So the system software is an important or indispensable part of the computer 

system. 

Types of System Software 

 Operating System 

 Utility Programs 

Operating System 

 Operating System is an important system software found almost in all computers. 

 Operating is defined as the program, that instructs the computer how to work with 

its various components. 

 It helps to manage files and checks the various peripheral devices such as 

printers, monitors, etc. 

 The operating system itself is a collection of programs, these programs translate 

our instructions to the computer's language. 

 And then translate the computer's response from computer's language to the 

user understandable form. 

Utility Programs 

 Utility software is a type of system software designed to help analyze, config, 

optimize and maintain the computer. 

  A single piece of utility software is usually called a utility or tool. 

 Utility software should not be confused with application software, which allows 

users to do things like creating text documents, playing games, listening to music 

or surfing the web.  

 Rather than providing these kinds of user-oriented or output-oriented 

functionality, utility software usually focuses on how the computer infrastructure 
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(including the computer hardware, operating system, application software and 

data storage) operates. 

  Due to this focus, utilities are often rather technical and targeted at people with 

an advanced level of computer knowledge. 

 Examples of utility software include, 

 Virus scanner - to protect the system from viruses. 

 Disk defragmenter - to speed up the hard disk. 

 System monitor - to look at the current system resources. 

 File managers - to add, delete, rename and move files and folders. 

Application Software 
 

 Application software is computer software, designed to help the user to perform 

singular or multiple related specific tasks.  

 They act as instructions which direct the hardware to perform specific functions. 

 Application software cannot be operated unable to run without the operating 

system and system utilities. 

 Application software can be used as a productivity/business tool; to assist with 

graphics and multimedia projects. 

 Examples of Application Software 

 Microsoft Word 

 Microsoft PowerPoint 

 Macromedia Freehand 

 Adobe Photoshop 

 CorelDraw 

Note: Above & below mentioned software/Logos are of respective vendors. 
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FIG 2.47: Application Software  

Types of Application software 

 General purpose application software is designed to satisfy common needs of 

various businesses such as 

 Application suite 

 Enterprise software 

 Enterprise infrastructure software  

 Information worker software 

 Content access software 

 Educational software 

 Simulation software 

 Media development software 

 Product engineering software 

 Application suite 

 It consists of multiple applications bundled together.  

 They usually have related functions, features and user interfaces, and may be 

able to interact with each other. 

 Enterprise software 

 Enterprise software addresses the needs of an entire organization's 

processes and data flow, across most all departments, often in a large 

distributed environment.  

 Departmental Software is a sub-type of enterprise software with a focus on 

smaller organizations and/or groups within a large organization. 
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 Enterprise infrastructure software  

 It provides common capabilities needed to support enterprise software 

systems. 

 Information worker software 

 Users can create and manage information, often for individual project within a 

department, in contrast to enterprise management. 

 Content access software 

 It is used primarily to access content without editing, but may include software 

that allows for content editing. 

 Educational software 

 It is related to content access software, but has the content and features 

adapted for use in by educators or students. 

 Simulation software 

 It simulates physical systems for either research, training purposes. 

 Media development software 

 It generates print and electronic media for others to consume, most often in a 

commercial setting.  

  This includes graphic-art software, desktop publishing software, multimedia 

development software, HTML editors, digital-animation editors, digital audio 

and video composition, and many others. 

 Product engineering software 

 It is used in developing hardware and software products.  

 This include computer-aided design, computer-aided engineering, computer 

language editing and compiling tools, integrated development environments, 

and application programmer interfaces. 

Features of application software  

 Application software is close to users. 

 Application software is slow in speed. 

 This software is easy to understand and manipulate. 

 Application software is easy to design. 
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Chapter : 2.12 Relationship between Hardware and Software 

Topic : 2.12.1 Relationship between Hardware and Software 
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Chapter : 2.13 Compiler 

Topic : 2.13.1 Compiler 

 

Compiler 

 Compiler is a program that translates one language (source program) as input 

and translates into an equivalent another language (target program). 

 During this process of translation if some errors are encountered then compiler 

displays them as error messages. 

 The basic model of complier can be represented as follows 

 

FIG 2.48: Compiler 

 The compiler takes a source program as high level language such as C, 

PASCAL, FORTRAN, etc., and converts it into low level language or machine 

language such as assembly language. 

 The compilation can be done in two parts 

 Analysis 

 Synthesis 

 In analysis part the source program is read and broken down into constituent 

pieces. 

 The syntax and the meaning of the source string is determined and then an 

intermediate code is created from the input source program. 

 In synthesis part, this intermediate form of the source language is taken and 

converted into an equivalent target program. 



E-Content of 

IT TOOLS AND BUSINESS SYSTEM 

Page | 62  
 

 During this process, if certain code has to be optimized for efficient execution 

then the required code is optimized. 

 

 

FIG 2.49: Analysis and Synthesis Model 

 

 The analysis part is carried out in three sub parts 

 

FIG 2.50: Analysis Part 

 Lexical Analysis  

  In this step the source program is read and then it is broken into a stream of 

strings.  

 Such strings are called tokens.  

 Hence tokens are nothing but the collection of characters having some 

meaning.  

 Syntax Analysis  

 In this step the tokens are arranged in hierarchical structure that ultimately 

helps in finding the syntax of the source string.  
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 Semantic Analysis  

 In this step the meaning of the source string is determined.  

 In all these analysis steps the meaning of the every source string should be 

unique.  

 Hence actions in lexical, syntax and semantic analysis are uniquely defined 

for a given language. 

  After carrying out the synthesis phase the program gets executed.  
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Chapter : 2.14 Names of some High-level Languages 

Topic : 2.14.1 Names of some High-level Languages 

 

Names of some High-level Languages 

 High level programming languages is a programming language with 

strong abstraction from the details of the computer. 

 In comparison to low-level programming languages, it may use natural 

language elements, be easier to use, or may automate significant areas of 

computing systems, making the process of developing a program simpler and 

more understandable relative to a lower-level language.  

 High-level languages are closer to human languages and further from machine 

languages. 

 A high-level language isolates the execution semantics of computer architecture 

from the specification of the program, making the process of developing a 

program simpler and more understandable with respect to assembly and 

machine level languages. 

 

 

FIG 2.51: Types of Programming Languages 
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 Some of the features of a program written in high-level language are as follows 

 Programs are easier to write, read or understand in high-level languages than 

in machine language or assembly language. For example, a program written 

in C++ is easier to understand than a machine language program. 

 Programs written in high-level languages is the source code which is 

converted into the object code (machine code) using translator software like 

interpreter or compiler. 

 A line of code in high-level program may correspond to more than one line of 

machine code.  

 Programs written in high-level languages are easily portable from one 

computer to another.  

 Examples of High level Languages  

 COBOL 

 FORTRAN 

 PASCAL 

 C & C++ 

 PROLOG 

 JAVA 

 PERL 

 PHP 
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Chapter : 2.15 Free Domain Software 

Topic : 2.15.1 Free Domain Software 

Free Domain Software 

 Free Domain Software is software that comes with permission for anyone to use, 

copy and distribute either original or with modifications either without charge or 

for fee. 

 In particular that the source code must be available. 

 Free domain software can be freely used, modified and redistributed but with one 

restriction that is, the redistributed software must be distributed with original 

terms of free of use, modification and distribution. This is known as 'copyleft'. 

 Free software may be packaged and distributed for a fee. 

 The 'Free' here refers to the ability of reusing it modified or unmodified, as a part 

of another software package. 

 The best known example of free software is Linux, an operating system that is 

proposed as an alternative to Windows or other proprietary operating system. 

 Free software should therefore not be confused with freeware, which is term 

used for describing software that can be freely downloaded and used but which 

may contain restriction for modification and reuse. 
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Chapter : 2.16 Summary 

Topic : Summary 

 In this class, we have learnt about 

 Process of Central Processing Unit 

 Input, Output and Storage Devices 

 Concept of Multimedia 

 Computer Software 

 Compiler. 
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Chapter : 2.17 Model Questions 

Topic : Model Questions 

 What is CPU? 

 Explain Storage devices. 

 Describe Multimedia. 

 Explain the types of software. 

 What is compiler? 

 What is the usage of 'free domain software'? 
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Assessment 1  
 

1. The information stored in the RAM is typically loaded from the computer's  

______________. 

a) RAM 

b) Cache 

c) Hard disk 

d) BIOS 

 

2. What is the operation that performed by RAM? 

a) Read only 

b) Write only 

c) Read and write 

d) None of the above 

 

3. An electronic path, that sends signals from one part of computer to another is? 

a) Logic gate 

b) Bus 

c) Modem 

d) Serial port 

 

4. Which part is responsible for communication between Memory and ALU? 

a) Logic gate 

b) RAM 

c) USB 

d) Control unit 
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5. ____________ is the illusion of movement created by a succession of still graphics 

that are shown rapidly to the eye. 

a) Animation 

b) Graphics 

c) Web graphics 

d) All of the above 

Answers: 

1.c 

2.c 

3.b 

4.d 

5.d 
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Assessment 2  
 

1. Systems software is a set of instructions that serves primarily as an intermediary 

between computer hardware and application programs. 

a) True 

b) False 

2. Application software is computer software, designed to help the user to perform 

singular or multiple related specific tasks.  

a) True 

b) False 

3. Booting is the restarting of the computerized system.  

a) True 

b) False 

Answers: 

1.a 

2.a 

3.a 
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Chapter : 3.1 Objectives 

 

Objectives 

 At the end of the course the user will be able to 

 Understand about Windows Operating system. 

 Know the different essential accessories. 

 Understand about to managing applications. 

 Know about LINUX operating system. 
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Chapter: 3.2 Microsoft Windows 

Topic: 3.2.1A Introduction to Microsoft Windows 

 

Introduction to Microsoft Windows 

 Windows is developed by Microsoft Corporation. 

 Microsoft Windows is a series of graphical interface Operating Systems. 

 Microsoft Windows provides the environment necessary to start up and to 

operate a personal computer. 

 It controls the overall activity of the computer. 

 Windows also provides virtual memory management, supports multitasking 

platform and support many peripheral devices. 

 More than 90 % of all the personal computers were dominated by Windows 

Operating System. 

An overview of different versions of Windows 

 Versions of Microsoft Windows 

 Windows 1.0 - 2.0  

 Windows 3.0 - 3.1 

 Windows 95 

 Windows 98 

 Windows-2000 

 Windows –XP 

 Windows Vista 

 Windows 7 

 Windows 8 
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FIG 3.1: Versions of Windows 

 

 The first version of Microsoft Windows (Microsoft Windows 1.0) came out in 

November 1985. 

 

FIG 3.2: Microsoft Windows 1.0 

 Rather than typing MS-DOS commands, you just move a mouse to point and 

user can click their way through screens in Windows1.0.  
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 On December 9, 1987 Microsoft releases Windows 2.0 with desktop icons and 

expanded memory.  

 

FIG 3.3: Microsoft Windows 2.0 

 With improved graphics support, you can now overlap Windows, control the 

screen layout, and use keyboard shortcuts to speed up your work.  

 Microsoft released Windows 3.0 in May, 1990. Offering better icons, 

performance and advanced graphics with 16 colors designed for Intel 386 

processors.  

 This version is the first release that provides the standard "look and feel" of 

Microsoft Windows. 

 

FIG 3.4: Microsoft Windows 3.0 
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 In the year 1992 Microsoft releases Windows 3.1 and this is the most widely 

used Operating System yet. 

 

FIG 3.5: Microsoft Windows 3.1 

 Windows 3.1 contained necessary fixes and improved font functionality.  

 Microsoft continued to develop a new release, Windows NT, hoping it could be 

released as a continuation of Windows 3.0 and 3.1.  

 Unfortunately, issues with driver support and software meant that it was time for 

a new version altogether. 

 Microsoft introduced Windows 95 in August 1995 to supersede Windows 3.X and 

significant enhancement were made for managing multimedia elements. 

 

FIG 3.6: Microsoft Windows 95 

 Window 95 is updated from 16-bit to 32-bit. 

 Microsoft released the next version of Windows on June 25, 1998: Windows 98.  
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FIG 3.7: Microsoft Windows 98 

 Windows 98 included improved hardware and hardware drivers, Internet 

Explorer, and eventually, Internet connection sharing. 

 A second edition of Windows 98 came out on February 17, 2000; it was named 

Windows 98 SE (for "Second Edition"). 

 On September 14, 2000, Microsoft released Windows Me (for Millennium 

Edition), also called Windows Millennium. 

 

FIG 3.8: Microsoft Windows 2000 

 Windows 2000 made everyone's lives easier by increasing the number of plug 

and play devices compatible with the operating system. 

 Windows XP was released in 2001. 
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 Windows XP is the new version of Windows. The letter XP stands for extra 

performance, Microsoft Windows XP brims with new features, improved 

programs and tools. 

 Windows XP comes in two versions, Home and Professional.   

 

FIG 3.9: Microsoft Windows XP 

 Windows Vista is released in 2006 with the strongest security system. 

 Windows Vista security features protect against the latest generation of threats, 

such as worms, viruses and spyware. If an attacker manages to compromise a 

computer, Windows Vista limits the damage. 

 

FIG 3.10: Microsoft Windows Vista 

 

 

 

 Windows 7 is released in 2009 to fulfill requirements of Windows vista. 
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 Windows 7 include multi-touch support, Internet Explorer 8, improved 

performance and start-up time, Aero Snap, Aero Shake, support for virtual hard 

disks, a new and improved Windows Media Center, and improved security. 

 

 

FIG 3.11: Microsoft Windows 7 

 Windows 8 has been released in 2012. 

 Windows 8 is a reimaged Operating System from the chipset to the user 

experience, and it introduces a totally new interface that works smoothly for both 

touch screens and input devices like mouse and keyboard.  

 It functions as both a tablet for entertainment and a full-featured PC for getting 

things done.  

 Windows 8 also includes enhancements of the familiar Windows desktop, with a 

new taskbar and streamlined file management. 

 Windows 8 features a Start screen with tiles that connect to people, files, apps, 

and websites.  

 Apps are easily accessed from the Windows Store built right into the Start 

screen. 
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FIG 3.12: Microsoft Windows 8 
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Chapter: 3.2 Microsoft Windows 

Topic: 3.2.1B Basic Windows elements 

 

Basic Windows elements 

Window  

 A window is simply a rectangular unit that acts independently from other 

windows. 

 In a graphical user interface (GUI), the boundaries of the window can be easily 

expanded or contracted. 

 Windows come in two basic types: the application window, and the dialog box. 

Application window 

 

FIG 3.13: Application Window 

 

 Application windows are the main part of almost all programs. 

 Common elements of application windows include the control menu, menu bar, 

and border. 
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Dialog box 

 

FIG 3.14: Dialog box  

 Dialogs perform a specific task or give details for the application. 

 Most dialog boxes lack several of the control buttons and a border, and will have 

other buttons inside the window to complete a request such as ―OK‖ and 

―CANCEL‖. 

Taskbar 

 In GUI interfaces, the taskbar is a desktop toolbar application that lets the user to 

locate and perform tasks such as switching between open Windows and starting 

new applications.  

 A bar at the bottom of the desktop is the Taskbar and it was first introduced with 

Microsoft Windows 95 and found in all versions of Windows after that. 
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FIG 3.15: Taskbar  

 The notification area, at the far right of the taskbar, includes a clock and a group 

of icons.  

 When clicked on a window title in the taskbar, that window will become active 

and show up in front of other Windows which are opened already.  

Icons 

 An icon is a small graphic representation of a program.  

 Icons allow the user to access the program with ease. 

 Icons are used with Graphical User Interface (GUI). 

 Operating Systems such as Microsoft Windows and the Apple Mac OS to help 

quickly identify a type of file or program associated with the icon. 

 

FIG 3.16: Icons  
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Start menu 

 The Start menu is a feature of the Windows Operating System that provides 

quick access to programs, folders and system settings.  

 By default, the Start menu is located in the lower-left corner of the Windows 

desktop. 

 

FIG 3.17: Start menu  

Border 

 A border is ―a part that forms the outer edge of something.‖ 

 The border not only defines where the window is on the desktop, but it can also 

be used to change the size of most windows. 

 This type of border can be used to represent the outer edge of a document or to 

separate several sections within a document from each other. 
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Title Bar 

 The title bar is located along the top of a window or a dialog box that displays the 

name of the window or software program being used. 

 In many graphical user interfaces, including the Macintosh and Microsoft 

Windows interfaces, user  move (drag) a window by grabbing the title bar. 

 Control buttons are the little buttons which are on the right side of title bar  

 
FIG 3.18: Title bar 

 These commands can be done with the mouse using other window elements; 

their primary usefulness is in when user have to do any of these functions with 

the keyboard. 

Minimize Button 

 

FIG 3.19: Minimize Button 

 By pressing, it will remove the window and replace it with a program icon 

somewhere on the desktop. 

Maximize / Restore Button 

 

FIG 3.20: Maximize Button 

 By pressing, it will make the window as large as it can possibly go – usually as 

large as the screen. 
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FIG 3.21: Restore Button 

 The button will then change to the Restore Button, which when pressed change 

the window back to its previous size. 

 Close Button 

 

FIG 3.22: Close Button 

 Pressing this button is just one way of closing the window. Other ways of closing 

the window include double-clicking the control menu or clicking on the File menu 

and then Exit if it's an application window, and clicking on the ―OK‖ button if it's a 

dialog box. 

 Take caution on dialog boxes: When this button is active, it usually has the same 

effect as pressing the ―CANCEL‖ button, so be sure that, don't need to save any 

changes user made in the dialog box. 

 Help Button 

 

FIG 3.23: Help Button 

 If user press it, a question mark will be attached to the mouse pointer.  

 Then when user click on something else in that window, user will see a little box 

describing the purpose of what they clicked on and/or how to use it. 

Resize Handle 

 

FIG 3.24: Resize Handler 

 The resize handle is actually an extension to the border, found in the lower right 

corner of the window. It is especially useful when user want to change the size of 

the window but for some reason the border is too thin. 
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Menu Bar 

 

FIG 3.25: Menu bar in Notepad 

 A menu bar is present in every application window directly below the title bar.  

 Each word on the menu bar is a separate menu. If user click on the word, the 

corresponding menu will appear.  

 Some programs have cascading menus, which means that an item inside the 

menu will bring user to another related menu. 

 

 

FIG 3.26: Cascading Menu bar 
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Chapter: 3.2 Microsoft Windows 

Topic: 3.2.1C File management through Windows 

 

File management through Windows 

 File management in windows can be done through Windows explorer or My 

Computer. 

Using Windows Explorer 

 To open Windows Explorer, 

 Click on Start 

 Point to All Programs 

 Point to Accessories, and then click on Windows Explorer (Animation: 

Recording) 

 The left pane of the Explorer window shows a hierarchical list of files, folders, 

and storage drives (both fixed and removable) on computer. It also lists any 

network drives that have been mapped to as a drive letters on computer.  

(Animation: Recording) 

 A drive or folder that contains other folders has an arrow to the left of the icon. 

Click the arrow to expand it and see the folders inside. 

 Windows Explorer can be used to copy, move, rename, and search for files and 

folders. 
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Opening drives and folders 

 

FIG 3.27: Opening drives and folders 

 There are two basic formats for the interface used to open drives and folders in 

the computer.(text animation) 

 The single-pane view used for most folders and in My Computer. 

 Two drives nearly all computers have a hard drive (drive C:). If user have 

more than one drive, then they are named E:, F: and so on. If user have a CD 

drive or a DVD drive, it also is named with a letter.  

 Opening a drive or folder is easy. Just double click the icon representing the 

drive user want to open. Files and folders contained in the drive are now shown 

in the opened window. Now for opening a folder, double click its icon. 

 

 Copying or Moving a file or folder using My Document 

 Click on Start, and then click on My Documents. 

 Click the file or folder to be copied. More than one file or folder can be copied at 

a time. 

 To select more than one consecutive files or folders, click the first file or folder, 

press and hold down SHIFT key, and then click the last files or folders. 

 Right click on the selected files or folders, then click Copy to copy the selected 
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files and folders. 

 Choose the desired location to paste the files of folders, then clicking the right 

mouse button, select Paste to paste the files or folders to the target drive. 

 

View file details 

 Click on Start, and then click on My Documents. 

 Double-click the folder that contains the files to be viewed. 

 On the View menu, click Details. 

 It will display all the details about the files such as Name, Type, size etc. 

 

Copying and moving files using Explorer 

 

FIG 3.29: Copying and moving files 

 Click Start, point to All Programs then Accessories, and then click Windows 

Explorer. 

 Make sure the destination for the file or folder user want to move is visible. 

 Drag the file or folder from the right pane and drop it on to the destination folder 

in the left pane to move the file or folder there. 
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 If user drag an item while pressing the right mouse button, they can move, copy, 

or create a shortcut to the file in its new location. 

 To copy the item instead of moving it, press and hold CTRL while dragging. 

 If user drag an item to another disk, it is copied, but not moved then press and 

hold down SHIFT while dragging. 

 Dragging a program to a new location creates a shortcut to that program. To 

move a program, right-click and then drag the program to the new location. 

Create a new folder 

 Folders help the user to organize their files.  

 User can create a folder either by using My Computer window or through 

Windows Explorer. User can create a Folder in any existing disk drive or folder or 

on the windows desktop.  

 The steps for creating a folder are 

 Click on Start, and then click on My Documents. 

 Under File menu click New and select Folder. 

 A new folder is displayed with the default name, New Folder. 

 Type a name for the new folder, and then press ENTER. 

 A new folder can also be created directly on the desktop by right-clicking a blank 

area on the desktop, pointing to New, and then clicking Folder. 

Rename a file or folder 

 The steps for renaming a folder are 

 Click on Start, and then click on My Documents. 

 Click on the file or folder user want to rename. 

 Under File menu click on Rename. 

 Type the new name, and then press ENTER key. 

 Alternately file or folder can also be renamed by right-clicking it and then clicking 

on Rename. 

Delete a file or folder 
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FIG 3.30: Delete a file or folder 

 Steps for delete a folder 

 Click on Start, and then click on My Documents. 

 Click on the file or folder user want to delete. 

 Under File menu click on Delete. 

 Files or folders can also be deleted by right-clicking the file or folder and then 

clicking Delete. 

 Deleted files or folders are stored in the Recycle Bin, till they are permanently 

removed from the Recycle Bin. 

 To retrieve a deleted file, double-click the Recycle Bin icon on the desktop. Right-

click on the file to be retrieved, and then click Restore. 

 To permanently delete a file, press and hold down SHIFT key and drag it to the 

Recycle Bin. 

 Files or folders deleted from a removable storage media such as network drive 

are permanently deleted and are not sent to the Recycle Bin. 
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Chapter: 3.3 Using Essential Accessories 

Topic: 3.3.1 System Tools 

 

System Tools 

 System Tools allows user to perform some basic maintenance from time to time 

to keep Operating System run smoothly. 

 But, it is impossible to expect the users run these tools on an periodic basis or 

make the administrators run it for user on all the computers. 

 Some of the System tools are as follows 

 Disk cleanup 

 Disk defragmenter  

Disk Cleanup 

 The Disk Cleanup tool helps user to free up space on the hard disk by searching 

the disk for files that user can safely delete.  

 User can choose to delete some or all of the files.  

 Use Disk Cleanup to perform any of the following tasks to free up space on the 

hard disk. 

 Remove temporary Internet files. 

 Remove downloaded program files. For example, ActiveX controls and Java 

applets that are downloaded from the Internet. 

 Empty the Recycle Bin. 

 Remove Windows temporary files. 

 Remove optional Windows components that user are not using. 

 Remove installed programs that user no longer use. 

 User can start Disk Cleanup, by doing one of the following 

 Click Start, and then click Run. In the Open box, type cleanmgr, and then 

click OK.  
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FIG 3.31: Disk Cleanup Dialog Box 

 Click Start, point to All Programs, point to Accessories, point to System 

Tools, and then click Disk Cleanup.  

 Open My Computer, right-click the disk in which user want to free up space, 

click Properties, click the General tab, and then click Disk Cleanup. 

 

FIG 3.32: Drive (C:) Disk Cleanup  
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Disk Defragmenter  

 Disk defragmentation is the process of consolidating fragmented data on a 

volume (such as a hard disk or a storage device) so it will work more efficiently. 

 It is a tool that rearranges the data on the volume and reunites fragmented data 

so that computer can run more efficiently. 

 To start Disk Defragmenter, use one of the methods. 

 Click Start, click All Programs, point to Accessories, select System Tools, 

and then click Disk Defragmenter.  

 

 

FIG 3.32: Disk Defragmenter 
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 Open My Computer, right-click the local disk volume that user want to 

defragment, and then click Properties, on the Tools tab, click Defragment 

Now and then click Defragment. 

 

FIG 3.34: Drive (C:) Disk Defragmentation 
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Chapter: 3.3 Using Essential Accessories 

Topic: 3.3.2 Entertainment 

 

Entertainment 

 Entertainment program is an add-on peripheral, where user can install 

entertainment software such as Windows Media Player, Volume Control. 

 Windows Media Player 

 To open Media Player, click on the Start button -> All Programs -> 

Accessories -> Entertainment -> Windows Media Player. 

 User can play audio and video files by using Windows Media Player.  

 User can choose different skins for the player from the available list or 

download more skins from Microsoft Windows site. 

 

 FIG 3.35: Windows Media Player 
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 Volume Control 

 To open Media Player, click on the Start button -> All Programs -> 

Accessories -> Entertainment -> Volume Control. 

 Enables to adjust master volume and balance of the audio speakers. 

 User can set different volumes for different file formats wave and midi and 

also for music played from CD Rom. 

 By default an icon of 'Volume Control' is also placed in 'System Tray' for easy 

access. 

 Right click on the icon in Notification Area opens full volume control window 

and a left click opens a small volume controller from which user can control 

the master volume of audio speakers. 

 The volume can also be controlled by the software of the sound card 

installed. 

 

FIG 3.36: Volume Control 
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Chapter: 3.3 Using Essential Accessories 

Topic: 3.3.3 Games 

 

Games 

 Games that come with Windows, and any new games user choose to install, 

appear in the Games folder. 

 Windows 7 comes with a variety of games to play. There are board games, card 

games, multiplayer Internet games, and even games for kids. 

 Open the Games folder by clicking the Start button . In the search box, 

type games, and then, in the list of results, click Games Explorer. 

 If user don't see a particular title, it could be for one of these reasons: 

 It is an older game, new games automatically show up in the Games folder 

when user install them. To add the game manually, see Install a game in the 

Games folder. 

 Windows Games are turned off. By default, the games that come with 

Windows are turned off, in some editions. To turn them back on: 

 Click the Start button , click Control Panel, click Programs, and then 

under Programs and Features, click Turn Windows features on or off. 

 Select the Games check box, and then click OK. 
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 User will find all games in the Games folder. To start playing, just open the folder 

and double-click a game icon. 

 

FIG 3.36: Games Window 

 Internet games such as Internet Backgammon, Internet Checkers, Internet 

Spades. 

 Board games such as Chess Titans, Minesweeper, Mahjong Titans. 

 Card games such as FreeCell, Hearts, Solitaire, Spider Solitaire. 

 Children's games such as Purble Place, Comfy Cakes, Purble Shop, Purble 

Pairs. 
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Chapter: 3.3 Using Essential Accessories 

Topic: 3.3.4 Calculator 

 

Calculator 

 Calculator is a software program included in all versions of Windows. 

 Window provides a simple calculator for doing arithmetic calculations.  

 To open a Calculator, click on the Start button, select All Programs, 

choose Accessories and then click Calculator. 

 Calculator provides four modes of calculation. They are, 

 Standard Mode 

 Scientific Mode 

 Programmer Mode 

 Statistics Mode 

 

FIG 3.37: Calculator 
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 Standard Mode  

 By default, Calculator runs in standard mode, which resembles a four-function 

calculator.  

 Standard Mode features are, 

 MC - Clears number in memory. 

 MR - Recalls number in memory. 

 MS - Stores number displayed in memory. 

 M+ - Adds number displayed to number in memory. 

 ← - deletes the last digit of the number displayed. 

 CE - Clears the last number input. 

 C - Clears the last calculation. 

 ± - Changes the sign of the number. 

 Note: Only the commonly misunderstood buttons are pointed out. 

 

FIG 3.38: Standard Mode  
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 Scientific Mode 

 More advanced functions are available in scientific mode. 

 To view the scientific calculator, select the view menu and click on Scientific. 

 In Scientific mode, Calculator is precise to 32 significant digits and honors 

operator precedence.  

 It offers functions such as basic to-the-power-of calculations as well as more 

powerful functions like sine, cosine, and pi functions.  

 User can use them in normal or inverse mode. 

 

FIG 3.39: Scientific Mode 
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 Programmer Mode 

 In Programmer mode, Calculator is precise up to 64 bits, depending on the 

word size.  

 The calculator honors operator precedence in Programmer mode and works 

in integer only mode. Decimals are discarded.  

 This mode lets user work in a variety of basic operations such as binary, 

octal, hexadecimal, and decimal.  

 It can do calculations from one base to another, such as converting octal to 

binary. 

 

FIG 3.40: Programmer Mode 
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 Statistics Mode 

 The Statistics mode is not quite as elaborate as the other two, but it‘s still 

something the old calculator did not have.  

 User get functions like the sum of numbers and the sum of numbers to a 

power to make statistical calculations. 

 The C key in statistics mode deletes the current value expressed instead of 

clearing it.  

 The CAD button clears all the values from the dataset, since statistics are 

usually built on a large number of figures. 

 

FIG 3.41: Statistics Mode 
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Chapter: 3.3 Using Essential Accessories 

Topic: 3.3.5 Imaging - Fax 

 

Imaging - Fax 

 Windows Fax and Scan can practically turn the computer into a fax machine—a 

potentially big money and time saver. 

 Before user start faxing, computer needs to be properly equipped. 

 If user planning to send and receive faxes at home, they first need to outfit their 

PC with a fax modem. 

 A fax modem is a relatively inexpensive piece of add-on hardware that allows the 

computer to communicate with a fax machine over a standard phone line.  

 The devices are sold at major computer stores and come in two varieties: internal 

and external. 

 Internal fax modems plug directly into the computer motherboard, similar to the 

way a video or sound card is plugged in.  

 External fax modems are small devices that connect to the serial or USB ports. 

 If user at work, another option is to see if the employer has a fax server—a 

dedicated computer equipped with multiple fax modems.  

 Sending a fax using a fax server doesn't require user to add any special 

hardware to the computer.  

 User have to just set up a connection with the fax server and go. 

Setting up Windows to fax 

 Once user have picked up a fax modem or found a fax server, you'll need to do a 

little setting up. 

 

 

To set up a fax modem 

 Before starting, make sure that fax modem has properly installed, and that it's 

plugged into a standard analog phone line. 
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 On the Start button , click All Programs, and then click Windows Fax and 

Scan. 

 At the bottom of the left pane, click Fax, and then click New Fax on the 

toolbar to launch the Fax Setup wizard. 

 

 

FIG 3.42: Windows Fax and Scan 

 

 

 Click Connect to a fax modem and follow the instructions. 

 

 
2 

1 
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FIG 3.43: Fax Modem 

 

To set up a fax server 

 Before starting, make sure the computer is connected to the network and user 

should know the network address of the fax server (for example, 

\\mycompanyfaxserver). 

 Click the Start button , click All Programs, and then click Windows Fax 

and Scan. 

 To use Fax view, click Fax at the bottom of the left pane. 

 

 Click the Tools menu, and then click Fax Accounts. 
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FIG 3.44: Opening Fax Account 

 

 Click Add, it will navigate to Fax Setup wizard. 

 

FIG 3.45: Add Account Dialog Box 

 In that click Connect to a fax server on my network and follow the 

instructions. 
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FIG 3.46: Fax Server 

Note: To connect to a fax server, user might need permission from the system 

administrator. 
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Chapter: 3.3 Using Essential Accessories 

Topic: 3.3.6 Notepad 

 

Notepad 

 Notepad creates and edits text and performs basic functions of a text editor 

without much formatting options. 

 The Notepad editor is about as old as Windows itself, yet it still has its uses even 

today.  

 Here are some ideas on how to use this venerable old program. 

 To open a notepad, on the Start button, click All Programs, point to 

Accessories and then choose Notepad. 

 Once Notepad is running, user will see its simplistic menu appear at the top of 

the Notepad program window. 

 

FIG 3.47: Notepad 

 One interesting feature about Notepad is its ability to word wrap to the width of 

the window.  
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 User can indicate whether they want word wrapping turned on or off from the 

Format menu. 

 Notepad offers only the most basic text manipulation functions, such as finding 

text.  

 Only newer versions of Windows include an updated version of Notepad with a 

search and replace function. However it has much less functionality in 

comparison to full-scale editors. 

How to create a text file using notepad 

 Once Notepad has been open, type the text file, and then save the file with any 

name making sure that the file name ends with .txt. 

 Notepad will not allow user to add pictures, since it is a plaintext editor and does 

not support pictures. 

 

FIG 3.48: Notepad with text 
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Chapter: 3.3 Using Essential Accessories 

Topic: 3.3.7 Paint 

 

Paint 

 A paint program is a software graphics program that allows the user to draw or 

paint bitmapped images on a computer.  

 User can use paint to create drawings on a blank drawing area or in existing 

pictures.  

 Many of the tools used in Paint are found in the ribbon, which is near the top of 

the Paint window.  

 Open Paint by clicking the Start button -> All Programs -> Accessories -

> Paint. 

 

FIG 3.49: Paint Window 
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 In paint user can do the following. 

 Drawing lines 

 Drawing different shapes 

 Adding Text 

 Selecting and editing objects 

 Working with color 

 Viewing the picture 

 Saving and using the picture 

 Drawing lines 

 User can use several different tools to draw line in Paint.  

 The tool user use and the options they select determine how the line appears 

in the drawing.  

 There are two tools used in drawing lines. They are Pencil tool and Brushes. 

 

 

FIG 3.50: Paint Tools 

 

 Drawing different shapes 

 Paint allow user to add different shapes in a picture.  

 The ready-made shapes range from traditional shapes such as rectangles, 

ellipses, triangles, and arrow and unusual shapes, such as a heart, lightning 

bolt, or callouts.  

 If user want to make their own custom shape, they can use the Polygon 

tool  to do this. 
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FIG 3.51: Shapes for drawing 

 Adding Text 

 In Paint, user can also add their own text or message in the picture using Text 

tool. 

 

FIG 3.52: Text Tool 

 Selecting and editing objects 

 If user want to make a change to part of a picture or an object, user need to 

select the part of the picture that they want to change, and then make the 

edit.  

 Some changes user can make include the following. 

 Select Tool 

 Resizing an object 

 Moving or copying an object 

 Rotating an object 

 cropping the picture to show only the selected item. 

 Erase part of a picture  
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FIG 3.53: Select Tool 

 Working with color 

 There are a number of tools to work specifically with color in Paint.  

 They let user to use the colors they want when they are drawing and editing 

in Paint. 

 

FIG 3.54: Colors 

 Viewing the picture 

 Pictures can be viewed in different ways using the View tab. 

 User can use the following views. 

 Magnifier 

 Zoom in and out 

 Rulers 

 Gridlines 

 Full screen 

 

FIG 3.55: View Tab 

 Saving and using the picture 

 When editing in Paint, you should save your work frequently. 
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 After user save the picture, user can use it on their computer or share it with 

others in e-mail. 

 Save a picture for the first time 

 Click the Paint button , and then click Save. 

 In the Save as type box, select the file format to save. 

 In the File name box, type a name, and then click Save. 

 

 

 

FIG 3.56: Save menu 

 

 

 

 Open an existing picture 

 Click the Paint button, and then click Open. 
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 Find the picture that want to open in Paint, click it, and then click Open. 

 

FIG 3.57: Open menu 

 

 

 

 

 

 

 Set your picture as your desktop background 

 Click the Paint button, point to Set as desktop background, and then 

click one of the desktop background settings. 
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FIG 3.58: Set as desktop background menu 

 Send the picture by e-mail 

 If user have an e-mail program installed and configured on the computer, 

user can attach the picture to an e-mail message, and then share it with 

others through e-mail. 

 Save the picture. 

 Click the Paint button, and then click Send in e-mail. 

 In the e-mail message, enter the person's e-mail address, type a short 

message, and then send the e-mail message that has the picture 

attached. 
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FIG 3.59: Send in e-mail menu 
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Chapter: 3.3 Using Essential Accessories 

Topic: 3.3.8 WordPad 

 

WordPad 

 User can create a formatted document without having to use a full-blown word 

processor like Word. 

 Although WordPad is not as robust as some mainstream word processors, it is a 

great choice for creating simple documents with a few formatting bells and 

whistles. 

 To open the WordPad window, click on the Start button →All Programs → 

Accessories → WordPad.  

 The WordPad window opens with a blank document. 

 

 

FIG 3.60: WordPad Window 

 

 

 WordPad allows simple formatting such as 
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 Change fonts.  

 Character level formatting.  

 Margins can be changed / created.  

 Insert bulleted charts/graphic and sound files. 

 

 

FIG 3.61: WordPad Ribbon 

 Rich text format (RTF) allows the exchange of text files between different  

word processors in different OS. 

 Printing and Page Setup in WordPad  

 User can use the same techniques to print a document from WordPad that 

they used to print a document from Notepad.  

 In WordPad, the only formatting that user can apply to the document (Page 

Setup) is to alter the margins.  

 Headers and Footers are not supported. 
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Chapter: 3.4 Command prompt 

Topic: 3.4.1 Command prompt 

 

Command prompt 

 Command Prompt is a command line interpreter application available in most 

Windows operating systems. 

 The Command Prompt program allows the user to work in an environment that 

looks more like a traditional operating system as opposed to the icon based 

Windows environment. 

 Command Prompt is officially called Windows Command Processor but is also 

sometimes called the command shell or by its file name cmd.exe. 

 In Command Prompt, only keyboard can be used and mouse cannot be used. 

 Command Prompt works at a lower level than Windows. This means that user 

will have more control over the machine.  

 The disadvantage of command prompt is that it is not user-friendly. 

 The GUI based operating system made command prompt boring. 

 

 

 

 

 

 

 

 

http://pcsupport.about.com/od/termsc/g/command-line-interpreter.htm
http://pcsupport.about.com/od/termshm/g/term_os.htm
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Opening a command prompt: 

 There are two conventional ways to start a Command prompt.  

 Start->Programs-> Accessories->Command prompt 

 Start->Run and type "cmd" and press enter.  

 The Command Prompt shows up as a black terminal window. The command 

prompt should look something like: C:\> 

 

FIG 3.62: Command prompt 

Directory Navigation 

 Navigating the command prompt, as well as changing drives and directories is 

important skill to have. To do this, you must learn a few commands that you must 

enter into the command prompt. 

 Changing directories (or changing your path) in the command prompt makes use 

of the CD command. The CD command has a small amount of possible 

arguments. CD accepts a drive and a path. 

 Some of the key commands are: 

 CD ( Change Directory) : The CD command is very simple to use. All 

commands are relative to the directory that you are in. Therefore, using the 

example output of a "dir" that is shown above, if you want to change to the 

"Windows" directory, you would type  
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 CD Windows : If you want to change to the "system" directory (which is a sub 

directory of "windows"), you would enter  

 CD System : However if you knew that you wanted to change to the system 

directory immediately, you could type this command. 

 CD Windows\System : However if you were already deep in another 

directory (for example c:\ documents and settings \username\ local settings) 

and then wanted to move directly to windows\system then you can do that by 

putting in an initial backwards slash. 

 CD \Windows\System : This tells the command to go to the root of the drive, 

then to the directory Windows and system.  

 Moving Back Up : You can also move back up the tree, instead of down. 

 cd \  or cd\ :  to just return to the root of the drive (C:\) 

 cd.. : to just go back one level (to use the earlier example, you were in 

c:\windows\system and you wanted to be in c:\windows). 

 cd program files or cd "program files" : to access a totally different 

directory, for example "Program Files". When typing directories to change to, 

if the directory name is unique, then you can use wild cards. For example : cd 

program. 

 dir - This command will list all of the folders and files in the directory you are 

currently at. 

 cd folder - This command will move you to the folder that you specify. The 

folder must be in the directory you are currently in. For example: If you are 

currently at C:\Users\username\ and you enter cd desktop you will be taken 

to C:\Users\username\Desktop\ 

 cd path - This command will take you to a specific path on your computer. 

You do not need to be in the same directory as the path. You must enter the 

entire path for it to work. For example: cd C:\Windows\System32 

 driveletter: - This command will take you to the drive letter that you specify. 

The drive you specify will need to be active, or have a disc in it if it a CD\DVD 

drive. For example, if you want to switch to your D drive, you would enter the 

command D: 
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 exit - This command will exit the Command Prompt, no matter your current 

location.  

Path setting: 

 Users can run an executable from windows command prompt either by giving the 

absolute path of the file or just by giving the executable file name.  

 In the latter case, Windows searches for the executable in a list of folders which 

is configured in environment variables. These environment variables are as 

below. 

1. System path 

2. User path. 

 The values of these variables can be checked in system properties( Run 

sysdm.cpl from Run or computer properties).  

 Initially user specific path environment variable will be empty. Users can add 

paths of the directories having executables to this variable.  

 Administrators can modify the system path environment variable. 

To set path from command line 

 In Vista, Windows 7 and Windows 8 we can set path from command line  using 

‗setx‘ command. setx path "%path%;c:\directoryPath" 

 For example, to add c:\dir1\dir2 to the path variable, we can run the below 

command. setx path "%path%;c:\dir1\dir2" 

 Alternative way is to use Windows resource kit tools ‗pathman.exe‗. Using this 

command we can even remove a directory from path variable.  

 

1. System path environment variable: 

 Open administrator command prompt and Run  the below command 

 To add directory to the system path environment variable. 

 Syntax : pathman /as directoryPath 
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 To remove path from system path environment variable. 

 Syntax : pathman /rs directoryPath 

2. Setting user path environment variable 

 For user environment variables, admin privileges are not required. We can run 

the below command to add and remove a directory to user path environment 

variable. 

 To add a directory from user path, user can run the below command. 

 Syntax : pathman /au directoryPath 

 To remove a directory from user path, user can run the below command. 

 Syntax : pathman /ru directoryPath 

Creating And Using Batch File 

 A script or text file which contains a series of commands to be executed by the 

command interpreter is called as batch files. 

 Batch files are created to automate frequently performed tasks. 

 A batch file may have any constructs that enables conditional branching and 

looping within the batch files. 

 Batch files are simply text files, which is created using Windows notepad 

application. It should be created only using notepad, Other word processing 

applications should not be used as they stores the files by adding their own 

formats. 

 Batch file is created by typing the command to run, in a text file and saving with 

the .BAT extension. 
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Chapter: 3.5 Files 

Topic: 3.5.1 Files 

 

Files  

 Files are logical containers of data that are always present at the leaf level of a 

directory tree, i.e., they are the last element of any tree. 

  A file cannot be a collection of other files or directories and can only contain 

data or instructions.  

 Each file has a set of properties associated with it, such as 

 Size 

 Date created  

 Date accessed  

 Date modified  

 Path  

 File name  

 File name  

 Each file is recognized by its filename. Filename has two parts; name and 

extension. File naming conventions must be followed while naming a file. A 

filename can have a maximum of 8 characters. 

 Extension identifies the type of the file or the application to which a particular 

file belongs. It can be 3 characters long. 

 Size  

 Size determines how much space the file is occupying on the disk. 

 Date created  

 Data created corresponds to the date when file was created. 

 Date accessed  

 Data accessed corresponds to the date when file was last accessed. 

 Date modified  

 Data modified corresponds to the date when file was last modified. 



 E-Content of 

IT TOOLS AND BUSINESS SYSTEM 

Page | 61  
 

 Path  

 Path specifies the location of file on the disk. It comprises of a series of 

predecessor (parent) directories and moves up to the root.  

 A file has a certain defined structure which depends on its type 

 Text file 

 Source file 

 Object file 

 Executable file 

 Text file 

 Sequence of characters organized into lines. 

 Source file 

 Sequence of sub routines and functions each of which is further organized as 

declarations followed by executable statements. 

 Object file 

 Sequence of bytes organized into blocks understandable by the system's linker 

 Executable file 

 Series of code sections that the loader can bring into memory and execute. 
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Chapter: 3.6 Directories and its Structure 

Topic: 3.6.1 Directories and its Structure 

 

Directories and its Structure 

 Directories are a collection of files or other directories.  

 Directory at the highest level is called the root directory.  

 There can be only one root in a directory structure.  

 Directories at lower levels are called child and those who share the same parents 

are called siblings.  

 A directory structure can be viewed as a way to organize files on the hard disk. 

 

FIG 3.63: Directory Structure 

Operations on a directory 

 The directory can be viewed as a symbol table that translates file names into 

their directory entries. 

 The operations that can be performed on the directory are: 

 Search for a file 

 Find the entry for a particular file. 

 Create a file 

 Create new file and add to directory. 

 Delete a file 
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 Remove a file when no longer needed. 

 List a directory 

 List the files in a directory and the contents of the directory entry for each file 

in the list. 

 Rename a file 

 Change name of a file as per user‘s request. 

 Position within the directory may also change. 

 Traverse the file system 

 Every directory and every file within a directory structure should be 

accessible. 

 Magnetic tape is the commonest backup device. 

Directory Structure 

 The directory structure is the organization of files into a hierarchy of folders.  

 It should be stable and scalable; it should not fundamentally change, only be 

added to. 

 Types of directory structure 

 Single-level directory 

 Two-level directory 

 Tree structured directory 

 Acyclic graph directory  

 General graph directory 

Single-level directory 

 A single-level directory with file entries for all users contained in the same 

directory. 

 It is the simplest structure of all directories. 

 All files are in the same directory. 

 It is easy to support and understand. 

 Name collision problem - files must have unique names since multiple users 

share same directory. 



 E-Content of 

IT TOOLS AND BUSINESS SYSTEM 

Page | 64  
 

 Even in case of a single user it is difficult to remember all file names and create 

files with unique names (the naming problem). 

 Files are limited in length. 

 

FIG 3.64: Single-level directory 

Two-level directory 

 The standard solution to limitations of single-level directory is to create a 

separate directory for each user. 

 System maintains a Master File Directory (MFD). 

 A separate directory for each user. 

 Easy to support and understand. 

 User file directory (UFD). 

 User name and a file name constitute a path name. 

 Solves the name collision problem. 

 Sharing of files by different users is difficult. 

 

FIG 3.65: Two-level directory 
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Tree structured directory 

 The two-level directory structure can be extended to a tree of arbitrary height. 

 Tree is the most common directory structure. 

 Examples of systems supporting tree structure. 

 MS-DOS 

 UNIX 

 A tree has a root directory. 

 The root contains a set of directories. 

 A directory contains a set of files and other sub directories. 

 Each sub directory can further contain a set of files and other sub directories. 

 Each file has a unique path name. 

 

FIG 3.66: Tree-structured directory 

 

 One bit in each directory entry defines the entry as a file(0) or as a sub 

directory(1). 
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Path name 

 

 A path name is the path from the root, through all the subdirectories, to a 

specified file. 

 Example 

 In the figure root/spell/mail/prog/obj is a path. 

 Types of path names can be of two types. 

 Absolute path name. 

 Relative path name. 

 Absolute path name 

 An absolute path name begins at the root and follows a path down to the 

specified file giving the directory names on the path. 

 Relative path name 

 A relative path name defines a path from the current directory. 

 With reference to figure, if the current directory is root/spell/mail, to reference the 

file list. 

 Relative path name:  prog/list. 

 Absolute path name: root/spell/mail/prog/list. 

Acyclic graph directories 

 When the same files need to be accessed in more than one place in the directory 

structure ( e.g. because they are being shared by more than one user / process ), 

it can be useful to provide an acyclic- graph structure 

 UNIX provides two types of links for implementing the acyclic-graph structure. 

 A hard link (usually just called a link) involves multiple directory entries that 

both refer to the same file. Hard links are only valid for ordinary files in the 

same file system. 

 A symbolic link, that involves a special file, containing information about 

where to find the linked file. Symbolic links may be used to link directories 

and/or files in other file systems, as well as ordinary files in the current file 

system. 
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FIG 3.67: Acyclic graph directory 

 

 

General graph directories 

 Allow users to create subdirectories in a two-level directory result is a tree 

structured directory. 

 Simply adding new files and subdirectories to an existing tree-structured directory 

preserves the tree-structured nature. 

 When user add links to a tree, the tree structure is destroyed resulting in a simple 

graph. 

 Cycles allowed. 

 Cycles might result in an infinite loop while searching. 

 One solution is limit to the number of directories which will be accessed during a 

search. 



 E-Content of 

IT TOOLS AND BUSINESS SYSTEM 

Page | 68  
 

 

FIG 3.68: General graph directory 
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Chapter: 3.7 Drives 

Topic: 3.7.1 Drives 

 

Drives 

 Drives are logical partitions of the hard disk or may be extension to the hard disk. 

  A convention is followed while giving names to these partitions. For example, A:, 

B: represents Floppy disk. C:, O:, E: represents Hard Disk, and F:, G: represents 

the Compact Disk.  

 To switch from one drive to another, only the drive letter followed by a colon 

needs to be specified. For example, at C:\> type A: and press <Enter>. This will 

take you to A:  

 While doing any directory or file manipulation user must take note of your 

location. 

  Location of a file or directory always starts with the drive letter (which is the root) 

followed by the name of its parent in one order and finally its own name.  

 For example, C:\Program Files\Microsoft Office\Office\MS Word  

 Implies that the root is C:\, one of the folders in C:1 is Program Files, Program 

Files contains Microsoft Office folder, which in turn contains office folder, which in 

turn contains MS Word.  
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Chapter: 3.8 Application Management 

Topic: 3.8.1A Installing and Uninstalling an application 

 

Application Management  

 All applications tend to share a common set of functionality that applies to 

application implementation and management. 

 Application management is the process of managing the applications on the 

Computer. 

Installing an application 

 To install a software program can depend on the operating system being used 

and the program being installed. 

  Because of all the different possibilities, we have created the steps below as 

guidelines for installing programs in each of the major operating systems. 

Steps for installing an application 

  To install a program from a CD or DVD 

 Insert the disc into your computer and follow the instructions on your screen. 

 If users are prompted for an administrator password or confirmation, type the 

password or provide confirmation. 

 Many programs installed from CDs or DVDs launch an installation wizard for 

the program automatically.  

 In these cases, the AutoPlay dialog box will appear and user can choose to 

run the wizard.  

 For more information, see AutoPlay: frequently asked questions. 

 If a program doesn't begin to install, check the information that came with the 

program.  

 This information will likely provide instructions for installing the program 

manually. 

 

 If user cannot access the information, they can also browse through the disc 

and open the program setup file, usually called Setup.exe or Install.exe. 
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FIG 3.69: AutoPlay Dialog Box 

 To install a program from the Internet 

 In user web browser, click the link to the program. 

 Do one of the following 

 To install the program immediately, click Run and follow the instructions 

on user's screen.  

 

FIG 3.70: Open File-Security Warning dialog box 

 

 If they are prompted for an administrator password or confirmation, type 

the password or provide confirmation.  
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 To install the program later, click Save and download the installation file to 

your computer.  

 When user are ready to install the program, double-click the file and follow 

the instructions on your screen.  

 

FIG 3.71: Installing the file 

 

 This is a safer option because user can scan the installation file for viruses 

before you proceed. 
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Uninstalling an application 

 To see a list of the programs that we can uninstall we must first open 

the Programs and Features control panel. 

 To do this user should follow these steps 

 In Windows click on the Start button to open your Start Menu. 

 When the Start Menu opens click on the Control Panel menu option. 

 When the Control Panel window opens click on the Uninstall a program option 

under the Programs category.  

 

 

                                       FIG 3.72: Uninstall option 

 If user are using the Classic View of the Control Panel, then user would 

double-click on the Programs and Features icon instead. 

 User will now be at the Programs and Features, or Uninstall or change a 

program, screen as shown below.  

 From this screen user can uninstall programs, view installed updates, and 

turn Windows features on and off. 
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FIG 3.73: Programs and Features Window 

 Now that user know what all the options in this screen do, let's start learning 

how to uninstall a program.  

 The first step is look through the list of programs for the one that user would 

like to uninstall and then left-click on it once so that it becomes highlighted. 

 Once user highlight a program they will see two new options next to the 

Organize and View button called Uninstall and Change 
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                                     FIG 3.74: Confirmation Dialog Box 

 If user press the Yes button, it will start the uninstall routine for the program 

and begin to remove it.  

 An uninstall screen will typically now open and may ask user questions about 

how the program should be uninstalled.  
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Chapter: 3.8 Application Management 

Topic: 3.8.1B Managing the Running  application 

 

Running Applications 

 The running applications can be managed using the task manager. 

 Using task bar the following process can be done on the running applications. 

 The task manager can be opened in following two ways; 

 Press Ctrl+Alt+Del -> Click start task manager. 

 Right click on the tack bar -> Click start task manager 

 

FIG 3.75: Running Applications 
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Ending a running application 

 The running application can be closed using the task manager. 

 It is done when the application hangs too long, The status column shows not 

responding, when the application is crashed or hanged. 

 By that time the user can use task manager to close the application by doing the 

following steps; 

 Open the task manager. 

 Click the Applications tab. 

 In the Task area, locate an application that is needed to be closed and click 

on it. 

 Finally, Click the End Task button. 

 

FIG 3.76: Ending a running application 
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Starting an application 

 The Create New Task button comes in handy in situations which helps the user 

to reopen an application.  

 If the user know the path to the application, he can enter it. 

 otherwise, the user can click the Browse button to navigate to the application 

name. 

 To open an application follow the steps given below; 

 Open the task manager. 

 Click the Applications tab. 

 Click the New task button. 

 Create new task dialog box opens, in that enter the application name to be 

opened, or else use browse option to select an application to open. 

 Finally, Click the ok button. 

 

FIG 3.77: Starting a new application 
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Monitor an Application's CPU and Memory Usage 

 The task manager can be user to know about the CPU and Memory usage of an 

running application. 

 It is done as follows; 

 Open the task manager. 

 Click the Processes tab. 

 Now it displays the list of running applications along with their CPU and 

Memory usage details. 

 

FIG 3.78: CPU and memory usage 
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End a Process 

 If the user thinks that a process is consuming more memory and its CPU 

utilization is more, Then he can end the process as shown below. 

 Not ending a process safely can result in data loss or in rare cases, system 

instability. 

 Steps to end a process; 

 Open the task manager. 

 Click the Processes tab. 

 select the process from the list, which is to be ended.  

 Click the End Process button, It asks for conformation. 

 Click end Process again to end the process. 

 

FIG 3.79: Ending a process 
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Stopping and Restarting a Service 

 The following steps shows as how to stop and restart a service through Task 

Manager. 

 The user can stop and restart a service when he wants. 

 This is done as follows; 

 Open the task manager. 

 Click the Services tab. 

 Right Click on the service from the listed services which is needed to be 

stopped. 

 Then click Stop Service option. 

 Depending on the security configuration, It might show an access-denied 

message.  

 If this is the case, click the service again and click on the Services button in 

the lower right corner. 

 Click Yes in the opened UAS window. 

 Then again right click the service to be stopped and click Stop Service 

Option. 

 To restart the service, follow these same steps. The only difference is that 

choosing Start Service instead of choosing Stop Services. 
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FIG 3.80: Stop a service 

 

FIG 3.81: Restart a service 
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An overview of Linux 

 Linux is an operating system. 

 It was developed beginning in 1991 by a University of Helsinki student named 

Linus Torvalds (Linux stands for Linus UNIX). 

 Linux itself is actually just a kernel. 

 It implements multitasking and multiuser functionality, manages hardware, 

allocates memory and enables application to run. 

 Linux delivers the power and flexibility of a UNIX server or desktop. 

 It also provides a set of utilities, Internet applications and a fully functional 

desktop interface. 

 The Linux operating system has become a server platform for powerful internet 

and many other applications. 

 Linux is capable of running from a Web, File Transfer Protocol (FTP), file and 

printer servers, to wide-area information server (WAIS). 

 The structure of Linux is organized on file systems that provide interfaces and 

abstraction needed to work with data and files. 

 Files are organized into directories with the disk hardware. 

 Each directory can contain any number of subdirectories each holding files. 

 

 

 

 

 

 

 

 

Chapter: 3.9 Linux 

Topic: 3.9.1 An overview of Linux 
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Chapter : 3.10 Basic Linux Elements 

Topic : 3.10.1 System and Software Features 

 

System Features 

 Linux supports most of the features found in other implementations of UNIX, plus 

quite a few that are not found elsewhere. 

 Linux is a complete multitasking, multi-user operating system (just like all other 

versions of UNIX). This means that many users can be logged into the same 

machine at once, running multiple programs simultaneously. 

 

 

Fig 3.82: Linux Logo 

 The Linux system is mostly compatible with a number of UNIX standards (in as 

much as UNIX has standards) on the source level, including IEEE POSIX.1, 

System V and BSD features. 

 It was developed with source portability in mind-therefore, users are most likely 

to find commonly-used features in the Linux system which are shared across 

multiple implementations. 

 A great deal of free UNIX software available on the internet and elsewhere 

compiles on Linux of out of the box. 

 In addition all source code for the Linux system is freely distributable, including  

 kernel 

 device drivers 

 libraries 

 kernel 
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 The kernel is able to emulate 387-FPU instructions itself, so that systems 

without a math coprocessor can run programs that require floating-point math 

instructions. 

 Linux supports various file system types of storing data. 

 Various file system, such as the ext2fs file system, have seen developed 

specifically for Linux. 

 Other file system types , such as the MINIX-1 and Xenix file systems are also 

supported. 

 The MS-DOs file system has been implemented as well allowing the user to 

access MS-DOS files on hard drive or floppy directly. 

 Device drivers 

 Linux provides a complete implementation of TCP / IP networking. 

 This includes device drivers for many popular Ethernet cards, SLIP (Serial 

Line Internet Protocol), PLIP (Parallel Line Internet Protocol), PPP (Point-to-

Point), NFS (Network File System) and so on. 

 The complete range of TCP / IP clients and services is supported such as 

FTP, telnet, NNTP and SMTP. 

 Libraries 

 Executables use dynamically linked shared libraries meaning that 

executables share common library code in a single library file found on disk. 

 This allows executable files to occupy much less space, especially those that 

use many library functions. 

 There are also statistically-linked libraries to be in place. 

 Linux shared libraries are dynamically linked at run-time, allowing the 

programmer to replace modules of the libraries with their own routines. 

Software Features 

 The fact that most of this software is freely distributable is even more impressive. 

 Many of the software applications available for Linux  

 Basic Commands and Utilities 

 Programming Language and Utilities 



 E-Content of 

IT TOOLS AND BUSINESS SYSTEM 

Page | 86  
 

 The X Window System 

 Networking  

 Telecommunication and BBS software 

 Interfacing with MS-DOS 

 Basic Commands and Utilities 

 Virtually every utility that user would expect to find on standard 

implementations. 

 This includes basic commands such as ls, awk, tr, sed, bc, more and so on. 

 Many text editors are available including vi, ex, pioc, jove as well as GNU 

Emacs and variants such as Lucid Emacs and joe. 

 The most important utility to many users is the shell. 

 The shell is the program which reads and executes commands from the user. 

 There are many types of shells available for Linux. 

 The most important difference between the shell is the command language. 

 Programming Languages and Utilities 

 Linux provides a complete UNIX programming environment, including all of 

the standard libraries, programming tools, compilers and debuggers that user 

would expect to find on other UNIX systems. 

 Within the UNIX software development world, applications and systems 

programming is usually done in C or C++. 

 

FIG 3.83: Programming languages 
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 The standard C and C++ compiler for Linux is GNU's gcc, which is an 

advanced, modern compiler supporting many options. 

 It is also capable of compiling C++ as well as Objective-C another objects-

oriented dialect of C. 

 Besides C and C++ many other compiled and interpreted programming 

languages have been ported to Linux, such as Smalltalk, FORTRAN, Pascal, 

LISP, Scheme and Ada. 

 The X Window System 

 The X window System is the standard graphics interface for UNIX machines. 

 It is a powerful environment supporting many applications. 

 Using X Windows, the user can have multiple terminal windows on the screen 

at once, each one containing a different login session. 

 Many X-specific applications have been written, such as games, graphics 

utilities, programming and documentation tools and so on. 

 Networking 

 Linux supports the two primary networking protocols for UNIX systems 

 TCP/IP  

 UUCP 

 TCP/IP (Transmission Control Protocol / Internet Protocol) is the set of 

networking paradigms that allow systems all over the world to communicate 

on a single network known as the internet. 

 With Linux, TCP/IP and a connection to the network, user can communicate 

with other users and machine across the Internet via electronic mail, USENET 

news, file transfers with FTP and more. 

 UUCP 

 UUCP is an older mechanism used to transfer files, electronic mail and 

electronic news between machines. 

 Classically, UUCP machines connected to each other over the phone lines 

via modem but UUCP is able to transport over a TCP/IP network as well. 
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 If the user do not have access to a TCP/IP network or a SLIP server, user can 

configure their system to send and receive files and electronic mail using 

UUCP. 

 

FIG 3.84: Networking  

 

 Telecommunication and BBS software 

 Many people use telecommunication software to access bulletin board 

systems (BBSs) as well as commercial online services. 

 If user have modem they will be able to communicate with other machines 

using one of the telecommunication packages available for Linux. 

 Telecommunications software under Linux is very similar to that found under 

MS-DOS or other operating system. 

 Linux supports a wide range of BBS software, most of which is more powerful 

that what is available for other operating system. 

 With a phone line, a modem, and Linux user can run their system into a BBS, 

providing dial-in access to their systems to other users worldwide. 
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 Interfacing with MS-DOS 

 Various utilities exist to interface with the world of MS-DOS. 

 The most well-known application is the Linux MS-DOS Emulator, which 

allows user to run many MS-DOS applications directly from Linux. 

 

FIG 3.85: MS-DOS logo  

 

 Other Applications 

 Several relational databases are available for Linux including Postgres, Ingres 

and Mbase. 

 These are full-featured, professional client/server database applications 

similar to those found on other UNIX platforms. 

 /rdb, a commercial database system, is available as well. 

 Scientific computing applications include 

 FLET (a finite element analysis tool) 

 gnuplot (a plotting and data analysis application) 

 Octave (a symbolic mathematics package) 

 xspread (a spreadsheet calculator) 

 xfractinit (X-based port of the popular financial fractal generator) 

 xlispstat (a statics package) and more 

 Other applications include  

 Spice 

 Khoros 
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Chapter :3.11 File Structure 

Topic : 3.11.1 File Structure 

 

File Structure  

 In the Linux file structure files are grouped according to purpose. 

 Parts of a Unix directory tree are listed below. 

 

 

FIG 3.86: File Structure 

 

 All directories are grouped under the root entry "/". 

 

Directories  Description 

/ 

 

Root directory that forms the base of the file system. All files and 

directories are logically contained inside the root directory 

regardless of their physical locations. 

/bin Contains the executable programs that are part of the Linux 

operating system. Many Linux commands, such as cat, cp, ls, more, 

and tar, are locate in /bin 

/boot Contains the Linux kernel and other files needed by LILO and 

GRUB boot managers. 

/dev Contains all device files. Linux treats each device as a special file. 

All such files are located in /dev. 

/etc Contains most system configuration files and the initialization scripts 
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in /etc/rc.d subdirectory. 

/home Home directory is the parent to the home directories for users. 

 

/lib 

Contains library files, including loadable driver modules needed to 

boot the system. 

/lost+found Directory for lost files. Every disk partition has a lost+found 

directory. 

/media Directory for mounting files systems on removable media like DVD-

ROM drives, flash drives, and Zip drives. 

/mnt A directory for temporarily mounted filesystems (ie Backup 

Software). 

/opt Optional software packages copy/install files here. 

/proc A special directory in a virtual memory filesystem. It contains the 

information about various aspects of a Linux system. 

/root Home directory of the root user. 

/sbin Contains administrative binary files. Commands such as mount, 

shutdown, umount, reside here. 

/srv Contains data for services (HTTP, FTP, etc.) offered by the system. 

/sys A special directory that contains information about the devices, as 

viewed by the Linux kernel. 

/tmp Temporary directory which can be used as a scratch directory 

(storage for temporary files). The contents of this directory are 

cleared each time the system boots. 

/usr Contains subdirectories for many programs such as the X or GUI 

Window System. 

/usr/bin Contains executable files for many Linux commands. It is not part of 

the core Linux operating system. 

/usr/include Contains header files for C  programming languages. 

/usr/lib Contains libraries for C  programming languages. 

/usr/local Contains local files. It has a similar directories as /usr contains. 
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/usr/sbin Contains administrative commands. 

/usr/share Contains files that are shared, like, default configuration files, 

images, documentation, etc. 

/usr/src Contains the source code for the Linux kernel. 

/var Contains various system files such as log, mail directories, print 

spool, etc. which tend to change in numbers and size over time. 

/var/cache Storage area for cached data for applications. 

/var/lib Contains information relating to the current state of applications. 

Programs modify this when they run. 

/var/lock Contains lock files which are checked by applications so that a 

resource can be used by one application only. 

/var/log Contains log files for different applications. 

/var/mail Contains users' emails sent by system or server. 

/var/opt Contains variable data for packages stored in opt directory. 

/var/run Contains data describing the system since it was booted. 

/var/spool Contains data that is waiting for some kind of processing. 

/var/tmp Temporary files preserved between system reboots. 
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Chapter : 3.12 File handling in Linux 

Topic : 3.12.1 Hardware and Software Requirements 

 

Hardware Requirements 

 Linux has very minimal requirements compared to other operating systems. 

 Linux is a high-performance system and can bring out the deficiencies of a 

particular piece of hardware better than DOS or Windows. 

 

CPUs 

Intel-Pentium, Pentium Pro, Pentium II, Pentium II 

Xenon, Pentium III, Pentium III Xenon, Pentium IV, 

Pentium IV Xenon, Celeron AMD - K6, K6-2, K6-3,  

Athlon, Duron, Athlon XP, Athlon MP Cyrix-MII VIA-

Cyrix MIII, C3 

Video cards 

3DFX-Banshee, Voodoo3, Voodoo5;  

ATI-Radeon Mobility M6, M7;  

Radeon 7000, 7500, 8500, 9000, 9700 (2D only);  

Rage 128, Rage 128 Mobility M3, M4; Rage 128 Pro, 

Rage 128 Pro Ultra, most MAch64-complaint cards;  

Intel-1740, i810, i815, i830, i845G, i845GL Matrox-

Millienum, Millenium II, etc., 

SCSI controllers 

Adaptec-200x, 21xx, 22x, 27x, 28xx, 29xx, 32xx, 

34xx, 39xx, 54xx  

Advansys-940(Ultra/Wide); 

AMI-MegaRAID Express 200(466 series) 

Dell-PowerEdge RAID series; 

IBM(Buslogic/Mylex)-Flashpoint, MultiMaster, DAC-

960; 

IDE controllers 

ATA-133, ATA-33-most controllers 

ATA-66 (not RAID)- HighPoint 366/368, Intel 

82801AB ICHO (440BX) Promise PDC20262, 



 E-Content of 

IT TOOLS AND BUSINESS SYSTEM 

Page | 94  
 

PDC2027x, PDC20265/7 VIA 82c596B/686A. 

Network cards 

3COM-3C905/B/C; D-Link-DFE-530/+; Rraltek-

RTL8029, RTL8139, RTL8139C+, RTL8169; 

IntelNEtherExpress Pro 100/1000; Netgear-

FA311TX; Linksys-LNE100TX; Silicon Integrated 

Systems- SiS900; Intel-DE4x5/Tulip series; GigE-

Broadcom Tigon3, Intel e1000, NatSemi NS83820, 

Realtek RTL8169 VIA - Rhine 

Modems 

100% Hayes-compatible Internal and external serial 

modems with hardware UART, NOTE: WinModems, 

host-based, HCF-, HSP-, HSF-, controllerless, host-

controlled, and soft modems are NOT supported. 

Sound cards 

C_Media-CM8338/CM8738; Creative Labs-

SoundBlaster 128 PCI, SoundBalster Livel, 

SoundBlaster Live! Audigy; Crystal-

CS428X/CS46XX; ESS-Maestro, Maestro2, 

Maestro3, Solo; Ensoniq-AudioPCI ES1370, 

ES1371; Intel-ICH, ICH2, ICH3, ICH4; Yamaha-

YMF724, 74x, 754; VIA-VIA82c686, VIA8233, 

VIA8235 
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Software Requirements 

 These requirements are common to all platforms 

 A working network card and internet connection is recommended during 

installation. 

 At least 1 GB memory, but 4 GB per processor core or more is 

recommended. 

 1-5 GB of disk space, depending on your licensed products and installation 

options. 

 Operating System Requirements 

 Linux 

32-bit Operating Systems 

Debian 5.0, 6.0 and 7.0 

OpenSUSE 11.3 

RedHat Enterprise Linux 5 and 6 

Ubuntu 10.04 and 12.04 LTS 

64-bit Operating Systems 

Debian 5.0, 6.0 and 7.0 

OpenSUSE 11.3 

RedHat Enterprise Linux 5 and 6 

Ubuntu 10.04 and 12.04 LTS 

 

  RedHat Enterprise Linux 5 is only supported for server, batch, and cluster 

operation. 

 OS Specific System Requirements 

32-bit Linux 

GNU C Library version 2.3.4 or later 

Linux kernel 2.6.18 or later 

Intel Pentium IV or AMD Athlon XP processor or later 

64-bit Linux 

GNU C Library version 2.3.4 or later 

Linux kernel 2.6.18 or later 

Intel Pentium IV or AMD Athlon XP processor or later. 
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 Graphics System Requirements 

 COMSOL Multiphysics is a finite element analysis, solver and Simulation 

software 

 COMSOL recommends hardware rendering for performance reasons. 

 Hardware rendering requires drivers that support OpenGL version 1.4. 

 Hardware rendering requires at least 24-bit color graphics. 

 Alternatively, software rendering can be used.  

 For performance reasons, we recommend that the graphics card has at least 

512MB memory. 

 

 Card Model Operating System Driver Version 

Linux 

 

FirePro V4800 

 

Ubuntu 10.04 LTS 

 

8.723.1-10048a-

09850C-ATI 

 

Quadro FX 1800 

 

Debian 6.0 

 

195.36.31 

 

 

 Parallel System Requirements  

 Linux 

Shared-memory Parallelism 

 

32-bit and 64-bit Linux Distributions 

Distributed-memory Parallelism 

 

RedHat Enterprise Linux 5 and 6, 

Debian 6, and Ubuntu 12.04.  
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Chapter : 3.13 Installing Linux OS 

Topic : 3.13.1A Preliminary step before installation and Disk Space requirement 

 

Preliminary step before installation 

 After user have obtained a distribution of Linux, they are ready to prepare their 

system for installation.  

 This takes a certain degree of planning, especially if user are already running 

other operating systems.  

Installation Overview  

 While each release of Linux is different, in general the method used to install the 

software is as follows 

 Repartition your hard drive(s)  

 Create Linux partitions  

 Boot the Linux installation media   

 Create file systems and swap space 

  Install the software on the new file systems 

 Repartition user's hard drive(s)  

 If user have other operating systems already installed, they will need to 

repartition the drives in order to allocate space for Linux.  

 Boot the Linux installation media   

 Each distribution of Linux has some kind of installation media-usually a "boot 

floppy"-which is used to install the software. 

 Booting this media will either present the user with some kind of installation 

program, which will step user through the Linux installation, or allow them to 

install the software by hand.  

 Create Linux partitions  

 After repartitioning to allocate space for Linux, user create Linux partitions on 

that empty space.  

 This is accomplished with the Linux fdisk program.  
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 Create file systems and swap space 

 At this point, user will create one or more file systems, used to store files, on 

the newly-created partitions.  

 In addition, if user plan to use swap space, they will create the swap space on 

one of their Linux partitions.  

 Install the software on the new file systems 

 Finally, user will install the Linux software on their newly-created file systems.  

 
Installation Disk Space Requirement 

 These recommendations are based on an installation that only installs one 

language (such as English). 

 If user plan to install multiple languages to use on their system, they should 

increase the disk space requirements.  

 Personal  Desktop 

 Workstation 

 Server  

 Custom  

 Personal  Desktop 

 A  personal  desktop installation, including a graphical desktop environment, 

requires at least 1.7GB of free space.  

 Choosing both the GNOME and KDE desktop environments requires at least 

1.8 GB of free disk space. 

 Workstation 

 A workstation installation, including a graphical desktop environment and 

software development tools, requires at least 2.1 GB of free space.  

 Choosing both the GNOM and KDE desktop environments requires at least 

2.2 GB of free disk space. 
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 Server  

 A server installation requires 850MB for a minimal installation without X(the 

graphical environment), at least 1.5 GB of free space if all package groups 

other than X are installed, and at least 5.0 GB to install all packages including 

the GNOME and KDE desktop environments. 

 Custom  

 A Custom installation requires 475 MB for a minimal installation and at least 

5.0 GB of free space if every package is selected.  
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Chapter : 3.13 Installing Linux OS 

Topic : 3.13.1B Boot methods 

 

Boot methods 

 There are several methods that can be used to install Red Hat Linux.  

 Boot CD-ROM  

 Boot Diskette 

 Driver Diskette  

 Installing from a CD-ROM requires that user have purchased a Red Hat Linux  

product, or user have a Red Hat Linux CD-ROM, and they have a CD-ROM 

drive.  

 Most new computers will allow booting from the CD-ROM. 

 If your system will support booting from the CD-ROM, it is an easy way to begin a 

local CD-ROM installation.  

 User BIOS may need to be changed to allow booting from your CD-ROM drive.  

 Boot CD-ROM  

 If user can boot using the CD-ROM drive, they can create their own CD-ROM 

to boot the installation program.  

 This may be useful, for example, if user are performing an installation over a 

network or from a hard drive. 

 If user choose to create a boot CD-ROM, it will not be necessary to create a 

driver diskette.  

 If user cannot boot from the CD-ROM drive, the following alternative boot 

method is available. 

 Boot Diskette 

 If user need a boot diskette, they must create it.  

 A boot diskette will be needed if user cannot boot from the CD-ROM.  

 It can be used to boot from a network, block, or PCMCIA device (user will 

also need the corresponding driver diskette for their booting scenario).  
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 The boot diskette image file, bootdisk.img, is located in the images directory 

on their Red Hat Linux CD-ROM. 

 If user choose to create a boot diskette, they must also create the appropriate 

driver diskette if they are installing over a network or from a hard drive.  

 Driver Diskette  

 If user are performing anything other than an IDE CD-ROM or hard disk 

installation and are using a boot diskette, they will need at least one driver 

diskette that user must make in advance.  

 User will be prompted by the installation program to insert the driver diskette 

at the correct time.  
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Chapter : 3.13 Installing Linux OS 

Topic : 3.13.1C Red Hat Linux installation 

 

Red Hat Linux installation 

 Red Hat Enterprise Linux is one of the best and stable Linux Operating systems. 

 

Fig 3.87: Red Hat Linux Installation window 

Red Hat Linux Installation steps 

Step 1 

 Select Install or upgrade existing system options. 

 

 

Fig 3.88: Installing or upgrading an existing system 

Step 2 
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 Select Language. 

 

Fig 3.89: Selecting a language 

Step 3 

 Select keyboard type. 

 

Fig 3.90: Selecting keyboard type 

Step 4 
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 Choose skip media test, click ok if user want to check media. 

 

 

Fig 3.91: Media section 

Step 5 

 Select storage device. 

 

Fig 3.92: Selecting storage device 

 

 

Step 6 



 E-Content of 

IT TOOLS AND BUSINESS SYSTEM 

Page | 105  
 

 Type computer name or hostname. 

 

Fig 3.93: Typing host name 

 

Step 7 

 Select time zone location. 

 

Fig 3.94: Selecting time zone location 

 

Step 8 

 Enter password for root user. 
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Fig 3.95: Entering password  

Step 9 

 Select type of installation and review partitioning layout carefully also may 

choose Encrypt system. 

 

Fig 3.96: Selecting installation type 

Step 10 

 Review partitioning layout, modify if needed.  
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 User have chosen default setup with Ext4 and LVM. 

 

 

Fig 3.97: Reviewing Partitioning layout 

Step 11 

 Manually configuration of LVM and RAID storage. 

 

 

Fig 3.98: Manual Configuration 

 

Step 12 

 Creating partition and formatting filesystems. 
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Fig 3.99: Formatting filesystems 

Step 13 

 Configuring boot loader options, also can give boot loader password for security 

reason. 

 

Fig 3.100: Configuring boot loader 

Step 14 

 Select applications to install and select customize now. 
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Fig 3.101: Installing and customizing 

Step 15 

 Customize package selections. 

 

Fig 3.102: Customizing package selection 

 

 

Step 16 

 Installation progress. 
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Fig 3.103: Installation processing 

Step 17 

 Installation is completed successfully. 

 

Fig 3.104: Installation completing 

 

 

Step 18 

 User reboot their computer and login with root credentials. 
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Fig 3.105: Rebooting the computer 

Step 19 

 Login Screen. 

 

Fig 3.106: Linux Login screen 
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Chapter : 3.14 Summary 

Topic : Summary 

 

 In this class, we have learnt about 

 Windows Operating system. 

 Different essential accessories. 

 Managing applications. 

 LINUX operating system. 
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Chapter : 3.15 Model Questions 

Topic : Model Questions 

 

 What are the versions of Microsoft Windows? 

 What are essential accessories used in Windows operating system? 

 Explain about Command promt. 

 Explain how the application management done in windows? 

 Explain detail about LINUX. 
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Assessment 1  
1. In which generation, operating system was introduced?. 

a) First 

b) Second 

c) Third 

d) Fourth 

2. Common elements of application windows include the control menu,  ___________ 

and border. 

a) Taskbar 

b) Dialog box 

c) Menu bar 

d) Icons 

3. The Start menu is a feature of the Windows Operating System that provides quick 

access to programs, folders and system settings.  

a) Start menu 

b) Control menu 

c) Taskbar 

d) Title bar 

4. How many modes of calculation in a computer calculator 

a) One 

b) Two 

c) Three 

d) Four 

5. The running applications can be managed using the ______________. 

a) Task manager 

b) Taskbar 

c) Start menu 

d) Control menu 

Answers: 

1.b 

2.c 

3.a 

4.d 

5.a 
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Assessment 2  
 

1. The Linux system is most compatible with a number of UNIX standards. 

a) True 

b) False 

2. Command Prompt is a command line interpreter application available in most 

Windows operating systems. 

a) True 

b) False 

3. In Command Prompt, both keyboard and mouse can be used. 

a) True 

b) False 

Answers: 

1.a 

2.a 

3.b 
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Chapter : 4.1 Objectives 

Topic : 4.1 Objectives 

 

Objectives 

 At the end of the course the user will be able to  

 understand the basic concepts of word processing 

 know about word processing techniques 

 understand the concept of editing and profiling tools 

 understand the various shortcuts while using word software 

 know to prepare the document much easier. 
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Chapter  : 4.2 Word Processing Concepts 

Topic  : 4.2.1 Introduction to Word Processing 

 

Introduction to Word Processing 

 The term “word processing” means writing, editing and production of documents 

as letters, reports and books, through the use of a computer program or a 

computer system. 

 Most people, who use a computer, commonly use word processing tools. 

 The word processing software allows user to create text documents that includes 

pictures and drawings.  

 Microsoft word is a versatile, easy-to-use word processing program. 

 

 

 

FIG 4.1: Word processing 
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What a user can do with MS word? 

 A word processor enables users to  

 Create documents like letters, resume, letter heads & business usage. 

 Store it electronically on a disk. 

 Enter and modify characters using keyboard and print with the help of 

printer. 

 The Word processor has different variety of uses and applications within the 

business circle, home and education departments. 

 It saves time of the user and enhances document appearance. 

The advantage of using Microsoft word 

 MS word has many features like highlight, table creation, justify, fonts, 

paragraph, bullets and numbering, editing the document, adding pictures and 

graphs, creating group letters, spelling and grammar check etc. 

 

FIG 4.2: Options in MS-word 
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Versions of Microsoft Word 

 Word 1990 to 1995 

 Word 1997 

 Word 1998 

 Word 2001/Word X 

 Word 2002/XP 

 Word 2003 

 Word 2004 

 Word 2007 

 Word 2008 

 Word 2010 

 Word 2011 

 Word 2013 

 MS word 2013 is the latest version and its advantage is its ability to store and 

access files in cloud storage.  

                

 

 

FIG 4.3: MS Word 2010 Icon  
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FIG 4.4: Home page of MS Word 2010 

 

 

 

FIG 4.5: Overview of MS-Word 2010 
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Chapter  : 4.2 Word Processing Basics 

Topic  : 4.2.2 Opening a word processing package 

 

Opening a Word processing package 

 The word processing package can be opened in many ways, some of them are 

 Single click the word icon on the task bar. 

 Double click the word icon on the Desktop. 

 If the word icon is not on the Taskbar or Desktop, users can access it by 

clicking Start → All Programs → Microsoft Office → Microsoft Office 

Word 2010. 

 

FIG 4.6: Blank/New Word Document 
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Chapter  : 4.2 Word Processing Basics 

Topic  : 4.2.3 Opening An Existing Document 

 
How to open an existing Document? 
 

 Under File Menu, click Open. 

 

FIG 4.7: Open option in File Menu 

 It will navigate the user to the Open window. 

 From file list, select All Word Document. 

 Choose the drive and folder from which the file needs to be opened. 

 Choose the desired file to be opened and then click Open or just double click on 

the file to be opened. 
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FIG 4.8: Open Window for selecting document 
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Chapter  : 4.2 Word Processing Concepts 

Topic  : 4.2.4  Saving a document                

Saving a document 

 Saving a document is the process of applying the modifications to the original 

word document.  

 It is simply done with the keyboard shortcut CTRL+S or by clicking SAVE icon . 

 Whenever the user creates or edits a document, it is stored in the temporary 

memory until the user saves the document permanently. 

 The data can be lost if a power failure or computer hardware problem occurs.  

 So, it is always good practice to save the work frequently. 

 In the word software, user can use either the Save or Save As command to save 

a document.  

 Some guidelines about saving documents in word 

 Use Save option to save a document for the first time. 

 Use Save As to save an existing document under a new name. Save As 

creates an entirely new file and leaves the original document unchanged. 

 Use Save to update an existing document. 

 The first step in saving a document for future use is to assign a file name. 

 The rules for naming documents are 

 File names can contain up to 260 characters, including the drive letter, the 

folder name and extension.  

 The following characters cannot be used in a file name: /\><*?”:|. 

 File names can include uppercase letters, lowercase letters, or a combination 

of both.  

 They can also include spaces. 

 Before saving a new document, decide as where to save it.  

 

 Word saves documents in the current drive and folder, when the location is not 
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specified.  

 Under File menu click Save As. 

 

 

FIG 4.9: Save As option 

 It will navigate users to the Save As window. 

 User can create new folder in the desired place by selecting the New Folder 

option in the Save As dialog box. 

 

 Then choose the file type and type the file name in the File name text box, and 

then click Save button. 

 After the document is saved in the desired location, if user wish to save the 
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edited content again, they should use the Save button from File Menu or Ctrl+S 

to save the edited text. 

  

 

FIG 4.10: Save As Window 
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Chapter  : 4.2 Word Processing Concepts 

Topic  : 4.2.5 Closing a document 

 Closing a document 

 After finishing the work on a document then the user needs to save it and then 

close the document, and he can open another document or exit the Word. 

 The easiest ways to close a document and exit Word are 

 Click the Close button in the upper right corner of the Word window. 

 Choose the Close command from the File tab. 

 The Keyboard shortcuts to close word are 

 Press Ctrl + W to close a document. 

 Press Alt + F4 to exit Word. 
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Chapter  : 4.2 Word Processing Concepts 
 

Topic  : 4.2.6 Text Selection 
 

Text Selection 

 Selecting text is a basic technique that makes revising documents easy. 

 When text is selected, that area of the document is called selection, and it 

appears as a highlighted block of text.  

 A selection can be a character, group of characters, word, sentence, or 

paragraph or the whole document. 

 User can select the text in several ways, depending on the size of the area you 

want to select. 

 

 Text selection methods 

 Select the text by dragging the mouse over the desired text while keeping the left 

mouse button depressed, or hold down the SHIFT key on the keyboard while 

using the arrow buttons to highlight the text.  

 The following information contains shortcuts for selecting a portion of the text 

 Whole word →  double-click within the word. 

 Whole paragraph →  triple-click within the paragraph. 

 Several words or lines →  drag the mouse over the words or hold 

down SHIFT while using the arrow keys. 

 Entire document, choose → Edit | Select | Select All from the Ribbon, or 

press Ctrl+ A. 

 In Word, user can select noncontiguous text by keeping Ctrl button depressed 

and then selecting the text with mouse. 

 



E-Content of 

IT TOOLS AND BUSINESS SYSTEMS 

Page | 16  
 

 

FIG 4.11: Text selection 
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Chapter  : 4.2 Word Processing Concepts 

Topic  : 4.2.7  Editing text 

 

Editing text 

 Using the word, user can quickly and painlessly edit text you which have already 

typed.  

 There are many ways to edit content in a document.  

 Some options are as listed below 

 Tying and Inserting Text 

 Inserting Additional text 

 Copy and Paste text 

 Deleting Blocks of text 

 Undo and Redo changes 

 

Typing and Inserting Text 

 To Edit the text, just start typing, the text will appear where the blinking cursor is 

located. 

 Move the cursor by using the arrow buttons on the keyboard or positioning the 

mouse and clicking the left button.  

 The keyboard shortcuts listed below are also helpful while typing the text in a 

document.  

 Beginning of the line → HOME key 

 End of the line → END key 

 Top of the document → CTRL+ HOME key 

 End of the document → CTRL+ END key 

 

Inserting Additional Text 



E-Content of 

IT TOOLS AND BUSINESS SYSTEMS 

Page | 18  
 

 Text can be inserted in a document at any point using any of the following 

methods 

 Type Text 

 Copy and Paste Text 

 Cut and Paste Text 

 Drag Text 

 Type Text 

 Place the cursor where user wants to add text and type it. 

 Check whether if user is in Overwrite mode or not. 

 When editing text in overwrite mode, it replaces any existing characters to the 

right side of the insertion point. 

 To make it in non-overwrite mode, follow these steps 

 Click File menu, then at the bottom, click Option. 

 In the left pane, click Advance. 

 Under editing options, select or clear the Use Overtype mode check box. 

 

FIG 4.12: Word Option Window 

 Copy and paste Text 
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 To select a word or a line, then click the Copy button under home tab or use 

Ctrl + C. 

 Then place the cursor where to paste the copied text. 

 Click Paste button under home tab, or use Ctrl + V. 

 Cut and Paste Text 

 Select a word or a line, then click the Cut button under home tab or use 

Ctrl+ X. 

 Then place the cursor where to paste the text. 

 Click Paste button under home tab, or use Ctrl + V. 

 

FIG 4.13: View of Clipboard 

 

 

 Drag Text 

 To move within the same document 
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 Select a portion of text that the user wants to move from any of selection 

options. 

 Then move the mouse pointer to the selected text and hold the left mouse 

button while moving around the document. 

 Take mouse pointer to the place where to place it. 

 To move within different documents 

 Keep both the documents open, click Arrange all button under  the View 

tab 

 After that, two documents will display like this. 
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FIG 4.14: Display of two windows after Arrange all button is selected 

 Select the text from one document and hold user left mouse button and 

drag that text to the next document. 

 User can switch through the different window to move the text by using 

the Alt + Tab keys. 

 

Deleting Blocks of Text 
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 User can use Backspace or Delete key on the keyboard to delete text. 

 Backspace 

 The Backspace key will delete text to the left of the insertion point. 

 Ctrl + Backspace 

 This key will deletes the whole word to the left of the insertion point. 

 Delete 

 The Delete key will delete the text to the right of the insertion point. 

 Ctrl + Delete 

 This key will deletes the whole word to the right of the insertion point. 

 Using selection Method 

 Select the text or a line or a paragraph to delete by using any one of the 

selection methods such as 

 By simply double click on a word. 

 By using Shift + Arrow keys (depends on the direction). 

 By using Ctrl + double click on different words. 

 Press Ctrl + A which select the entire document. 

 Then click Delete key on the keyboard. 

Undo and Redo Changes 

 Word remembers the changes made by the user in a document and lets the user 

to undo or redo those changes.  

 For example, if the user accidentally deletes a text, then the user can use the 

Undo command Ctrl + Z to reverse the action and restore the text.  

 If user changes his mind and decide to keep the deletion, then they can use the 

Redo command Ctrl + Y to reverse the canceled action. 

 To undo changes use any one of the following methods 

 Click the Undo button on the Quick access toolbar.  
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 Use key combination (Ctrl + Z). 

 To redo changes 

 Click the Redo button on the Quick access toolbar.  

 Use key combination (Ctrl + Y). 

 

 

 

FIG 4.15: Quick Access Toolbar 
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Chapter  : 4.2 Word Processing Concepts 

Topic  : 4.2.8 Find And Replace 

 

Find and Replace 

 To find a particular word or phrase in a document 

 Click Find button on the Editing group on the Ribbon. 

 Or use keyboard shortcuts as Ctrl + F. 

 To find and replace a word or phrase in the document 

 Click Replace button on the Editing group tab. 

                                                       

     FIG 4.16: Editing Group 

    

  FIG 4.17: Find and Replace dialog box 

 Type the text in Find what text box and Replace with text box to replace 

particular word. 

Steps to Find and replace a text 
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  Click the Editing button on the ribbon bar to reveal the edit options. The Edit 

options may be visible already if your Word window is large enough to support 

them. 

 Click the Replace menu item. 

 The Find and Replace dialog box appears, with the selected Replace tab. 

 

FIG 4.18: Finding and Replacing Words 

 In the Find what, type the word in the document. In the Replace with, type the 

word to be replaced. 

 Click the Replace All button to replace all instances of the word in the document. 

 A dialog box will appear indicating the number of replacements made. Click the 

OK button. 
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 If the user thinks this type of global replace is risky, then they can use the 

Replace button to approve each replacement. This same dialog box is used for 

the Find feature, which allows the user to search for text in the document. 

 Click the Close button to close the Find and Replace dialog box if it is still open. 
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Chapter  : 4.2 Word Processing Concepts 

Topic  : 4.2.9 Printing a Document 

 

Printing a document 

 After creating a document, printing is easy. User can use any of the following 

methods 

 Choose Print from the File tab. 

 Press Ctrl + P 

 Clicking the Print button sends the document directly to the printer, using Word’s 

default settings. 

Steps to print a document 

 Click the File tab. Click the Print command. The Print tab displays Word’s default 

print settings and a preview of the document. 

 

FIG 4.19: Print option in File Menu 
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 Click the PRINT button to accept the default print settings. 

 

FIG 4.20: Overview of Print Preview window 

 Then select the PAGE RANGE and NUMBER OF COPIES and click OK button. 

 

FIG 4.21: Print option dialogue box 
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Chapter  : 4.2 Word Processing Concepts 

Topic  : 4.2.10 Creating and Printing a Merged Documents 

Creating and Printing Merged Documents 

 Mail merge is a useful tool that will allow the user to easily produce a set of 

documents. 

 Each document has the same kind of information, yet some of the content is 

unique. 

 For example, in advertisement or invitation letters the main contents will be same, 

but there will be difference only in the name and address for each customer. 

 The information in each letter comes from entries in a data source such as a 

spreadsheet.  

 If there is no existing address list, then create the new address list. 

Creating a Merge Document 

 A Mail Merge document is created in MS Word to print mailing documents.  

 The data and fields for merging documents are imported from the MS Excel 

database.  

 Creation of documents depends mainly upon knowing what data should be 

printed and what formatting should be applied.  

 

FIG 4.22: Start Mail Merge option 
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Steps followed to create a Merge Document 

 Start MS Word and type the letter content. 

 Then click the mailings tab and click Start mail merge option. 

 Click step by step mail merge wizard. It will open a mail merge window on the 

right side of the screen. 

 Then choose the document type as needed. The definition of each type will be 

displayed below. Then click on next. 

 Choose use current document. This option will use the currently opened 

document to create mail merge. Click next. 

 Choose use an existing list. This will use the existing Excel document for   

customer details. Then click the browse option, to select the existing customer 

details document. 

 If there is no existing customer details document, then create and save the new 

document by selecting create new option and then select that newly created 

customer details document. Click next. 

 Now a mail merge recipient’s dialogue box will be displayed. From that select the 

recipients to whom the mail is to be sent. Then click ok. 

 Now place the cursor on the document where the address of the recipient is to 

be added. 

 Then click the Address block option and select the needed recipients name 

format from the mailmerge wizard window. Now the address block will be 

included in the document. 

 Then place the cursor in right side of the document and click on the greeting 

line option and select the needed greeting line format to be included. Then click 

next. 

 Now the mail merge document preview will be displayed. user can check the 

created document of each recipient by clicking the forward and backward 

buttons. 

 User can also exclude recipients during this preview stage by clicking  Exclude 
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the recipient button, when the user preview the recipient document. Then click 

next. 

 Finally, choose Edit individual option to make any corrections if available , and 

select All and click ok. Then save the created merged document or user can 

directly print the merged document by clicking print button and selecting All 

option in the Print option dialogue box. 

 

 

FIG 4.23: Preview of Merged Document 

 

Printing a Merged Documents 

 Printing a merged document is same as a normal document. 
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 User gets an extra window where user can select which data source to use, and 

which records to print. 

 The steps involved to print a merge documents are 

 Open any of the mail merge envelopes, labels, or letters created previously. 

 Choose Finish & Merge > Print Document , under  the mailing tab. 

 

 

FIG 4.24: Printing of merged document 

 

 Then from Merge To Printer dialog box. Choose the document page which 

needs to be printed. User can choose either 

 All. 

 Current record. 

 Particular page intervals. 

 

FIG 4.25: Printing of merged document 
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Chapter  : 4.2 Word Processing Concepts 

Topic  : 4.2.11 Character Formatting 

Character Formatting 

 The text in user document is very plain. So, user can add some formatting 

features like BOLD, ITALIC, UNDERLINE, FONT, FONT COLOUR etc., to add 

some interest and emphasis to the text. 

 

 

FIG 4.26: Font tab  

 Use the mouse to drag and select a word in a document. 

 Clicking somewhere else in the document removes the selection highlighting. 

 The font style of the text can be modified as needed. User can select it from 

several available font styles. 

 Font size can be kept as needed by choosing the required size. 

 Font colors can be changed by selecting the text and choosing the appropriate 

color from the color pane. 

 Click the Bold button to add bold formatting. Since the text is selected, the text 

appears darker and slightly larger. 

 User can use the Bold button to remove the bold formatting as well. 



E-Content of 

IT TOOLS AND BUSINESS SYSTEMS 

Page | 34  
 

 

FIG 4.27: Bold text 

 User can also apply formatting to a large block of text rather than to one word or 

line at a time. 

 Similarly, users can add italic and underline. 

 Italic  

 This formatting slants the characters. 

 Use this sparingly in documents.  

 It is suitable for emphasis, but it slows down the reader. 

 Click the Underline button to add underline to the text. 

 

 The Bold formatting, the italic and underline formatting can also be applied or 

removed by clicking again on the corresponding buttons. Formatting can also be 
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combined.  

 

 

 

FIG 4.28: Text editing options 
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Chapter  : 4.2 Word Processing Concepts 

Topic  : 4.2.12 Paragraph Formatting 

Paragraph Formatting 

 Paragraph formatting is the process of modifying the contents of the paragraph 

to make it formal, attractive and understandable. 

 

FIG 4.29: Paragraph formatting options 

 Paragraph formatting types 

 Alignment of Paragraph. 

 Paragraph Indenting. 

 Bullets and Numbering. 

Alignment of Paragraph  

 There are three types of alignment 

 Align the text left or right 

 Center the text 

 Justify the text 

 

 

 

 Align the text left or right 
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 Select the text to align. 

 On the Home tab, in the Paragraph group, click Align Left or Align 

Right button. 

 Center the text 

 Select the text to center. 

 On the Home tab, under Paragraph group, click Center button. 

 Justify the text 

 Select the text to justify. 

 On the Home tab, under Paragraph group, click Justify button. 

Paragraph Indenting 

Method 1 

 Select the line to apply the indent, then press "Increase indent" or "Decrease 

indent" button in "Paragraph" group. 
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Method 2 

 Open the Paragraph dialog box on the lower right corner inside “Paragraph” 

group, click the small arrow. User can open this through the “Paragraph” group in 

the “Home” tab or the “Page Layout” tab. 

                

FIG 4.30: Paragraph Dialog Box 

 

 Find the “Indentations” section. This can be found in the “Indents and Spacing” 

tab. 

 Click the drop down menu under “Special”. Select “First Line” it automatically 

indent the first line of each new paragraph. 
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 Enter the indent size 

 Enter the amount that each line needs to be indented.  

 The most commonly used size is 0.5 or 1/2 of an inch.  

 User can see a preview of the changes in the Preview section at the bottom 

of the dialog box. 

 Click OK to save user changes and apply them to the document. 

 Click the “Set as default” button if user wants to set the changes revert 

automatically take effect only after new documents. 

Method 3 

 Click on the "Page Layout" tab, at the top of the Ribbon in MS-Word 2010.  

 In the section of "Paragraph" click on the little arrow button in the bottom right-

hand corner. 

 The user will be navigated to the same "Paragraph" dialog box which can be 

viewed in the 2nd method. 

 Then make all the changes as user desired and click OK, and continue typing 

Bullets and Numbering 

 To apply Bullets and Numbering to the selected text. Go to the Paragraph 

section under Home tab, use bullets and numbering button. 

 Click small down arrow on the Bullets button. 

 User may navigate to a display box. From that display box user can select any 

bullet from different types of bullets to insert. 
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FIG 4.31: Bullets and Numbering 
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Chapter  : 4.2 Word Processing Concepts 

Topic  : 4.2.13 Page Design And Layout 

Page Design and Layout 

 While creating the document, the user should first consider about the page 

layout of the document.  

 The page layout affects how content appears and includes the page's 

orientation, margins, and size. 

 

 

FIG 4.32: Page Layout tab 

 Page layout is the part of graphic design that deals in the arrangement of visual 

elements on a page. 

 MS word offers the following Page Design and Layout options: 

 Page Orientation. 

 Page Margins. 

 Page Size. 

Page Orientation 

 Word offers two page orientation options 

 Landscape 

 Portrait 

 Landscape means the page is oriented horizontally, while portrait means the 

page is oriented vertically. 

http://en.wikipedia.org/wiki/Graphic_design
http://en.wikipedia.org/wiki/Page_(paper)
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FIG 4.33: Page Layouts 

Steps to change page orientation 

 Select the Page Layout tab. 

 Click the Orientation command in the Page Setup group. 

 A drop-down menu will appear. Click either Portrait or Landscape to change the 

page orientation. 

 The page orientation of the document will be changed.  

Page Margins 

 A margin is the space between the text and the edge of your document. 

 By default, a new document's margins are set to Normal, which means it has a 

one-inch space between the text and each edge.  

 Depending on user needs, Word allows to change the document's margin size. 

 

FIG 4.34: Page Layout 

 Steps to format Page Margins 

 The word has a variety of predefined margin sizes to choose from. 

 Select the Page Layout tab, and then click the Margins command.          
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 A drop-down menu will appear. Click the predefined margin size, which is 

needed. 

 The margins of the document will be changed.  

 

 

 

FIG 4.35: Page Margins 

 

Steps to use custom margins 

 Word also allows user to customize the size of margins in the Page Setup dialog 

box. 

 From the Page Layout tab, click Margins. Select Custom Margins, from the 

drop-down menu. 
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 The Page Setup dialog box will appear. 

 Adjust the values for each margin, and then click OK. 

 The margins of the document will be changed. 

 

 

 

FIG 4.36: Custom Margins 

 

Page size 

 By default, the page size of a new document is 8.5 inches by 11 inches. 

 Depending on the project, user may need to adjust the document's page size.  

 It's important to note that before modifying the default page size, user should 

check to see which page size his printer can accommodate. 
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FIG 4.37: Page Sizes 

 

 

 

 

 

Steps to change the page size 

 The word has a variety of predefined page sizes to choose from. 

 Select the Page Layout tab, and then click the Size command. 

 A drop-down menu will appear. The current page size is highlighted. Click the 

desired predefined page size. 

 The page size of the document will be changed.  
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FIG 4.38: Page Size options 

 

 

 

 

Steps to use custom page size 

 Word also allows the user to customize the page size in the Page Setup dialog 

box. 

 From the Page Layout tab, click Size. Select More Paper Sizes, from the drop-

down menu. 

 The Page Setup dialog box will appear.  

 Adjust the values for Width and Height, and then click OK. 
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 The page size of the document will be changed. 

 Alternatively, user can open the Page Setup dialog box by navigating to the Page 

Layout tab and clicking the small arrow in the bottom-right corner of the Page 

Setup group. 

 

 

FIG 4.39: Custom Page Size 
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Chapter  : 4.3 Editing and Profiling Tools 

Topic  : 4.3.1 Checking and Correcting Spelling 

 

Checking and Correcting Spelling  

 Word checks the spelling and grammar frequently as the contents are typed. 

 A red squiggly line under a word denotes that Word thinks it has been spelt 

incorrectly. 

 If the line is green, then the grammar may be incorrect. 

 If the line is blue, then the word is correctly spelled but improperly used. 

 

 

FIG 4.40: Error Detection 

To run a spelling and Grammar check 

 User can check the whole or part of the text for mistakes using the Spelling and 

Grammar button.  

 From the Review tab, click the Spelling & Grammar command. 

 The Spelling and Grammar pane will appear.  

 For each error in your document, Word will try to offer one or more suggestions. 

 User can select a suggestion and click Change to correct the error. 

 Word will move through each error until the user review them all. 
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 After the last error has been reviewed, a dialog box will appear confirming that 

the spelling and grammar check is complete.  

 Click OK. 

 If no suggestions are given, user can manually type the correct spelling in his 

document. 

 

FIG 4.41: Spelling and Grammar check option 

Ignoring errors 

 The spelling and grammar check is not always correct.  

 Particularly with grammar, there are many errors Word will not notice. 

 There are also sometimes when the spelling and grammar check will say 

something's an error when it's actually not.  

 This often happens with people's names, which may not be in the dictionary. 

 If Word says something is an error, user can choose not to change it.  

 For spelling errors 

 Ignore: This will skip the word without changing it.  

 Ignore All: This will skip the word without changing it, and it will also skip all 

other instances of the word in the document.  

 Add: This adds the word to the dictionary so it will never come up as an error. 

Make sure the word is spelled correctly before choosing this option. 
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FIG 4.42: Ignoring Error 

 For grammar errors 

 Ignore: This will skip the word or phrase without changing it.  

 For grammar errors, Word provides an explanation for why it thinks something is 

incorrect. This can help you determine whether you want to change or ignore it. 

Automatic spelling and grammar error checking 

 By default, Word automatically checks the document for spelling and grammar 

errors, so user may not even need to run a separate check. These errors are 

indicated by colored, wavy lines. 

 The red line indicates a misspelled word.  

 The blue line indicates a grammatical error, including misused words.  

 A misused word occurs when a word is spelled correctly but used incorrectly. 

Steps to change the automatic spelling and grammar check settings 
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 From the Review tab, click the Spelling & Grammar command and then click 

Options. 

 A dialog box will appear. On the left side of the dialog box, select Proofing.  

 

FIG 4.43: Spelling and Grammar check dialog box 

 The dialog box gives several options to choose from 

 If the user doesn’t want Word to automatically check spelling, uncheck Check 

spelling as you type. 

 If the user doesn’t want grammar errors to be marked, uncheck Mark 

grammar errors as you type. 

 If the user doesn’t want Word to check for contextual errors, uncheck Use 

contextual spelling. 

 By default, Word does not check for sentence fragments (incomplete sentences) 

and run-on sentences.  

 To turn on this feature, click Settings in the dialog box, then check the 

Fragments and Run-ons option. 



E-Content of 

IT TOOLS AND BUSINESS SYSTEMS 

Page | 52  
 

 

FIG 4.44: Spelling Check Options dialog box 
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Chapter  : 4.3 Editing and Profiling Tools 

Topic  : 4.3.2 Handling Graphics 

 

Handling Graphics 

 MS word allows the user to communicate information with graphics instead of 

just using text. 

 Graphics can be added into the word document by choosing the required options 

available in the illustrations group under the Insert tab. 

 There are a variety of several other types of options, which user can use to 

illustrate many different types of ideas. 

 Types of options available in the MS word are 

 Clipart 

 Text Wrapping 

 Inserting Pictures 

 Word Art 

 WaterMark 

 

What is Clip Art? 

 Adding Clip Art to the document is a way to illustrate ideas.  

 Clip art is a collection of graphic images that can be inserted in documents. 
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Steps to Insert a Clip Art 

 Click the Insert tab and from the Illustrations grouping, click on Clips Art. 

 

FIG 4.45: Clip Art 

 The Clip Art Task pane will open on the right of the screen.  

 In the three fields that are provided, user can search for a particular topic, in all 

the collections provided by Microsoft and all media types.  

 After clicking the Go button the search will return a list of clip art.  

 Use the scroll bar to locate a clip, which the user likes. 

 Click once on the clip art to insert it into the user document. 

 

FIG 4.46: Clip Art task pane 
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What is Text Wrapping? 

 Wrapping means that text flows around a graphic object rather than over it. 

Wrapping Text Around Graphics 

 Click on the image to be wrapped. 

 And from the Arrange grouping under page Layout tab , select the Wrap text 

option.  

 

FIG 4.47: Wrap Text 

 Click one of the text wrapping options that appears. 

 Click More Layout Options, to change which sides of the object to place text or 

change the distance between the text and object.  

 When the Graphic is selected, user can also click-hold and drag the graphic to a 

new position.  

 It allows the user to control how many lines of text are above to the right or Left 

of the graphic. 
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FIG 4.48: Text wrapping Layouts 

Inserting Pictures from Files 

 In addition to the clip art graphics that come with Word, user can insert graphics 

that were scanned or created in the other graphics programs into the documents. 

How to insert a picture? 

 Place the cursor in the document where the picture/ illustration wants to be 

inserted. 

 Click the Insert Tab on the Ribbon. 

 Click the Picture Button. 

 Browse to the picture to include. 

 Click the picture and click on the insert button. 
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FIG 4.49: Insert Picture Option 

Word Art 

 Word Art is another powerful graphics tool that the user can use to make his 

documents with visual impact.  

 Text in Word Art is formatted in unique shapes, orientations, and patterns that 

the user can easily modify and customize. 

How to Insert Word Art 

 Click the Insert tab, from the Text grouping; click the Word Art dropdown arrow. 

 Click a style of WordArt from the Gallery. 
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FIG 4.50: Word Art Styles 

 Type the text in Your Text here box, user can change the font and size before 

Clicking OK. 

 

FIG 4.51: Word Art Text 

 It can be resized by dragging the white handles and position as desired. 

 Check out the WordArt Tools Format Ribbon for text, edit, style changes, spacing 

and height.  

Watermark  
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 A watermark is a graphical object which appears very faintly in the background 

of a page. 

Steps to Insert Watermark 

 Click the Page Layout Tab in the Ribbon. 

 Click the Watermark Button in the Page Background group. 

 Click the watermark that is needed for the document or click Custom   

Watermark to create the new watermark. 

 An Image can also be used as a Watermark.  

 To remove the watermark follow the steps above, but click Remove Watermark. 

 

FIG 4.52: Watermark 
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Chapter  : 4.3 Editing and Profiling Tools 

Topic  : 4.3.3 Creating Tables And Charts 

 

Creating Tables And Charts 

Tables 

 A table is made up of rows and columns. The intersection of a row and column is 

called a cell. 

Create a Table 

 Click the Insert tab on the Ribbon 

 Click the Table button 

 Select Insert Table. 

 

FIG 4.53: Insert Table Option 

 Click the arrows to select the desired number of columns and rows. 

 Then click OK. 
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FIG 4.54: Insert Table Dialog Box 

Insert a Row or Column 

 Position the cursor in the table where the user would like to insert a row or 

column. 

 Right click the mouse and click on Insert option. 

 To insert a Row, Click either the Insert Row Above or the Insert Row Below 

button. 

 To insert a Column, Click either the Insert Columns to Left or Insert Columns 

to Right button. Or it can be done on layout tab. 
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FIG 4.55: Insert a Row or Column 
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Delete a Row or Column 

 Position the cursor in the row or column which should be deleted. 

 Then right click the mouse and click Delete Cells Option . 

  Click the Delete entire row to delete a row or Click Delete entire column to 

delete a column. 

 Then click ok. 

                               

 

FIG 4.56: Delete a Row or Column 

Charts 

 A chart is a tool which the user can use to communicate the data graphically. 

 Including a chart in the document will help the reader to see the meaning behind 

the numbers, and it makes the comparisons to be shown easier. 

 The word has many different types of charts, allowing the user to choose the one 

that fits best to the data.  

 In order to use charts effectively, user needs to understand as how different 

charts are used. 

 

FIG 4.57: Charts in Excel 

How to Insert a Chart 
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 Position the cursor on the document, where the chart is to be inserted. 

 Open the Insert ribbon. 

 Click Chart in the Illustrations section. 

 

FIG 4.58: Chart button in word 

 

FIG 4.59: Chart Templates 

 Select the style of chart to insert and click OK. 

 A chart and a spreadsheet will appear.  

 The data that appears in the spreadsheet is placeholder source data that the 

user will replace with their own information.  

 The source data is used to create the Word chart. 
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FIG 4.60: Chart and Spreadsheet 

 Enter the data into the worksheet. 

 If necessary, click and drag the lower-right corner of the blue line to increase or 

decrease the data range for rows and columns.  

 Only the data enclosed by the blue lines will appear in the chart. 

 When it is done, click the close button to close the spreadsheet.     

 The chart will be completed.     

 User can edit the chart data at any time by selecting the chart and clicking the 

Edit Data command on the Design tab. 

Creating charts with existing Excel data 

 If the user already has the data in an existing Excel file, for which the chart is to 

be created. Then the user can transfer the data by copying and pasting it.  

 To copy the data, open the spreadsheet in Excel, select and copy the desired 

data and paste it into the source data area of the Word chart. 

 User can also embed an existing Excel chart into a Word document. 

 This can be useful when the user knows that user needs to update the data in his 

Excel file and when he needs his Word chart to automatically update whenever 

the Excel data is changed. 
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Chapter  : 4.3 Editing and Profiling Tools 

Topic  : 4.3.4 Document templates and wizards 

Document Templates 

 Document templates in Word are very simple and it offers customizable options. 

 Document templates will help the user to prepare his documents as it looks more 

attractive and formal. 

 There are many predefined templates in different categories, such as 

 Letters 

 Charts and diagrams 

 Reports 

 Certificates 

 Business cards 

 Books 

 Calendars, etc 

 

 

Using Existing Template 

 To start a new document, Click the File tab and then click New option which will 

display Available Templates to be selected. 
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FIG 4.61: Available Templates 

 

 Microsoft Word provides a list of templates arranged under Sample Templates 

or user can download hundreds of templates from office.com which are 

arranged in different categories.  

 User will use Sample Templates for their document, click over Sample 

Templates which will display a gallery of templates. User can try to use 

office.com option to select a template for their requirement. 

 



E-Content of 

IT TOOLS AND BUSINESS SYSTEMS 

Page | 68  
 

                        

FIG 4.62: Sample Templates 

 

 User can browse a list of available templates and finally select one of them for   

document by double clicking over the template.  

 User select Equity Report template for report purpose.  

 While selecting template for a document, would have to select Document 

Option available in the third column.  

 This opens the document with predefined setting which can modify document 

title, author name, heading etc. as per document requirement. 
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FIG 4.63: Selected Template 

Create New Template 

 User can create a fresh new template based on requirement or can modify an 

existing template and save it for later use as a template.  A Microsoft Word 

template file has an extension of .dotx.  

 To create a new template using an existing template, Click the File tab and then 

click New option which will display Available Templates to be selected. Select 

any of the available templates and open it with Template Option turned on. 
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FIG 4.64: Template Option 

 

 Now user can modify opened template as per requirements and once user done, 

save this template with .dotx extension which is standard extension for Microsoft 

Word Templates. 
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FIG 4.65: Modified Template 

 User can create a template from a new document as well. Click the File button, 

and click New option to open a new document. Under Available Templates, 

double click Blank Document to create a new document template. Save the 

template with a unique name and .dotx extension. 

 User can save created template anywhere and whenever like to use this 

template, just double click over the template file and it will open a new template 

based on the document for User. 
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Chapter : 4.4 Summary  

Topic  : Summary 

 

 In this class, user have learnt about 

 the basic concepts of word processing 

 about word processing techniques 

 the concept of editing and profiling tools 

 the various shortcuts while using word software 

 to prepare the document much easier. 
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Chapter : 4.5 Model Questions 

Topic  : Model Questions 

 

Model Questions 

1. Explain about the basic concepts of word processing. 

2. Describe about word processing techniques. 

3. Explain the concept of editing and profiling tools in MS-Word. 

4. What are all the various shortcuts present in MS-Word? 

5. How to prepare a document much easier? 
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Assessment 1 

1. _____________ a document is the process of applying the modifications to the 

original word document.  

a) Closing 

b) Restarting 

c) Saving 

d) Opening 

 

2. Which shortcut key is used to close a document in MS word.  

a) Ctrl+s 

b) Ctrl+w 

c) Ctrl+o 

d) Ctrl+d 

 

3. Which key will deletes the whole word to the left of the insertion point. 

a) Backspace 

b) Delete 

c) Ctrl+Delete 

d) Ctrl+Backspace 

 

4. What happens when ctrl+a shortcut key is pressed? 

a) Selects the whole document 

b) Select single line 

c) Selects a single paragraph 

d) None of the above 

 

5. Landscape means the page is oriented _________, while portrait means the page 

is oriented ____________. 

a) Vertically , Horizontally 

b) Horizontally, Vertically 

c) Top, bottom 

d) Bottom, Top 
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Answers: 

1.c 

2.b 

3.b 

4.a 

5.b 
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Assessment 2  

1. A margin is the space between the text and the edge of a document. 

a) True 

b) False 

2. The shortcut key ctrl+s is used to restore a document. 

a) True 

b) False 

3. The spelling and grammar check is not always correct.  

a) True 

b) False 

Answers: 

1.a 

2.b 

3.a 
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Chapter : 5.1 Objectives 

 

Objectives 

 At the end of the course the users will be able to  

 understand the concept of electronic spreadsheet 

 understand the functions in spreadsheet 

 know how to formatting a worksheet 

 understand the usage of charts and graphs 

 know how to integrate text and web pages 
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Chapter : 5.2 Spreadsheet Concepts 

Topic : 5.2.1 Overview of Spreadsheet 

 

Overview of Spreadsheet 

 Microsoft Excel is the most widely used spreadsheet package and lets user to 

organize their data into lists and then summarize, compare and present the data 

graphically. 

 A spreadsheet is a generic term for the software application package that 

simulates a paper worksheet often used by people in management. 

 Microsoft-Excel is an electronic spreadsheet. 

 

FIG 5.1: Microsoft Excel 2010 Icon 

 MS-Excel can be used for a variety of tasks which include automating of financial 

statements. 

 The spreadsheet is an interactive computer application program for organizing 

and analyzing data in tabular form. 

 The spreadsheet program operates on data represented as cells of an array, 

organized in rows and columns. 

 Each cell of the array is an element that contains numeric, text data or the results 

of formulas that automatically calculate and display a value based on the 

contents of other cells. 

 Data stored in database formats can be accessed through MS-Excel. 
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FIG 5.2: Microsoft Excel sheet 

 

 Excel emerges as a powerful and flexible graphical presentation tool. 

 Graphs or charts can be created based on data, for quick assessment of a 

situation. 

 Name Box 

 The Name box is a quick and easy way to move around and select ranges in 

a large spreadsheet. 

 Office Button 

 In the upper left corner of the Excel 2007 window is the Microsoft Office 

button.  

 Clicking on the Office Button displays a drop down menu containing a number 

of options. 

 Quick Access Toolbar 
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 Next to the Microsoft Office button is the Quick Access Toolbar.  

 The Quick Access Toolbar is grouped with Save, Undo, Redo and Print 

options.  

 Title bar 

 Next to the Quick Access Toolbar is the Title bar.  

 On the Title bar, Microsoft Excel displays the name of the current workbook. 

 Ribbon 

 In Microsoft Excel 2007, the Ribbon is located on the top of the Excel window 

and below the Quick Access Toolbar.  

 Ribbon has several tabs, clicking a tab displays several related command 

groups, within each group are related command buttons.  

 Tab list 

 Similar to a menu, it display a different ribbon. 

 Column Letters 

 Columns are vertical lines of Cells. 

 They are named from A to Z and then continuing from AA to AZ, BA to BZ 

and so on. 

 Row Numbers 

 Rows are horizontal lines of Cells.  

 A number identifies each row. 

 The rows are numbered 1 to 1,048,576.  

 Formula bar 

 It is a toolbar at the top of the Microsoft Excel spreadsheet window. 

 The formula bar can be used to enter or copy an existing formula into the 

cells or charts. 

 The formula bar is a section in Microsoft Excel that shows the contents of the 

current cell and allows the user to create and view formulas. 

 It is labeled with function symbol (fx).  

 

 The Formula Bar will become activated when the user type an equal (=) 

symbol in a cell, or if he clicks on it.  

http://www.webopedia.com/TERM/F/spreadsheet.html
http://www.webopedia.com/TERM/F/formula.html
http://www.computerhope.com/jargon/e/excel.htm
http://www.computerhope.com/jargon/c/cell.htm
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 Status bar 

 This bar displays various messages like status of the Num Lock, Caps Lock, 

and Scroll Lock keys on your keyboard. 

 Active Cell  

 The dark outline indicates the currently active cell. 

 Sheet Tab Scroll Button  

 On the bottom left of the worksheet user will find the Sheet Tab Scroll Buttons 

to move to the First sheet, Previous sheet, Next sheet, and Last sheet.   

 Page View Buttons 

 Change the way the worksheet is displayed by clicking one of these buttons. 

 Page Zoom Control 

 The worksheet has, in and out zoom controller. 
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Chapter : 5.3 Manipulation of Spreadsheet 

Topic : 5.3.1 Working with Spreadsheet 

 

Working with Spreadsheet 

Creating a new workbook 

 Creating a Blank Workbook 

 User can create new excel file, Click File tab then click New button and then 

double click Blank Workbook or click Create button. 

 

FIG 5.3: Creating a blank workbook 
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 Creating a Sample Template 

 If user wants to open a template, click File tab then click New button and then 

double click one of the template or click Create button. 

 

 

 

FIG 5.4: Creating a Sample Template 
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Saving a Workbook 

 For saving a workbook, click File Tab then click Save or Save As or press Ctrl + S 

in Keyboard. 

 Select required drive then type the file name and then check the file type to save 

the workbook by clicking Save button. 

 

 

 

FIG 5.5: Saving a Workbook 
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Editing a Workbook 

 If user wants to edit the saved workbook, open the existing file. 

 Make changes in the file then save. 

 

FIG 5.6: Editing a Workbook 

 To move or copy entire data, select the data, point to the top or bottom or left or 

right border around the data, now the mouse appears as an arrow, and then drag 

and drop. 

 

 

FIG 5.7: Copying and Moving selected cells 
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Chapter : 5.3 Manipulation of Spreadsheet 

Topic : 5.3.2 Inserting and Deleting Worksheets 

 

Inserting and Deleting Worksheets  

 Excel gives three Worksheets by default.  

 If user wants to add a worksheet 

 First, right click the tab of the sheet that the user wants to add the new one. 

 To insert a sheet between 2 and 3 for instance, right click the sheet 3 tab. 

 Then, choose Insert then double click Worksheet. 

 

 

 

FIG 5.8: Inserting a Worksheet 
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 If user wants to delete a worksheet 

 Right click the tab of the sheet which the user wants to delete. 

 Then click delete. 

 

 

 

FIG 5.9: Deleting a Worksheet 

 

 

 

 

 

 

 

 

 



      E-Content of 

IT TOOLS AND BUSINESS SYSTEM 

Page | 14  
 

Chapter : 5.3 Manipulation of Spreadsheet 

Topic : 5.3.3 Entering Data into Spreadsheet 

 

Entering Data into Spreadsheet 

 Enter data into a spreadsheet by typing in the active cell. 

 After typing, press ENTER key, the next cell becomes active. 

 User can also use arrow keys to move from one cell to another.(Show keyboard 

arrow keys) 

 User can enter the student details table shown below, by doing the following 

steps. 

 In the blank workbook, move cell pointer to the cell A1. Type S.NO. 

 Press the right arrow key to move to cell B1. Type STUDENT NO. 

 Press the right arrow key to move to cell C1. Type STUDENT NAME. 

 Press the right arrow key to move to cell D1. Type MARK1. 

 Press the right arrow key to move to cell E1. Type MARK2. 

 Press the right arrow key to move to cell F1. Type MARK3. 

 Press the right arrow key to move to cell G1. Type TOTAL. 

 Now move the cursor to cell A2 and press Enter. 

 Repeat the steps to enter the data for S.NO, STUDENT NO, STUDENT 

NAME, MARK1, MARK2, MARK3. 

 Now, move the cell pointer below the TOTAL field (G2). 

 Enter the formula in the formula bar by =SUM(D2+E2+F2) for calculating the 

TOTAL and then press ENTER. 

 The TOTAL is displayed. Then, drag the active cell as need, the total for all 

consequent cells are calculated. 
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FIG 5.10: Entering data  

 Enter the formula in the formula bar by =SUM(D2+E2+F2) for calculating the 

TOTAL and then press ENTER. 

 The TOTAL is displayed. Then, drag the active cell at G2 to G6, the total for 

all consequent cells are calculated. 

 

FIG 5.11: Calculating the total  
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Chapter : 5.4 Handling Operators  

Topic : 5.4.1 Handling Operators  

 

Handling Operators  

 Excel allows the user to use formulae to calculate and analyze data in their 

worksheet. 

 A formula uses the values in cells to perform operations such as addition, 

subtraction, multiplication and division. 

 Formulas need mathematical operators such as (+, - , *, /) and can use the cell 

reference or cell names for referring to the contents of a cell. 

 A formula always begins with an equal (=) sign.  

 Excel allows the user to use formulae to calculate and analyze data in their 

worksheet. 

 There are four types of operators. 

 Arithmetic operators 

 Comparison operators 

 Text operator 

 Reference operators 

 

 

 

 

 

 

 

 

 

 



      E-Content of 

IT TOOLS AND BUSINESS SYSTEM 

Page | 17  
 

 Arithmetic operator 

 These are used to perform basic mathematical operations, and to combine 

numeric values to produce numeric result. 

 

FIG 5.12: Arithmetic operators 

 

 Comparison operators 

 These are used to compare two values and produce a logical result either 

True or False, 0 (Zero) or 1 (one). The following are the Logical operators. 

 

FIG 5.13: Comparison operators  
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 Text operator 

 This operator joins two or more text values to produce a single combined text 

value. 

 Text formulas use the ampersand (&) operator to work with text cells, text 

strings enclosed in quotation marks, and text function results. 

 

Operator Name Example Result 

& ampersand ="soft"&"ware" software 

 

FIG 5.14: Text operator 

 

 Reference operators 

 The reference operators combine two cell references or ranges to create a 

single joint reference. 

 

FIG 5.15: Reference operators 

 

 

 

 

 



      E-Content of 

IT TOOLS AND BUSINESS SYSTEM 

Page | 19  
 

Chapter : 5.5 Functions 

Topic : 5.5.1 Functions 

 

Functions 

 A function is a predefined formula in Excel.  

 Like formulas, functions begin with the equal sign ( = ) followed by the function's 

name and its arguments. 

 The function name tells Excel what calculation to perform.  

 The arguments are contained inside round brackets. 

 There are several types of functions in spreadsheet some of them are 

 Math Functions 

 Logical Functions 

 Statistical Functions 

 Text Functions 

 Date and Time Functions 

 Math Functions 

 The Excel Math Functions are provided by Excel, to carry out many of the 

common mathematical calculations, including basic arithmetic, conditional 

sums & products, and the trigonometric ratios. 

 E.g. ABS (), CEILING (), COS (), SIN (), LOG () etc. 

 Logical Functions 

 Logical functions are provided by Excel, to help the user  to work with logical 

values, TRUE and FALSE.  

 They include boolean operators, conditional tests and functions to return the 

constant logical values. 

 E.g. IF (), NOT (), TRUE (), FALSE (), AND () etc. 
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 Statistical Functions 

 Excel provides a large selection of Statistical Functions, that perform most of 

the common statistical calculations, from basic mean, median & mode 

calculations to the more complex statistical distribution and probability tests. 

 E.g. AVERAGE (), COUNT (), CORREL (), FDIST (), FINV () etc. 

 Text Functions 

 Text functions are provided by Excel, to help the user to work with text 

strings. 

 They include functions to return information about a text string, to apply 

formatting to a text string, to convert between text and other data types, and 

to cut up and join together text strings. 

 E.g. FIND (), CONCATENATE (), LOWER (), UPPER (), MID () etc. 

 Date and Time Functions 

 Data and Time functions are used to calculate Dates, Times, and Days. 

 E.g. DATE (), DAY (), MONTH (), HOUR (), MINUTE () etc. 

Function wizard 

 Function Wizard prompts user for the information their need to enter for each 

function. 

 Function Wizard can be useful if users are not sure of the correct format to use to 

enter the formula.  

 The Function Wizard also gives a description of the function at the bottom, as 

well as presenting the formula result. 
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FIG 5.16: Function Wizard  

 

FIG 5.17: Function Wizard dialog box 

 

 It also offers many built in functions which user can utilize. 

 



      E-Content of 

IT TOOLS AND BUSINESS SYSTEM 

Page | 22  
 

Chapter : 5.7 Formatting a Worksheet  

Topic : 5.7.1 Formatting a Worksheet 

 

Formatting a Worksheet 

 In Excel, every cell can be formatted differently.  

 There are many options available to customize the Excel Workbook, which can 

make the worksheet easier to read.  

 Excel also provides many number formats, allowing user to standardize how 

numbers will appear in the document.  

 Formatting Cells includes the following 

 Changing data alignment 

 Date Fields 

 Currency or Account Fields 

 Changing Font 

Changing Data Alignment 

 Formatting is the process of changing the appearance of the data in a 

Worksheet. 

 The default alignment of text data, such as labels and column titles is on the left 

side of a cell. 

 Numbers, formulas, and dates, which are referred to as values, are right aligned 

by default. 

 These default alignments are not always the best choice for user's data, so Excel 

makes it easy to improve the layout and appearance of a worksheet by using the 

cell alignment icons on the Home tab of the ribbon. 
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FIG 5.18: Alignment group 

 Alignment group is under the Home tab. 

 Vertical Alignment 

 In the Vertical Alignment three options are there to do Top Align, Middle Align, 

Bottom Align. 

 To change the vertical alignment of the alignment group 

 Select a cell or range of cells. 

 Click the Top Align, Center, or Bottom Align command. 

 

 

FIG 5.19: Vertical Alignment group 
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 Horizontal Alignment 

 Horizontal Alignment used to align the text Left, Center and Right. 

 To align text or numbers in a cell 

 Select a cell or range of cells. 

 Click on either the Align Left, Center, or Right commands on the 

Home tab. 

 
FIG 5.20: Horizontal Alignment group 

 Orientation 

 User can rotate data clockwise, counterclockwise, vertically, rotate text up or 

down or click Format Cell Alignment to set a more precise orientation by 

specifying the number of degrees to rotate the text. 

 Select the cell. 

 On the Home tab of the ribbon, in the Alignment group, locate the button 

containing  “ab” (angled with an arrow underneath). 

 Click the button to display the Orientation menu.  

 There the user will find a button with an „a‟ and a „b‟ and an arrow all on an 

angle. 

 

FIG 5.21: Text Orientation 
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 Indentation 

 Select Increase Indent to increase the indentation within the cell by one 

character space. Select Decrease Indent to remove indentation by one 

character space. 

 Indenting cell data 

 Select the cells containing text, which the user want to indent. 

 Click the Increase Indent button in the Alignment group on the Home tab. 

 Each time the user click the Increase Indent button, Excel adds a small 

amount of space between the cell border and the data itself. 

 Removing cell indentation 

 Select the cells containing the indented text. 

 Click the Decrease Indent button in the Alignment group on the Home tab. 

 Each time user click the Decrease Indent button, Excel removes a small 

amount of space between the cell border and the data itself. 

 

 

FIG 5.22: Indentation buttons 

 Wrap Text 

 Wrapped Text wraps the contents of a cell across several lines if it's too 

large than the column width.  

 Merge & Center 

 Merge & Center use to merge the cell and center the text, merge across 

multiple  rows of cells, merge and unmerge the selected cells. 
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 To change text control 

 Select a cell or range of cells. 

 Select the Home tab. 

 Click the Wrap Text command or the Merge & Center command. 

 

FIG 5.23: Text Control group 

Date Fields 

 Highlight all the date fields. 

 Select the Home Tab. 

 In the Cell group, click Format button. 

 From the drop-down list, select Format Cells. 

 

FIG 5.24: Selecting Format Cells 

 In the dialog box, highlight Number tab. 
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 Select "Date" in the column at the left of the screen. 

 Select one of the Date format then Highlight that choice. 

 

FIG 5.25: Selecting Date Format 

 Click OK to save the format. 

 

Currency or Accounting Fields 

 Currency format 

 Displays the currency symbol immediately to the left of the number and 

displays a minus sign in front of negative values. 
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 Accounting format 

 Displays the currency symbol at the left edge of the cell, lines up the decimal 

points in a column, and encloses negative values within parentheses. 

 Also indents numbers slightly from the right edge of the cell to accommodate 

the right parenthesis in negative values. 

 Follow these steps to format numbers in Excel 2007 as currency 

 Select the cells containing the numbers, that the user wants to format. 

 From the Home tab, click the Number dialog box launcher in the bottom-right 

corner of the Number group. 

 The Format Cells dialog box appears, with the Number tab on top. 

 In the Category list, select Currency. 

 

FIG 5.26: Selecting Currency Format 
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 Change any other options as desired, such as the number of decimal places 

or the symbol to use for currency. 

 The Accounting format also enables you to choose different ways to display 

negative values. 

 Click OK. 

Changing Font 

 The character the Excel displays on the screen are a specific font types, 

style, size and color. 

 Excel allows the user to change the font characteristics in a single cell, a 

range of cells, the entire worksheet or the entire workbook. 

 From Font Face drop-down list choose one of the font as user need. 

 Font size is used to change the size of the font. 

 Increase and Decrease font size is used to increase and decrease the size of 

font. 

 Bold, Italic, Underline and Double Underline are used to make changes in the 

selected text. 

 Borders are used to do bordering around the selected cells. 

 Fill and Font colors are change the background and text color. 

 

 

FIG 5.27: Font group 
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Chapter : 5.8 Printing a Worksheet 

Topic : 5.8.1 Printing a Worksheet 

 

Printing a Worksheet 

 Step 1 :  

 From File tab, in the Backstage view click Print option or use keyboard 

shortcut with the combination of Ctrl + P. 

 Step 2 :  

 Now user can see the print preview. 

 Step 3:   

 To preview the other pages that will be printed, click 'Next Page' or 'Previous 

Page' at the bottom of the window. 

 Step 4 :  

 Under Print, select the number of copies to be print.  

 Step 5:  

 From Printer, choose the name of the printer. 

 Step 6:  

 In the Settings, the first drop down list has three options. 

 Step 7 :  

 Print Active Sheets - For only active sheets printing. 

 Step 8 :  

 Print Entire Workbook - For entire workbook printing. 

 Step 9 :  

 Print Selection – For selected sheet printing. 

 Step 10 :  

 Pages can be specified by entering the page number in the text box. 

 Step11:  
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 If one copy contains multiple pages, you can switch between Collated and 

Uncollated.  

 Step 12:  

 User can switch between Portrait Orientation (more rows but fewer columns) 

and Landscape Orientation (more columns but fewer rows). 

 Step 13:  

 Select paper size as user need. 

 Step 14:  

 Select one of the predefined margins (Normal, Wide or Narrow) from the 

Margins drop-down list. 

 Step 15:  

 Select 'Fit Sheet on One Page' from the Scaling drop-down list. 

 Step 16 :  

 After all changes made, finally click Print button to get print out. 

 

 

FIG 5.28: Print window 
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Chapter : 5.9 Working with Charts 

Topic : 5.9.1 Working with Charts 

 

Working with Charts  

 Creating Charts 

 To select the data for creating a graph click on the first cell of data and then 

drag the cursor over the remaining data to be included as the part of chart. 

 Go to Insert tab and click the line chart under the chart group. 

 

 

FIG 5.29: Selecting Line Chart 

 

 Click the chart and go to Design tab and click the chart layouts for creating 

chart title. 

 User can change the title name and axis name. 

 If user needs to edit the names of their series they can do so by first clicking 

on the graph to activate the Chart Tools Menu. 

 

 Under Chart Tools choose the Design tab, under the data group, click Select 
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Data. 

 

 

 

FIG 5.30: Select Data Source dialog box 

 

 To edit the name of a series, highlight it and then click the Edit button. 

 When the Edit series dialog box appears, type the series name in the box 

labeled Series name. 
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 Previewing Charts 

 If user wants to print, go to File tab and click Print Option or Press Ctrl + P in 

keyboard. 

 In the print page user can see the preview of the page in right side. 

 

 

 

FIG 5.31: Previewing Charts 
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 Modifying Charts 

 Click the chart and drag it another location on the same worksheet or click 

Move Chart button on the design tab. 

 Click the object in radio button to choose where the object is placed. 

 Then click OK. 

 To change the color of chart, click Design and click any one in Chart Styles. 

 

FIG 5.32: Modifying Charts 

 

 To reverse which data are displayed in rows or columns, click Chart  

 And then click Switch Row / Column button on the Design tab. 
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Chapter : 5.10 Integrating Text and Web Page into spreadsheet 

Topic : 5.10.1 Integrating Text into Spreadsheet 

 

Integrating Text into Spreadsheet 

 Open a blank or existing Excel 2010 spreadsheet.  Click the Data tab on the 

Ribbon and choose “From Text”. 

 

FIG 5.33: From Text button 

 

 Choose the text file user wants to import and double click. This will open the Text 

Import Wizard. 

 User can choose their data type and which row they want to start the data at and 

click next. 
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FIG 5.34: Text Import Wizard Step 1 

 Step 2 of the Wizard allows user to manage the break lines between their data.  

 

FIG 5.35: Text Import Wizard Step 2 

 Step 3 of the Wizard allows user to choose column formats, provides data 

preview, and other advanced settings.  When everything is organized click on 

Finish. 
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FIG 5.36: Text Import Wizard Step 3 

 A final window will be displayed asking where user wish to put the data into the 

sheet.  Here user can select either Existing Worksheet or New Worksheet. 

 Text Data will now be input into the Excel sheet. 

 

FIG 5.37: Imported Text File 
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Chapter : 5.10 Integrating Text and Web Page into spreadsheet 

Topic : 5.10.2 Integrating Web Page into Spreadsheet 

 

Integrating Web Pages into Spreadsheets 

 From the Excel Ribbon Click on Data. 

 From the Data tab, in the Get External Data group click on From Web. 

 It displays a following dialog box. 

 

 

 

FIG 5.38: New Web Query dialog box 
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 Enter a website address that user wants to get data from, and click Go.  The 

page will load in the preview box, and user might have to scroll to find the data 

they want on the page. 

 

 

 

FIG 5.39: Searching web page in New Web Query 
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 User will see a small arrow beside any web tables they can import into 

Excel.  Click the arrow to select the data, and then click the Import button on the 

bottom of the dialog. 

 

 

 

FIG 5.40: Small arrow beside table 

 

 Select where user wants Excel to place the web data, and click OK. 
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FIG 5.41: Selecting cell to place the table 

 

 A message in the spreadsheet that Excel is getting the data. 

 

 

FIG 5.42: Getting data in excel 

 After a few moments, web data will appear in Excel. 
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FIG 5.43: Imported web page 
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Chapter : 5.11 Summary 

Topic : Summary 

 

 In this class, we have learnt about 

 Spreadsheet Concepts 

 How to create, save, edit, insert and delete spreadsheet 

 How to handle operators 

 Various types of functions 

 Formatting a spreadsheet in different ways 

 Usage of charts and graphs 

 Integrating text and web pages 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



      E-Content of 

IT TOOLS AND BUSINESS SYSTEM 

Page | 45  
 

Chapter : 5.12 Model Questions 

Topic : Model Questions 

 

 What is a spreadsheet? 

 Explain operators 

 How functions used in spreadsheets? 

 What is the meaning of formatting cells? 

 Describe Charts and Graphs 

 How to do the integration of text and web pages 
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Assessment 1 

1. Each excel file is called a workbook because.  

a) It contains text and data Restarting 

b) It can be modified  

c) It can contain many sheets including worksheets and chart sheets 

d) It can be used for calculation 

2. What is the shortcut key to insert a new sheet in current workbook? 

a) F11 

b) Alt+F11 

c) Shift+F11 

d) Ctrl+F11 

3. In Excel, by default Numeric Values appears in 

a) Left aligned 

b) Right aligned 

c) Center aligned 

d) Justify aligned 

4. How are data organized in a spreadsheet? 

a) Lines and spaces 

b) Layers and planes 

c) Rows and columns  

d) Height and width 

5. On an excel sheet the active cell in indicated by ? 

a) A dotted border 

b) A dark wide border 

c) A blinking border 

d) By italic text 

Answers: 

1.c 

2.d 

3.b 

4.c 

5.b 
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Assessment 2  

1. Excel allows the user to use formulae to calculate and analyze data in their 

worksheet. 

a) True 

b) False 

2. Formatting is the process of changing the appearance of the data in a Worksheet. 

a) True 

b) False 

3. The dark outline indicates the currently active formula bar in the worksheet. 

a) True 

b) False 

 

Answers: 

1.a 

2.a 

3.b 
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Chapter : 6.1 Objectives  

   

Objectives 

 At the end of the course, user will be able to  

 learn how to create, open and save a presentation. 

 know to work with different views and slides. 

 understand Adding, Formatting Text and Paragraphs. 

 learn about spelling error. 

 learn to work with objects and adding clip arts. 

 understand the concept of designing, running and printing a presentation. 
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Chapter : 6.2 Introduction to PowerPoint Presentation 

Topic : 6.2.1 Overview of PowerPoint 

 

Overview of PowerPoint 

 Microsoft PowerPoint is a slide show presentation program developed by 

Microsoft. 

 PowerPoint is simple, flexible and powerful tool for creating professional-looking 

slides.  

 PowerPoint presentation provides various views and tools the user can use to 

build a presentation that includes words, graphics and media. 

 Presentation package present information like business proposals, reports and 

plans in an effective and attractive manner using slides through presentations. 

 

 

FIG 6.1: PowerPoint Logo 

Opening a Presentation 

 Click the Start button on the Windows taskbar to display the Start menu. 

 Click All programs at the bottom of the left pane on the start menu to display the 

All programs list. 

 Click Microsoft Office in the All Programs list to display the Microsoft Office 

applications. 

 Click Microsoft Office PowerPoint 2010 to start PowerPoint. 
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FIG 6.2: Opening a PowerPoint window 

 Otherwise, double click on the PowerPoint 2010 Logo on the Windows desktop 

to start presentation. 

 When PowerPoint 2010 is opened, a blank Title slide appears by default as the 

first slide in the new presentation.  

 Click File menu then choose New and click blank presentation to open a blank 

presentation. 

  

FIG 6.3: Blank presentation 
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FIG 6.4: PowerPoint program window 

 The most important areas of the PowerPoint environments are 

 File Menu 

 Quick Access Toolbar 

 Tabs 

 Ribbons 

 Dialog Box Launcher 

 Slide 

 Navigation Pane 

 Slide  and Outline Tab 

 Notes Pane 

 Zoom Slider 

 

 File Menu 

 File Menu consist of New, Open, Save, Save As, Print, Save & Send and 

Close. 

 Quick Access Toolbar  
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 Quick Access Toolbar consist of Save, Undo and Redo buttons. 

 Tabs 

 There are many tabs in power point, each tab has several groups and 

buttons. 

 Ribbons 

 Ribbon is displayed by clicking its tab found below the title bar.  

 Each collection of commands found in a ribbon is further grouped into 

sections. 

 Dialog Box Launcher 

 Some groups have a dialog box launcher button in the lower right corner that 

will display a dialog box window for that particular group. 

 Slide 

 Slide is a working area of the power point presentation. 

 Navigation Pane  

 By default, thumbnails of the slides are shown here allowing for quick access 

of a slide, rearranging order of slides, and inserting/deleting slides. 

 Slide and Outline Tab  

 Slide tab is a main area. It shows the current slide we are working on. 

 Switch to Outline View on the left instead of slide thumbnails. 

 Notes Pane  

 User can write presentation notes in this area. 

 Zoom Slider 

 Drag the Zoom slider left to shrink or right to enlarge slides.  

 Click the Zoom In or Zoom Out button to zoom in or out by 10-percent 

increments. 

 PowerPoint is presentation software that allows creating slides, speaker notes, 

audience handouts and outlines, all in a single presentation. 
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Chapter : 6.2 Introduction to PowerPoint Presentation 

Topic : 6.2.2 Creating a Presentation 

 

Creating a Presentation 

 PowerPoint presentation can be created in two ways as follows 

 Blank Presentation 

 Using a Templates 

Creating a Blank Presentation 

 Click File menu then choose New and click blank presentation to open a 

blank presentation. 

 Then Click Create to get a blank Presentation. 

 

 

FIG 6.5: Opening a blank Presentation 

 

 

 

 



 E-Content of 

IT Tools and Business System 

Page | 9  
 

 Creating a Presentation Using a Template       

 Click File menu then choose New, it will navigate to an Available Templates 

and themes window. 

 

               

FIG 6.6: Opening a Sample Template 

 The Templates pane will display on the right side of the window with a variety 

of different templates to choose from. 

 Select Sample templates option and choose any slide design from it. 

 Then click Create button to create a new presentation with templates. 
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Chapter : 6.2 Introduction to PowerPoint Presentation 

Topic : 6.2.3 Saving a Presentation 

 

Saving a Presentation 

 Click File menu and choose Save or Save As button. 

 

 

FIG 6.7: Choosing Save button 

 

 This opens the Save As dialog box as shown in FIG 6.8 

 User can also change the current drive and directory in which they want to save 

the presentation. 
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FIG 6.8: Save As dialog box 

 

 Type a name for the file in the Save As dialog box and In the Save as type list, 

pick the file format that user want and then click Save. 
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Chapter : 6.3 Creating a look of Presentation 

Topic : 6.3.1 Views in Presentation  

 

Views in Presentation 

 To see slides in different views, use View button options which is available at left 

corner of the screen. 

 

 

FIG 6.9: View Tab 

 Normal View  

 Normal View is also commonly known as Slide View.  

 It is the main working window in the presentation. 

 The slide is shown full size on the screen. 

 Slide Sorter View 

 Slide Sorter View is a window in PowerPoint that displays thumbnail versions 

of all the slides, arranged in horizontal rows.  

 This view is useful to make global changes to several slides at one time. 

 Rearranging or deleting slides is easy to do in Slide Sorter view. 

 Notes Page View 

 Notes Page View shows a smaller version of a slide with an area below for 

notes.  

 Each slide is created on its own notes page.  

 

 The speaker can print these pages out to use as a reference while making his 

presentation.  
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 The notes do not show on the screen during the presentation. 

 Reading view 

 In reading view, each slide fills the screen.   

 The user cannot edit slides when working in Slide Show view.  

 The user can use this view to preview a presentation and to deliver it to an 

audience. 
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Chapter : 6.3 Creating a look of Presentation 

Topic : 6.3.2 Working with slides 

 

Working with slides 

 If user wants a different layout, in the Home tab click New Slide or Layout 

option from Slides group, click one of slide to type text. 

 

 

FIG 6.10: Selecting slide layout 

 

 After opening a presentation, in the presentation window click on title 

placeholder. 

 The cursor will change to an I-beam. This pointer appears whenever the user 
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enters or edits text.  

 The title placeholder is outlined to indicate that it has been selected. 

 Type the title.  

 The text will automatically be center aligned within the title placeholder. 

 Click outside of the title placeholder to view the title user have typed.  

 For adding subtitle do the same as start with click on subtitle placeholder. 

 

 

 

FIG 6.11: Presentation with Text 
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Adding a new slide 

 The new slide can be inserted after the current slide or in the position where the 

mouse was clicked.  

 There are several equivalent ways to add a slide to a presentation 

 Under Home tab select New Slide option from Slides section.  

 

FIG 6.12: New Slide Button 

 On the Slides or Outline pane right-click and select New Slide from the pop-

up menu (works in Normal view).  
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FIG 6.13: New Slide Options 

 Right-click on the main work area while in Slide Sorter view (which present in 

the status bar) and select New Slide from the right click pop-up menu.  

 

FIG 6.14: New Slide Option 
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Rearranging Slides 

 If user insert slides from another presentation into the current presentation and 

need to rearrange the slides into the order that most effectively communicates 

the message in slides of the presentation.  

 This is done using the Slide Sorter View, where user can drag one or more slides 

from one location to another. 

 

 

FIG 6.15: Rearrange Option 

 To rearranging slides in a presentation, do the following. 

 In Normal view, on the pane choose the Slides tab, click a slide to move and 

then drag it to the new location. 

 To select multiple slides, click a slide and then press and hold Ctrl key while 

user click each of the other slides that user want to move. 

 In the Slide Sorter View, drag the slide from the position to change and drop 

where to place. 
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FIG 6.16: Rearranged Slide 

Deleting Slides 

 There are three ways to delete a slide in a presentation. 

 Select the slide then press Delete key to delete the slide. 

 Select the slide in the Slide Sorter View (which is present in the status bar) 

and press the Delete key to delete a slide. 

 Select the slide that user wants to delete and then Right click and click delete 

slide from the list.  

 

FIG 6.17: Delete Slide 
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Chapter : 6.3 Creating a look of Presentation 

Topic : 6.3.3 Adding and Formatting Text 

 

Adding Text to the Slide 

 To enter a text into a presentation slide place the mouse cursor where it says, 

"Click to add title" or "Click to add text". 

 When the cursor begins blinking, then start to type. 

 To add text into a new text box, follow these instructions. 

 Under Insert tab, click Text Box from the Text section. 

 Move the mouse to where the new text box should appear and click. The 

textbox will automatically appear. 

 After the cursor begins blinking in the text box, type the text. 

 

 

FIG 6.18: New Text Box 

 

 

 Move a Text Box 
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 To move a text box, click once inside the text box and then click again on the 

dashed line that outlines the text box. 

 The outline of the text box should change to a solid line. 

 The cursor should also change to a four-pronged arrow. Use the mouse to 

drag the text box to the appropriate place. 

Formatting Text 

Changing the Color of a Text 

 Changing the color of a text in a slide enhances the appearance of the slide and 

draw attention to important information. 

 Users have to select the text to change the color. 

 Under Format tab, click Text Fill from WordArt Styles group then select the 

color for the text.  

 If user can't see the Drawing Tools or Format tabs, make sure that user 

selected the text box or not. 

 

FIG 6.19: Text Color 

 

 To change a color if that is not in the theme colors then 
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 Click More Fill Colors, and then either click the color on the Standard tab, or 

mix colors on the Custom tab. 

 

FIG 6.20: More Fill Color dialog box 

 To change the outline of the text, under Format tab click on the Text Outline 

option and select the outline color for the text. 

 User can also add effects to the text, using the Text Effects option. 

 WordArt are used to add a visual effect into the presentation. 

 To apply WordArt style, 

 Select the text to add WordArt. 

 Click the Insert tab on the Ribbon and click the arrow under the big 

‘A’ WordArt button. 

 Choose the WordArt from the drop down. 

 Otherwise, under Format tab in the WordArt Style group choose the style. 
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FIG 6.21: WordArt Button 
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Chapter : 6.3 Creating a look of Presentation 

Topic : 6.3.4 Formatting Paragraphs 

 

Formatting Paragraphs 

 Paragraphs can be formatted by using the Paragraph section, it contains  

 Bullets and Numbering 

 Decrease Indent and Increase Indent 

 Line Spacing 

 Alignment  (Left, Center, Right, Justify) 

 Columns 

 Text Direction 

 Align Text (Top, Middle, Bottom) 

 Convert to SmartArt 
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 Bullets and Numbering 

 User can add numbers or bullets to the selected text, by using Bullets and 

Numbering option from the Home tab. 

 To add bullets to a selected text, do the following 

 Select the paragraphs. 

 In the top left hand corner of the paragraph section user will see Bullet 

icon with 3 dots and 3 lines on it.  

 It contains 7 different options of bullets. 

 Choose required bullets and now Bullets are inserted in the paragraphs. 

     

 

 
FIG 6.22: Adding Bullets 

 

 

 

 

 

 To add Numbering to a selected text, do the following 
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 Select the paragraph. 

 Next to the Bullet icon there is Numbering icon with 123 and lines on it. 

 It also contains 7 different options of bullets. 

 Choose the required format of Numbering and now the lines will change 

with the numbers in front. 

               

 

 

FIG 6.23: Adding Numbering 
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 Decrease Indent and Increase Indent 

 The next to the Bullets and Numbering buttons are used to increase the 

indent level and decrease the indent level.  

 If user have something written on the presentation user can click those 

buttons to move the text further away from the outside edge or closer to the 

outside edge depending of the preference. 

 

 
FIG 6.24: Indent Option 
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 Line Spacing 

 Line Spacing is used to adjust the space between paragraphs on the 

PowerPoint slides to fit more lines in a text box. 

 The line spacing button has a blue arrow up and a blue arrow down. 

 Select a sentence that has two lines. Click on the line spacing button. 

 Choose the required space between the lines. 

 

FIG 6.25: Line Spacing Option 
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 Alignment (Left, Center, Right, Justify) 

 To align a text to left, center, right or justified use the option placed below the 

Bullets and Numbering option in the Paragraph section. 

 Select the line to change the alignment and use the option to make changes. 

      

 
FIG 6.26: Justification Option 
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 Columns 

 Column option used to make columns on the presentation. 

 Columns button is placed next to the Justification buttons.  

 Select the text to make columns.  

 Click the drop down menu on the Columns button.  

 Here user can choose if user want the text to be in one, two or three columns. 

 If users don't want columns click on the one column button and it will change 

it back to the original format. 

 

FIG 6.27: Columns Option 
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 Text Direction 

 Text Direction feature can give the slides more style and make it easier to fit 

text onto a slide.  

 This button has option of Horizontal, Rotate text 90 degrees, rotate all text 

270 degrees and stacked.  

 Click on this button and it will bring down a drop down menu, from that user 

can choose the direction of the text. 

 More options at the bottom will open the format text effects window to 

customize the text more.  

 If user don't like it or want to change it back click on horizontal and it will go 

back to normal. 

 

FIG 6.28: Text Direction Option 
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 Align Text (Top, Middle, Bottom) 

 Text direction is the Align text option.  

 Click the align text icon and it will bring up a drop down menu.  

 Here user can align the text top, middle , bottom and it give more options if 

needed. 

 Select the text and choose each one of these options to see where it aligns 

the text in the text box. 

 

FIG 6.29: Align Text Option 
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 Convert to SmartArt 

 The last button in the paragraph section of the Home tab is Convert to 

SmartArt. 

 This button will give more options to create a different look for the PowerPoint 

slides.  

 

FIG 6.30: SmartArt Option 
 

 Click the Convert to SmartArt button to bring up the drop down menu. 

 Choose any of the SmartArt option and now PowerPoint will open a new 

window that says type text here. 

 After entering the text close that window. 
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FIG 6.31: SmartArt Window 
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Chapter : 6.3 Creating a look of Presentation 

Topic : 6.3.5 Checking and Correcting Spelling 

 

Checking and Correcting Spelling 

 User can check the spelling in a presentation with a menu option. 

 While typing a word, a misspelled words and grammar mistake words are 

underlined with a red line or green line below the word. 

 The red line indicates a spelling error and the green line indicates a possible 

grammar error. 

 To correct the spelling of the word which is underlined, do the following 

 On the Quick Access Toolbar, choose Spelling option or press F7 key. The 

Spelling dialog box appears as shown in FIG 6.32 

 

     

FIG 6.32: Spelling dialog box 

 Here the computer suggests the appropriate spellings and grammar for the 

highlighted word. User can correct as per their need. 

 To check the mistakes automatically, user can use AutoCorrect Options. 

 Click File menu, at the bottom of the menu, Options. 

 It will navigate to the PowerPoint Options dialog box, in that click Proofing. 
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 Under When correcting spelling in PowerPoint, select or clear the Check spelling 

as you type or Use contextual spelling or Hide spelling errors check box. 

 

FIG 6.33: PowerPoint Options window 
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Chapter : 6.3 Creating a look of Presentation 

Topic : 6.3.6 Making Notes Master and Handouts 

 

Making Notes Master  

 The Notes are used to remember key points during a presentation in every slide. 

 On the View menu, click Notes Master, now the slide view is changed into Notes 

view as shown in FIG 6.34 

             

FIG 6.34: Notes Master View 

 Resize or change the location of the slide notes box to suit the needs. 

 User can add the items that they want on the notes master, such as text, art, 

headers or footers, date, time, or page number. 

 The existing notes can be changed or deleted as their need. 

 When user print slides with notes, items that are added will appear. 

 Then Close the slide, now notes are added to the slide. 
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Making Handouts  

 On the View menu, click Handout Master, now it will change to the Handouts 

Master view as shown in FIG 6.35 

 

 

FIG 6.35: Handout Master View 

 To preview the different layout, click the buttons on the Handout Master Toolbar. 

 Add the items to the handout master, such as text, art, headers or footers, date, 

time, or page number. 

 Items that are added may appear only on the handouts, no changes are made to 

the slide master. 

 On the Master Toolbar, click the Close button. 
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Chapter : 6.3 Creating a look of Presentation 

Topic : 6.3.7A Drawing Objects 

 

Drawing Objects 

 PowerPoint allows user to draw any shapes and format the shapes as their 

needs. 

 There are two ways of drawing as follows 

 Under Home tab, user can use Drawing section to draw and format the 

drawing. 

 Otherwise, Format tab under Drawing Toolbar is used for drawing. 

 

 

FIG 6.36: Format Tab 

 Format tab consist of 5 sections as follows.  

 Insert Shapes 

 Shape Styles  

 WordArt Styles 

 Arrange 

 Size 
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 Insert Shapes 

 User can use Insert Shapes section to draw any required shapes and user 

can also Edit Shape and add Text Box. 

 

FIG 6.37: Insert Shapes Section 

 Shape Styles 

 In the Shape Styles section, user can change the style of the shape, shape 

color, outline color and Shape effects. 

 

FIG 6.38: Shape Styles Section 
 

 WordArt Styles 

 In the WordArt Styles, user can change the text style, text color, text outline 

color and text effects. 

 

FIG 6.39: WordArt Styles Section 
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 Arrange 

 Arrange section allows user to change the position of the shapes like Bring to 

Front, Sent To Back, Align, Group the shapes and Rotate the shape for 

required Angle. 

 

FIG 6.40: Arrange Section 

 Size 

 Size section allows user to change the height and width of the shape using 

the up and down arrow in the box. 

 

 

FIG 6.41: Size Section 
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Chapter : 6.3 Creating a look of Presentation 

Topic : 6.3.7B Working with Objects 

 

Working with Objects 

 User can insert objects like table, Excel Spreadsheet, Formula and so on. 

 Table 

 Users have to select the slide where to add a table. 

 On the Insert tab, in the Tables group, click Table. 

 

FIG 6.42: Insert Table 

 Do one of the following 

 Users can move the pointer over the grid to select the number of rows and 

columns, and then click. 

 Click Insert Table, and then enter a number in the Number of columns 

and Number of row lists box. 

 To add text to the table cells, click a cell, and then enter the text. 
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 Click outside the table, after user has entered the text. 

 To add a row at the end of a table, click the last cell of the last row, and then 

press TAB. 

 To convert existing text to a table, user must first add a table to the slide and 

then copy the text into the table cells. 

 Excel Spreadsheet 

 Users have to select the slide where to add a table. 

 On the Insert tab, in the Tables group, click Excel Spreadsheet. 

      

FIG 6.43: Insert Excel Spreadsheet 
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 Formula 

 Use Insert -> Object -> Microsoft Equation to create a Math object in a 

slide. 

 

FIG 6.44: Insert Object dialog box 

 User will navigate to the Equation Editor window, type the desired formula 

then close the window. 

 

FIG 6.45: Equation Editor Window 

 

 Formula will appear in the selected slide. 
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Chapter : 6.3 Creating a look of Presentation 

Topic : 6.3.8 Insert Clip Art and Pictures 

 

Insert Clip Art  

 Click the slide where to add the clip art. 

 On the Insert tab, in the Images group, click Clip Art. 

 

 

FIG 6.46: Presentation with Clip Art 

 

 Clip Art task pane has Search for text box, type a word or a phrase that user 

want, or type all or some of the file name of the clip art. 

 Click Go to start search. 

 In the list of results, click the clip art to insert it. 
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Insert Pictures 

 Click the slide where to add the pictures. 

 On the Insert tab, in the Images group, click Picture. 

 It will navigate to Insert Picture dialogue box from that user can select the 

required images to insert. 

 

 

FIG 6.47: Insert Picture Dialog Box 
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Chapter : 6.3 Creating a look of Presentation 

Topic : 6.3.9 Designing Slide Show 

 

Designing Slide Show 

 Transition is a special effect used to introduce a slide during a slide show. 

 To Change the transition to a slide, Slides and Outline tabs are present in the 

pane, in that select the Slides tab. 

 

FIG 6.48: Selecting a Slide in Slides tab 

 In the Slides tab, click the thumbnail of the slide that has the transition that user 

want to change. 

 On the Transitions tab in the Ribbon, in the Transition to This Slide group, 

click a slide transition effect for that slide. 

 

FIG 6.49: Selecting a Transition 
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 To set the time for the transition to the current slide, do the following 

 On the Slides tab in Normal view, click the thumbnail of the slide with the 

transition that user wants to set the timing for. 

 Under Transitions tab, in the Timing groups, change the duration time then 

select it.               

 

FIG 6.50: Advance Slide option 
 

 To specify how long before the current slide advances to the next, use one of the 

following procedures 

 To advance the slide when click the mouse, on the Transitions tab, in 

Transition to This Slide group, select the On Mouse Click check box in 

Advance Slide. 

 To advance the slide at a specified time, on the Transitions tab, in the 

Transition Speed drop down list under Transition to This Slide, select one of 

the appropriate options to the transition.  
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Running a Slide Show 

 There are three ways to run a slide show, 

 Select Slide Show-> From Beginning. 

 Click the projector button in the lower right corner of the screen.  

 Press the F5 Key to run the slide show.  

 Go to the next slide: Press the Space Bar or Enter or Page Down or Right 

Arrow key or Down Arrow. 

 Go to the previous slide: Press Backspace or Page Up or the Left Arrow key or 

Up Arrow. 

 Exit slide show (at any time): press Esc or Alt+F4. 

 Access the pen tool (in order to draw on the screen): CTRL + P 

 Erase pen: Press E 

 Hide the pointer: Press  A  

 

 

FIG 6.51: Running a Slide Show 
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Chapter : 6.3 Creating a look of Presentation 

Topic : 6.3.10 Printing Slides 

 

Printing Slides 

 From File tab, click Print option. 

 Or use keyboard shortcut with the combination of Ctrl + P. 

 

 

FIG 6.52: Print option 
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FIG 6.53: Print window 

 

 Now printing options appears in the right side of the word document. 

  Under Print, select the number of copies to be print.  

 From Printer, choose the name of the printer. 

  In the Settings, the first drop down list has four options. 

  Print All Slides - For entire slides printing. 

 Print Selection - For selected slide printing. 

 Print Current Slide – For current slide printing. 

 Custom Range- For only given slides to be print. 

 Slides can be specified by entering the page number in the text box. 

 After all changes made, finally click Print button to get  print out                   
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Chapter : 6.4 Summary  

Topic : Summary 

 

 In this class, we have learnt about, 

 How to make a Presentation, 

 Creation of Presentation  

 Preparation of Slides 

 Slide Show 
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Chapter : 6.5 Model Questions 

Topic : Model Questions 

 

Model Questions  

 What is PowerPoint? 

 How to start a power point? 

 Explain the way of creating a presentation. 

 How to add clip art to a slide? 

 How to do Transition and Slide Timing in Slide show. 
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Assessment 1 

1. Which of the following is not one of the PowerPoint views? 

a) Slide show view 

b) Slide sorter view 

c) Presentation view 

d) Outline view 

 

2. A PowerPoint feature allows the user to create a simple presentation quickly is 

_____________.  

a) AutoContent Wizard 

b) Transition Wizard 

c) Chart Wizard 

d) Animations 

 

3. Special effects used to introduce slides in a presentation are known 

as_____________. 

a) Transitions 

b) Effects 

c) Custom animations 

d) Annotations 

 

4. ______________controls all the main slide control tasks for thex presentation. 

a) Task bar 

b) Task Pane 

c) Control Panel 

d) None of above 

 

5. A File which contains readymade styles that can be used for a presentation is 

called ________. 

a) AutoStyle 

b) Wizard 

c) Template 

d) Preformatting 
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Answers: 

1.d 

2.a 

3.a 

4.b 

5.c 
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Assessment 2  

1. User can add numbers or bullets to the selected text, by using Bullets and 

Numbering option from the Home tab. 

a) True 

b) False 

2. Columns button is placed next to the left align buttons.  

a) True 

b) False 

3. Size section option allows user to change the style and font of the shape using the 

up and down arrow in the box. 

a) True 

b) False 

 

Answers: 

1.a 

2.b 

3.b 
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Chapter : 7.1 Objectives 

 

Objectives 

 At the end of the course the user will be able to 

 understand data manipulation concept in database. 

 know about the relational database. 

 understand the concept of integrity. 

 know the database operations such as creating, dropping and manipulating 

table structure.  

 understand the concept of manipulating data in query, forms and reports. 
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Chapter: 7.2 Database  

Topic: 7.2.1 Introduction to Database 

 

Introduction to Database 

About Data 

 The term data can be defined as set of isolated and unrelated raw facts with an 

implicit meaning. 

 Data can be anything such as name of person, a number, images, sound etc. 

About Database 

 A database is an organized collection of related data from which user can 

efficiently retrieve the desired information.  

 Traditional databases are organized by fields, records and files. A field is a single 

piece of information. A record is one complete set of fields and a file is a 

collection of records. 

 In addition to the storage and retrieval of data, certain other operations can be 

performed on a database and the operations include addition, alteration, 

updating and deletion of data. 

 It is back-end of an application. 

About Database Management System (DBMS) 

 A Database Management System (DBMS) is an integrated set of programs used 

to create and maintain a database. 

 The operations such as adding, updating and deleting data on a database are 

performed using Database Management System (DBMS). 

 The main objective of DBMS is to provide a convenient and effective method of 

defining, storing, retrieving and manipulating data contained in the database. 
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Figure 7.1: Example for Database Structure 

 The database and the DBMS software are collectively known as database 

system. 

 Database Management Systems (DBMSs) are especially designed for software 

applications that interact with the user and other applications  

 Examples of DBMS are Microsoft Access, SQL Server, MySQL etc. 
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Chapter: 7.2 Database  

Topic: 7.2.2 Relational Database 

 

Relational Database 

 A relational database is a collection of data items organized as a set of formally-

described tables from which data can be accessed or reassembled in many 

different ways without having to reorganize the database tables.  

 The relational database was invented by E. F. Codd at IBM in 1970. 

 The standard user and application program interface to a relational database is 

the structured query language (SQL).  

 SQL statements are used for both interactive queries for information from a 

relational database and for gathering data for reports. 

  A relational database is a set of tables containing data fitted into predefined 

categories.  

 Each table (which is sometimes called a relation) contains one or more data 

categories in columns. Each row contains a unique instance of data for the 

categories defined by the columns.  

 The following intuitive correspondence can be made 

 A relation is a file. 

 Each file contains only one record type. 

 The records have no particular order.  

 Every field is single-valued. 

 The records have a unique identifying field or composite field, called the 

primary key field. 

 With a relational database, user can quickly compare information because of the 

arrangement of data in columns.  

 The relational database model takes advantage of this uniformity to build 

completely new tables out of required information from existing tables.  

 In other words, it uses the relationship of similar data to increase the speed and 

versatility of the database. 
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FIG 7.2: Relational Database 
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Chapter : 7.3 Integrity 

Topic : 7.3 Integrity 

 

Integrity 

 Data integrity refers to the overall completeness, accuracy and consistency of 

data.  

 The concept of data integrity ensures that all data in a database can be traced 

and connected to other data which ensures that the data is recoverable and 

searchable.  

 

 

FIG 7.3: Example for Integrity 

Types of Integrity 

 There are four types of Integrity  

 Entity Integrity 

 Referential Integrity 

 Domain Integrity 

 Entity Integrity 

 The Entity Integrity states that in a base relation, primary key column 

values cannot be null. (Null values are defined as "empty or containing no 

values"). 

 A primary key is a minimal identifier that is used to identify columns uniquely.  
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 A DBMS product such as Microsoft Access automatically enforces entity 

integrity by prohibiting null values in the primary key fields. 

 Referential Integrity 

 The referential integrity states that, if R2 (Child table) includes a foreign key 

FK matching the primary key PK of some R1 (Parent table) then every value 

of FK in R2 must 

 be equal to the value of PK in some rows of R1. 

 be wholly null, i.e. each column in that FK must be null. 

 For example, when adding a new row to a table containing FK, the table 

containing the referenced PK must have matching values. 

 Domain Integrity 

 Domain integrity states that the values in a table are legal according to the 

physical and the logical domain definition. 

 For Instant explanation, the StudentID column domain might be  

 Physical : data type "numeric" ; Length "4 characters" 

 Logical : "The range of the number between 1000 and 4999" 

 Therefore, the field would only accept input of four-digit number between 

1000 and 4999. 

 

FIG 7.4: Types of Integrity 
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Chapter : 7.4 Microsoft Access 

Topic : 7.4.1 What is Microsoft Access 

 

What is Microsoft Access? 

 Microsoft Access is a database software package. 

 A database is an organized collection of records. Example for paper database 

are telephone and address book. 

 With MS-Access, user can create a computerized database. After creation of 

MS-Access database, user can search it, manipulate it and extract information 

from it. 

Working with MS- Access 

 Open Microsoft Access 2010, click on Sample Templates. The Northwind icon 

appears in the center of the window. 

 

FIG 7.5: Microsoft Access 

 

 Click the Northwind icon. 
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 Click the Browse button. The File New Database dialog box appears. 

 Locate the folder in which user wants to save the Northwind database. 

 Click OK. The File New Database window closed. 

 Click Create. MS-Access Creates the Northwind database and opens it. 

 It shows the warning message to open the database in trusted location. 

 To enable database click the Enable content button. 

 MS-Access enables the content. If user enabling the Northwind database, the 

Login dialog box appears. 

 

 

FIG 7.6: Login Dialog  

 Click Login. MS-Access opens the Northwind database. 

 The Navigation Pane 

 The MS-Access database consists of the following objects 

 Tables 

 Queries 

 Forms 

 Reports 

 Macros 

 Modules 
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FIG 7.7: All Access Objects in Navigation Pane 

 The Navigation pane displays these objects in a database. 
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Chapter : 7.5 Operation  

Topic : 7.5.1 Creation of Database and Table 

 

Creation 

Creation of Database 

 A blank database is a database nothing in it. User must create all the tables, 

forms, reports, queries and so on. 

 If user cannot find a template that suits their needs, they can create a blank 

database. 

 Creating tables is the first step in building a database. Follow these steps to 

create a blank database 

 Start MS-Access, click Blank Database. 

 Type the database name in the File Name field. MS-Access will automatically 

append .accdb to the name. 

 

FIG 7.8: Steps to create a blank database 

 Click the Browse button. The File New Database window appears. 

 Locate the folder in where user wants to store the database. 

 Click OK, then click Create button. 
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 MS-Access creates the database and opens a datasheet with the Table Tools 

available is shown in the FIG 7.12 

 

FIG 7.9: Table Tools 

Creation of Tables 

 Tables are the foundation of an MS-Access database. 

 MS-Access stores data in tables. A table is a set of columns and rows. Each 

column is called field and each row is called record. 

 Each field must be given a name and no two fields can have the same name. 

 Each value in a field represents a single category of data.  

 Each row is called record. 

 

FIG 7.10: Table Name, Fields and Records 

 Follow the steps to add fields to a table  

 Click in the 'Click to Add' text box, it shows drop down list, select any data 

type from the list.  
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 Type the nextfield name, MS-Access creates the field. User can continue this 

process until fields in the table is to be created.  

 Press Enter without entering a field name to end their entries. 

 

FIG 7.11: Fields in a table 

 Follow the steps to name and save a table 

 Click the Save button on the Quick Access toolbar. The SaveAs dialog box 

appears. 

 Type the name of the table.  

 Then click OK. 
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FIG 7.12: Saving a table 

 Follow the steps to use Design view to create a new table 

 Activate the Create tab. 

 Click Table Design in the Tables group. MS-Access changes to Design view 

and the Table Tools become available. 

 

 

FIG 7.13: Create a new table using Design view 

 

 

 Type the first field name in the Field Name field. 

 Press the Tab key. 

 Click the down-arrow that appears when user click in the Data Type field and 

then select a data type. 

 Click Primary Key option if the created column is primary key. A small key 

appears next to the field name. 
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FIG 7.14: Fix primary key 
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Chapter : 7.5 Operations 

Topic : 7.5.2 Manipulating Table Structure 

 

Manipulating Table Structure 

 After creation of MS-Access table user can modify it, enter data into it manually 

or import data from different application such as Excel. 

 To manipulate table structure user can 

 Enter records into the table 

 Modify a table 

 Select columns and rows 

 Delete a record 

 Resize a column or row 

 Import a table into MS-Access from Excel 

Enter Records 

 To enter data into an AutoNumber field 

 Press the Tab key when the user makes an entry into another field in the 

record, MS-Access will automatically make an entry into the AutoNumber 

field. 

 To enter data into fields that have a lookup list 

 Click the down-arrow that appears when user click in the field. 

 Click to select the entry that user want. 

 Press the Tab key. 

 

FIG 7.15: Enter data into fields 
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 To enter data into Yes/No field 

 Click the checkbox for Yes, then leave the checkbox for No. 

 

 

FIG 7.16: Enter data into Yes/ No field 

 To enter data into a date field 

 Type the date. Or 

 Select the date from the calendar that appears to the left of the field. 

 Use the left-arrow at the top of the calendar to move to the previous month. 

 Use the right-arrow at the top of the calendar to move to the next month. 

 When user reaches the proper month, click the proper date. 

 

 

FIG 7.17: Enter data into a date field 

 

FIG 7.18: Calendar 
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Modify a Table 

 To insert column 

 The insert option inserts a column before the selected column. 

 

FIG 7.19: Insert a column 

 Click the column head of the column before which user wants to insert a 

column. 

 Right-click the column head that user wants to insert a column. A menu 

appears. 

 Click Insert field. 

 To move a column 

 User can use Move option to move a column from one place to another. 

 Move mouse pointer over the horizontal line under the column label. Users 

mouse pointer turns into a four sided arrow. 
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 Press left mouse button. 

 Click and drag the field to the new location. A dark line appears at the new 

location. 

 Release left mouse button. MS-Access moves the column. 

 To delete columns 

 The Delete option permanently deletes columns and all the data contained in 

them. User cannot undo a column after deleting. 

 

FIG 7.20: Delete a column 

 Right-click the column head that user wants to delete a column. A menu 

appears. 

 Click Delete feild. 

 A warning dialog box will appear because delete option permanently deletes 

the records. Click yes to delete 
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Select Columns and Rows 

 To perform any operation on a column or row user must select it. 

 To select a column, click the column head. 

 To select several columns, click a column head and then drag. 

 To select a row, click the blank area to the left of the row. 

 To select several rows, click the blank area to the left of a row and then drag. 

 To select the entire table, click the Select All button in the upper-left corner of the 

table. 

Delete a Record 

 To delete a record 

 Select the record that user wants to delete. 

 Activate the Home tab. 

 Click Delete in the Records group. Or 

 Click Delete option from right-click. A prompt appears. 

 Click the Yes button. 

Resize a column or row 

 User can make the column or row as larger or smaller, if the information in a 

column or row does not display or want to fit more information on the screen. 

 User can click and drag to increase or decrease column width or row height. 

 To resize a column or row 

 Place the cursor over the line that separates two columns or two rows. 

 The cursor turns into a double-sided arrow. 

 Hold down the left mouse button and drag to increase or decrease width of a 

column or the height of all of the rows. 

Import a table into MS-Access from MS-Excel 

 User can import data from Excel into MS-Access by using the Excel Spreadsheet 

Wizard. 

 To import data from Excel 

 Open the Excel Spreadsheet Wizard 
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FIG 7.21: Import data from Excel 

 Activate the External Data tab. 

 Click the Excel button in the Import group. The Get External Data - Excel 

Spreadsheet Wizard appears. 

 Click the Browse button, the File Open window appears. 

 Locate the spreadsheet that user want to import. 

 Click the Open button. The path to the selected file appears in the File Name 

field. 

 Click OK. MS-Access moves to the next page. 

 



 E-Content of 

IT TOOLS AND BUSINESS SYSTEM 

Page | 24  
 

 

FIG 7.22: Import Spreadsheet Wizard 

 Select Show Worksheets to import a worksheet or Select Show Named 

Ranges to import a named range. 

 Click the worksheet or named range that user wants to import. 

 Click Next. MS-Access moves to the next page. 
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FIG 7.23: Select first column heading in Import SpreadSheet Wizard 

 Select First Row Contains Column Headings if the first row of user's Excel 

spreadsheet contains column headings. 

 Click Next. MS-Access moves to the next page. 
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FIG 7.24: Import SpreadSheet Wizard 

 Click a column heading to select a column. 

 Type the MS-Access table's column heading in the Field Name field. 

 Choose a Data type. 

 Indicate if the field should be indexed and if so, select the type of index. 

 Check the Do Not Import Field box for any column that user do not want to 

import. 
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 Click Next. MS-Access moves to the next page. 

 

FIG 7.25: Choosing radio button in Import SpreadSheet Wizard 

 Click to choose the proper radio button 

 If user wants MS-Access to add the primary key, click Let MS-Access add 

Primary key option. 

 If user want to add the primary key, click Choose My Own Primary Key 

and then click the down-arrow and select the field that user want to use as 

the key. 

 If user do not want to add a primary key, click No Primary Key option. 

 Click Next. MS-Access moves to the next page. 
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FIG 7.26: Naming the imported table 

 Type the name of the imported table. 

 Click Finish. MS-Access moves to the next page. 

 Finally click Close to imports the table. 

 Now MS-Access imports the excel worksheet into the access table. 
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Chapter : 7.5 Operations 

Topic : 7.5.3 Dropping 

 

Dropping  

Delete a field in Datasheet view 

 In the Navigation Pane, double-click the table from which you want to delete 

the field. The table is opened in Datasheet view. 

 Select the field (the column) that user want to delete.  

 Press Delete Field option from right click. Or 

 Or on the Fields tab, in the Add & Delete group, click Delete button. Then 

click yes to delete the column permanently. 

Delete a record in Datasheet view 

 Same method need to be followed to delete a record in datasheet view. 

 Select the record (the row) that user want to delete. 

 Press Delete Record option from right click.  

 Or Press DELETE key. Then click yes to delete the record permanently. 

Delete a table relationship 

 If the tables that participate in the table relationship are open, close them. 

User cannot delete a table relationship between open tables.  

 Then right click over the table name in the navigation pane and click delete 

option. 

 Click yes in the warning dialog box to delete a table. 

 Thus MS-Access deletes that table permanently. 
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Chapter : 7.6 Manipulation of Data 

Topic : 7.6.1 Query 

 

Query 

 User can use a query to view a subset of data or to answer questions about user 

data. 

 For example, if user wants to view a list of student names and email address, but 

user do not want to see addresses and other data, user can create a query that 

displays the student's first name, last name and email address only. 

Open Tables or Queries in Query Design View 

 To open tables or queries in Query Design View 

 

 

FIG 7.27: Open tables or queries in Query Design View 
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 Activate the Create tab. 

 Click the Query Design button in the Queries group. The Show Table dialog 

box appears. 

 Activate the Tables tab if user wants to base their query on tables, activate 

the Queries tab if user want base their query on queries or activate the Both 

tab if user want to base their query on both tables and queries. 

 Click to choose the table or query on which user want to base their query. 

 Click Add. The table appears in the window. 

 Click to choose the next table or query on which user want to base their 

query. 

 Continue clicking tables or queries until user have all the tables and 

queries their plan to use. 

 Click Close. MS-Access changes to Query Design view. 

Display All Records and All Fields 

 In Query Design view, each table has an option that allows user to display all of 

the fields and all of the records in a table.  

 This option appears on the field line on the drop-down menu as the table name 

followed by a period and an asterisk (tablename.*). 

 To display all records and all fields 
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FIG 7.28: Display all records and all fields 

 Open a table or query in Query Design view. 

 Click the down-arrow in the first field on the Field row and then select 

the tablename.* option. The table name appears on the table line. 

 Click the Run button. MS-Access retrieves all of the fields and records for the 

table and displays them in Datasheet view. 
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FIG 7.29: Display all records and all fields 

 

Sort a Query 

 While creating a query, user can sort the rows that they retrieve in ascending or 

descending order by choosing the option of their need on the Sort row in Query 

Design view. 

 Follow the steps to perform a sort 
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FIG 7.30: Sort a Field 

 Open a table or query in Query Design view. 

 Choose the field names to retrieve them. 

 Under the field click the down-arrow and then choose Ascending or 

Descending. 

 Click the Run button. MS-Access retrieves the selected columns and displays 

the rows in the order that user specified. 
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FIG 7.31: Result after running a query 
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Save a Query 

 User can save and return a saved query at any time. 

 To save a query 

 

 

FIG 7.32: Save a query 

 Click the Save button on the Quick Access toolbar. Access saves the query 

unless it saving for first time. 

 Type the name of the query in Save As dialog box. 

 Click OK. MS-Access saves the query. User can now MS-Access the query 

by using the Navigation pane. 
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Chapter : 7.6 Manipulation of Data 

Topic : 7.6.2 Data Entry Forms 

 

Data Entry Forms 

 MS-Access forms are much like paper forms. User can use them to enter, edit, or 

display data. 

 They are based on tables. When using a form, user can choose the format, the 

arrangement, and which fields to display. 

Using the Form Button 

 MS-Access can automatically create several types of forms. 

 For example, when user click the Form button on the Create tab, MS-Access 

places all fields in the selected table on a form.  

 If the table has a one-to-many relationship with other table or query, MS-Access 

creates a stacked form (the records are displayed in a column) for the primary 

table and a datasheet for the related table. 

 If there are several tables with a one-to-many relationship, MS-Access does not 

create the datasheet. 

 Follow the steps to create a form 
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FIG 7.33: Create a Form 

 Open the Navigation pane. 

 Click the table or query on which user want to base their form. 

 Activate the Create tab. 

 Click Form in the Forms group. MS-Access creates a form. 
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FIG 7.34: Department Form tab 

 User can use the Navigation bars to move through the records on a form. 

 

FIG 7.35: Navigation bar in the Form  

1 Go to First Record 

2 Go to Previous Record 

3 The Current Record 

4 Go to Next Record 

5 Go to Last Record 

6 Create a New (Blank) Record 

  

 

 To save a form 

 Click the Save button on the Quick Access toolbar. MS-Access saves the 

form unless user are saving for the first time. If user saving for the first time, 

the Save As dialog box appears. 

 Type the name user want to give the form. 

 Click OK. MS-Access saves the form. User can now access the form by using 

the Navigation pane. 

Modify a Form 

 After user creates a form, it opens in Layout view, where user can modify it. 

 To change the size of a field 

 Click a side of the field and drag to change the width of the field. 

 Click the top or bottom of a field and drag to change the height of a field. 

 To move a datasheet 

 Click the datasheet to select it. 
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 Click and drag the four-sided arrow in the upper-right corner to move the 

datasheet. 

 To resize a datasheet 

 Click the datasheet to select it. 

 Click a side of the datasheet and drag to change the width. 

 Click the top or bottom of the datasheet and drag to change the height. 

 To apply an AutoFormat 

 Activate the Format tab. 

 Click Shape fill button and choose any color for background color. 

 User can also insert background image from gallery. 

 To change the font color, style, size click Select all button then choose the 

appropriate changes. 

 Then navigate to Forms view to see the full structure of the form 

 

 To change a Form title 

 While user create a form, by default, MS-Access uses the form name as the 

title. User can change the title. 

 Activate the Format tab. 

 Click the Title button. 

 Type the new title. 

 To add the date and time 

 User can easily add the date and time in their form. 

 Activate the Format tab. 

 Click the Date and Time button. The Date and Time dialog box appears. 

Select the date and time to appear on the Form. 
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 To change Fonts and Formats 
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Chapter : 7.6 Manipulation of Data 

Topic : 7.6.3 Reports 

 

Reports 

 Reports organize and summarize data for viewing online or for printing.  

 A detail report displays all of the selected records.  

Creating Reports 

 User can include summary data such as totals, counts, and percentages in a 

detail report.  

 A summary report does not list the selected records but instead summarizes the 

data and presents totals, counts, percentages, or other summary data only.  

 MS-Access has several report generation tools that user can use to create both 

detail and summary reports quickly.  

 Use of Report Button 

 The Report button creates a simple report that lists the records in the selected 

table or query in a column format. 

 To use the Report button 

 

FIG 7.36: Report button 

 Open the Navigation pane. 

 Click the table or query on which user want to base their report. 

 Activate the Create tab. 
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 Click the Report button in the Reports group. MS-Access creates report and 

displays report in Layout view. User can modify the report. 

 

 Sections of  Report 

 

FIG 7.38: Sections of a Report 
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Use the Report Wizard 

 User can also use the Report Wizard to create a report.  

 The Report Wizard provides with more flexibility than by using the Report button.  

 User can choose the tables and fields, group the data, sort the data, summarize 

the data, choose a layout and orientation, apply a style, and title their report.  

 To create a report by using the Report Wizard 

 Open the Report Wizard 

 

 

FIG 7.39: Report Wizard Button 

 Activate the Create tab. 

 Click Report Wizard in the Reports group. The Report Wizard appears. 

 

 

 Select tables, queries and fields 
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 When using the Report Wizard, user can use fields from multiple tables 

and/or queries if the tables/queries have a relationship. 

 

FIG 7.40: Select table, queries and fields 

 Click the down-arrow next to the Table/Queries field and then click the 

table from which user want to select fields. 

 Click a field and then click the single-right arrow to select a single field, 

click the double-right arrows to select all fields, click a field and then click 

the single-left arrow to deselect a single field, or click the double-left arrow 

to deselect all fields. 

 Click Next. The Report Wizard moves to the next page. 
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 Group 

 User can group data by using Report Wizard. 

 Grouping puts all of the values in a field into a group based on the field’s 

value. 

 

FIG 7.41 : Groups 

 

 Click to select the field which user want to group their data. User may not 

see this page of the wizard if they are selecting data from a single table. 

 Click Next. The Report Wizard moves to the next page. 
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FIG 7.42: Groups in Report Wizard 

 Click a field user want to group by. 

 Click the right-arrow to select a field; click a field and then click the left 

arrow to deselect a field. Use the up and down arrows to change the order 

of the groupings.  

 Click Next. The Report Wizard moves to the next page. 
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 Sort and summarize 

 User can create up to four levels of sort by using the Report Wizard. 

 

FIG 7.43: Sort and Summarize 

 Click the down-arrow and then select the field user want to sort by. 

 Click the button to choose ascending or descending order. Clicking the 

button toggles between Ascending and Descending. User can sort up to 

four levels. 

 Click the Summary Options button. The Summary Options window 

appears. 
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FIG 7.44: Steps to sort and summarize 

 Click to select the summary data user want. 

 Click to select whether user want detail and summary data or if user want 

summary data only. 

 Click if user want to calculate the percent to the total for sums. 

 Click OK. The Summary Options window closes. 

 Click Next. The Report Wizard moves to the next page. 

 Layout and orientation 

 User can choose the layout and orientation of their report. 

 The layout determines where the each fields appears on the page. 

 MS-Access provides three options for layout to choose 

 Stepped 

 Block 

 Outline 

 Orientation determines whether MS-Access creates the report in portrait or 

landscape. 
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FIG 7.45: Layout and orientation 

 Click to select a layout. 

 Click to select a page orientation. 

 Choose the Adjust The Field Width So All Fields Fit On A Page option if 

user want all fields to fit on a single page. 

 Click Next. The Report Wizard moves to the next page. 
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 Style 

 MS-Access supplies predesigned styles that format titles, labels, and more. 

 When user choose a style, the left side of the window displays a preview. 

 

FIG 7.46: To select style 

 Click to select a style. 

 Click Next. The Report Wizard moves to the next page. 

 Create a title 

 On the final page of the Report Wizard, user can title their report. The title 

appears at the top of the report and on the Navigation pane. 
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FIG 7.47: Create a title 

 Type the title user want to give the report. 

 Click Finish. MS-Access creates, saves, and opens their report in Layout 

view. 
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FIG 7.48: Example Report 

 

Modify a Report 

 After creation of a report, user can modify it by adding groups or sorting, adding 

fields, change labels and can perform many other tasks. 

 User can view a report in Report view, Layout view, design view and Print 

Preview. 

 Change to Layout view 

 Open the report. 

 Activate the Home tab. 

 Click the View button. A menu appears. 

 Click Layout View. MS-Access changes to Layout view. 
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 To change the Size of a Field or Label 

 

FIG 7.49: Change the size of a field or label 

 Click the field or label. A border appears around it. 

 Click a side of the border and drag outward to increase the width. Click a side 

of the border and drag inward to decrease the width. 

 Add a Group or Sort 

 Use Group & Sort button on the Design tab to create a group or sort. 

 To Group or Sort 

 

FIG 7.50: Add a group or sort 
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FIG 7.51: Add a Sort 

 Click Add A Group and then select the field by which user want to group. 

MS-Access groups and sorts the field. 

 

FIG 7.52: Add a group 

 Click Add A Sort and then select the field on which user want to sort. MS-

Access sorts the field. 
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 To add a field 

 

FIG 7.53: Add Existing Fields 

 Open the report in Layout view. 

 Activate the Design tab. 

 Click the Add Existing Fields button in the Tools group. The Field List pane 

appears. 

 Click Show All Tables if the field that user want to add does not appear. 

 

FIG 7.54: Drag a field into report 

 Click the field user want to add and drag it onto their report. 

 A thick line appears on the report. MS-Access places the field before the line. 

 If user want the field to appear in the detail area, be sure to drag it to the 

detail area. 

 To delete a field 

 Open the report in Layout view. 

 Click the field user want to delete. 

 Press the Delete key. MS-Access deletes the field. 
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 To move a column 

 Open the report in Layout view. 

 Click the column label. 

 Drag the column to the new location. MS-Access moves the column to the 

new location. 

 To change a title 

 Open the report in Layout view. 

 Double-click in the Title field. 

 Click and drag to select the current title. 

 Type a new title. 

 Click anywhere outside the Title field. MS-Access changes the title. 

 To change a field label 

 Open the report in Layout view. 

 Double-click the field label. 

 Click and drag to select the label name. 

 Type the new label name. 

 Click anywhere outside the label. MS-Access changed the field label.. 

 To add page numbers 

 Open the report in Layout view. 

 Activate the Design tab. 

 Click the Insert Page Number button. The Page Numbers dialog box appears. 

 Click a radio button to choose a format. 

 Click a radio button to choose a position. 

 Click the down-arrow in the Alignment field and then choose an alignment. 

 Deselect Show Number On First Page if user do not want the page number to 

appear on the first page. 

 Click OK. MS-Access places the page number in their report. 
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Chapter : 7.7 Summary 

Topic : Summary 

 

 In this class, we have learnt about 

 data manipulation concept in database. 

 the relational database. 

 the concept of integrity. 

 the database operations such as creation, dropping and manipulating table 

structure.  

 the concept of manipulating data in query, forms and reports. 
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Chapter : 7.8 Model Questions 

Topic : Model Questions 

 

1. What is database? 

2. Explain about relational database. 

3. Explain the concept of integrity and its types. 

4. How to create a database and tables in MS-Access? 

5. How to Drop a table and database in MS-Access? 

6. How to manipulate table structure in MS-Access. 

7. Describe query in MS-Access and its manipulation. 

8. Explain forms in MS-Access and its manipulation. 

9. Define reports in MS-Access and its manipulation. 
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Assessment 1 

1. Data isolation can be avoided easily by ____________? 

a) File processing system 

b) Database management system 

c) Hardware system 

d) Software system 

2. There are how many types of integrity in database systems. 

a) One 

b) Two 

c) Three 

d) Four 

3. The __________ integrity states that the values in a table are legal according to the 

physical and the logical domain definition. 

a) Entity 

b) Domain 

c) Referential 

d) Four 

4. Which of the following is not a type of Microsoft access database object? 

a) Table  

b) Form  

c) Worksheets  

d) Modules  

5. What are the columns in a Microsoft access table called? 

a) Rows  

b) Fields  

c) Records  

d) Columns  

Answers: 

1.b 

2.d 

3.d 

4.c 

5.b 
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Assessment 2  

1. In Microsoft access Each column is called a field and each row is called a record. 

a) True 

b) False 

2. The query is used to view a subset of data or to answer questions about user data. 

a) True 

b) False 

3. MS-Access supplies predefined styles that format titles, labels, and more. 

a) True 

b) False 

Answers: 

1.a 

2.a 

3.a 
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Chapter : 8.1 Objectives  

 

Objectives 

 At the end of the course the user will be able to 

 know about the Indian IT acts. 

 know about the Intellectual property Rights. 

 understand the importance of Information Technology in various fields. 
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Chapter : 8.2 Information Technology And Society  

Topic : 8.2.1 Information Technology And Society 

 

Information Technology and Society 

 Information Technology is the use of computer software to manage information. 

 IT is one of the booming sectors in India. 

 Information Technology makes the tasks easier, it brought the world closer to us. 

 Role of IT is to store the user data and it makes the manipulation and 

transactions on those data easier. 

 Information Technology reduced the cost and work efforts of the users. 

 User can enjoy the benefits of the IT with the help of computers and smart 

phones. 

 Online shopping, Ticket booking, Social networks, Video calling, Online banking, 

etc. are some of the major factors of Information Technology. 

 IT industry plays a major role in the growth of Indian economy and also it makes 

more employment options. 

 Now a day due to the impact of Information Technology, everything had become 

online. 

 

FIG 8.1: Information Technology 
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Advantages of Information Technology (IT) 

 Information Technology has made the communication cheaper, quicker and more 

efficient. 

 IT made the world more compact and it increased the world economy. 

 IT made the business process computerized and cost effective. 

 IT made the different culture people to communicate with each other. 

 Using the concept of Online stores, IT made the business to be opened 24×7 all 

over the globe. 

 Internet and IT technology made the world more flexible. 

 

Disadvantages of Information Technology (IT) 

 Information Technology has many privacy issues. 

  User data which are stored in online can be hacked and modified. 

 IT affects the culture of the people and the youngsters are mostly been spoiled in 

their behavior. 

 The personal information of the people like account number, password, etc. can 

be hacked by the culprits. 
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Chapter : 8.2 Information Technology And Society 

Topic : 8.2.2 Need For Cyber Law 

 

Need For Cyber Law 

 The evaluation of Information Technology gave birth to the cyber crime. 

 Through Information Technology is very useful and it has made everything 

possible, it has many problems too. 

 The main problem with IT is the privacy issue. 

 The personal details which are stored in the online servers are being hacked and 

misused. 

 Bank account details, mail id password, photos, conversations, etc. are being 

hacked and misused by the hackers. 

 These types of offenses are called as cyber crime. 

 In the online world, the copyright, patent, and trademark laws protect much of the 

material found on the Internet.  

 Now a day there is a separate section in police department to deal only with 

cyber crimes. 

 With the emergence of technology, the misuse of technology has also expanded 

to its optimum level and then there arises a need of strict laws to regulate the 

criminal activities in the cyber world. 

 In order to regulate the criminal activities in the cyber world, the cyber laws were 

introduced. 

 The importance of cyber law is that it deals with almost all aspects of transaction 

and activities concerning the Internet, World Wide Web and Cyberspace in India. 



E-Content of 

IT TOOLS AND BUSINESS SYSTEMS 

 

FIG 8.2: Cyber Security 
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Chapter : 8.2 Information Technology And Society 

Topic : 8.2.3 Indian IT Act 

 

Indian IT Act 

 The Indian parliament passed its “INFORMATION TECHNOLOGY ACT 2000” 

on 17 October 2000. It is also called as IT Act. 

 This law deals with the technology in the field of e-commerce, e-governance, e-

banking as well as penalties and punishments in the field of cyber crimes. 

 Information Technology Act 2000 consisted of 94 sections segregated into 13 

chapters. 

  Information Technology Act 2000 addressed the following issues 

 Legal recognition of electronic documents. 

 Legal recognition of digital signatures. 

 Offenses and contraventions. 

 Justice dispensation systems for cybercrimes. 

 Legal recognition for transactions. 
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Some of the Important Cyber Law Provisions In India  

Section Offense Punishment 

43 

Accessing, copying data, introducing the 

virus to others computer, damage to the 

network or computer. 

He should pay the Compensation to the 

affected person, not exceeding 1 Crore. 

65 

Tampering with computer source 

documents - Intentional concealment, 

destruction or alteration of source code 

when the computer source code is 

required to be kept or maintained by law 

for the time being in force 

Imprisonment up to three years, or fine up 

to 2 lakh rupees, or both. 

66 

Hacking, destroy, delete, or altering the 

user data. 

Imprisonment up to three years, or fine up 

to 5 lakh rupees, or both. 

66-A 
Sending offensive message through any 

communication service etc., 

Imprisonment up to three years, and with 

fine. 

67 
Publishing or transmitting obscene 

material in electronic form 

Imprisonment up to five years and fine up 

to ten lakh rupees. 
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Chapter : 8.2 Information Technology And Society 

Topic : 8.2.4 Intellectual Property Rights 

 

Intellectual Property Rights 

What is Intellectual Property (IP) 

 Intellectual Property (IP) refers to creations of the mind, such as inventions, 

literary and artistic works, designs and symbols, names and images used in 

commerce. 

 The assets that cannot be seen, touched or physically measured are called as 

Intellectual Property. 

 IP can be broadly defined as creations of the mind. 

 Generation of IP involves huge investment in terms of money, talent, time etc,. 

Hence the Intellectual Property Rights (IPR) is introduced in order to avoid 

duplication and to have ownership rights over it. 

 

FIG 8.3: Intellectual Property 
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Intellectual Property Rights (IPR) 

 Intellectual Property Rights (IPR) is rights granted to creators and owners of works 

that are results of human intellectual creativity.  

 These rights Safeguard creators and other producers of intellectual goods & 

services by granting them certain time limited rights to control their use. 

 The intellectual activity may be of industrial, scientific, literary & artistic domains, 

which can be in the form of an invention, a manuscript, a suite of software, or a 

business name. 

 

FIG 8.4: Intellectual Property Rights 

Intellectual Property Rights - Issues 

 The globalization of technology and skill, emergence of new technologies, and 

the rapid development of emerging economies have jointly elevated the 

importance of IPR protection, both politically and commercially. 

 IPR has gained commercial and political salience in recent years because the 

stakes involved are huge and growing.  

 IPR violations cause job and revenue losses in rich countries. 

 Trade-Related Intellectual Property Rights (TRIPs) starting in 2006 IPR 

protection has become another hotly debated issue dividing the developed and 

developing countries. 
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Types of Intellectual Property Rights 

 Patents 

 A patent describes an invention for which the inventor claims the exclusive 

right to make, use and sell an invention for a specific period. 

 Types of Patents 

 Utility Patents 

 Design patents 

 Plant patents 

 Utility Patents 

 It can be granted to anyone who invents or discovers any new and useful 

process, machine, manufacture or composition of matter, or any new and 

useful improvement thereof.  

 Utility period is for 20 years. 

 Design patents 

 It can be granted to anyone who invents a new, original ornamental design 

for an article of manufacture.  

 A design patent has duration of 14 years from the date of filing. 

 Plant patents 

 Plant patent can be granted to anyone who invents or discovers and 

reproduces a new variety of plant.  

  A plant patent has a term of 20 years from the date of filing. 

 Copyright 

 It gives the creator of original work exclusive rights to it, usually for a limited 

time. 

 Copyright may apply to a wide range of creative, intellectual, or artistic forms.  

 It does not cover ideas and information themselves. 

 Registered Design  

 It protects the visual design of objects that are not purely effective.  

 An industrial design consists of the creation of a shape, configuration or 

composition of pattern or color, or combination of pattern and color in three-

dimensional form containing an artistic value.  
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 Trade Marks 

 A trademark is a recognizable sign, design or expression which distinguishes 

products or services of a particular trader from the similar products or 

services of other traders. 

 Trade Secrets 

 A trade secret is a formula, practice, design, instrument pattern which is not 

generally known by which a business can obtain an economic advantage over 

competitors. 

 Confidentiality 

 Confidentiality information is any information that a business regards as 

secret.  

 It can include financial information, such as business plans, or technical 

information, such as specifications or computer software.  

 Confidential information may have a significant commercial value and needs 

to be protected as an asset. 

 Plant Varieties 

 Plant Varieties also known as Plant Breeder's Rights. 

 Plant Breeder's Rights are intellectual property rights given to a person who 

has developed a variety. 

  The variety must be  

 new. 

 clearly distinguishable from any other variety whose existence is a matter 

of common knowledge. 

 

 sufficiently uniform in its relevant characteristics. 

 stable. 
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FIG 8.5: Types of Intellectual Property Rights 
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Chapter : 8.3 Applications of Information Technology 

Topic : 8.3.1 In Railways 

 

Application of Information Technology in Railways 

 Computers and Information Technology are widely used in the railway system and 

railway industry. 

 IT plays a vital role in railways. It made it more efficient and simple. 

 The online reservation system allows the users to make reservations at the comfort 

of their homes. 

 The online reservation system also integrates other related services like irctc-pnr 

status check, live train status, availability of tickets, train schedules, etc. 

 A route-based reservation system that facilitates the issue of journey-cum-

reservation tickets, which can be issued from any station to any station. 

 Passenger journey to multiple laps of reservation can be handled from a single 

terminal window, and also round the clock service. 

 Provides automatic database recovery against all kinds of hardware and software 

failures. 

 

FIG 8.6: Railway Ticket Reservation System 

 Indian railways uses Information Technology for many purposes. They are 

 Passenger Reservation System Solution . 
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 Unreserved Ticketing System for Railways. 

 Mobile Ticketing. 

 Web Ticketing.  

 Kiosk-based Ticketing. 

 Centralized (Hybrid) Ticketing System. 

 Time Table and Scheduling System.  

  Traffic Management Systems.  

 Passenger Information Display System. 

 Managing railway construction projects. 

 There are many railway mobile applications to check the live train status, ticket 

availability, and train schedules, seat numbers, PNR status etc. 

 

 

FIG 8.7: Railway Mobile Application 

 

 The cloud based train security system has been installed in some parts of India. 

  It will check for any problem in train tracks or wheels. It is mainly used for 

preventing derailments. 
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FIG 8.8: Railway Mobile Application 

 

 With the help of modern technologies, the live train location can be tracked and the 

railway station automatically manages the signal and track allocation works.  

 It reduces the waiting time of each train for the signal. 

 

 

FIG 8.9: Railway Signal And Track Control System 
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Chapter : 8.3 Applications of Information Technology 

Topic : 8.3.2 In Airlines 

 

Application of Information Technology in Airlines 

 In airlines many different systems will interact to make a plane fly safely. But all 

these systems depend on the computers. 

 Information Technology plays an overall role starting from the passenger ticket 

booking to the takeoff and landing of the flight. 

 

 

FIG 8.10: Information Technology in Airlines 

 Ticket Reservation 

 E-ticket facility enables passengers to book tickets to any destination on the 

airline‟s route network through the Internet. 

  E-Ticket is fast, safe and convenient. 

 One can make reservations by visiting or telephoning the offices and through 

over 2000 authorized travel agents throughout India and over 74 General 

Sales Agent (GSA) offices worldwide. 

 The user can book tickets through online from anywhere and at any time and 

they can use the available offers too. 
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 With the online ticket booking system, the user can plan their travel with 

different airline companies and also they can easily plan all his travel 

arrangements. 

 

 

FIG 8.11: Online Flight Ticket 

 Customer Service 

 24-hour Interactive Voice Response (IVR) system for information on the flight 

when users really need it.  

 To inform passengers in case of delay, re-routing, rescheduling or 

cancellation of a flight, flight alerts are sent on their mobile phones.  

 User immediately informs all travel agents through our Global Distribution 

Systems (GDS). 

 The flight arrival and departure time is predicted by knowing the live flight 

status and they are communicated to the passengers. 

 Thus the passengers can plan their schedule according to the flight schedule. 
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FIG 8.12: Flight Timing Schedule 

 Security Services 

 Many security services of the airport rely on the computers. 

 Security screening machines such as luggage scanning, face recognition rely 

on the computers. 

 Many techniques are used to identify the drugs, diamonds etc. 

 

FIG 8.13: Luggage Scanning 

 Air Traffic 

 Computers are crucial to an airport air traffic control services. 

 Computers allow air traffic controllers to visualize and track the location of 

planes in the air and then instruct pilots as to the correct course of action. 

 In air traffic, controlling the devices used are all computer based. 
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FIG 8.14: Air Traffic Control 

 

 Autopilot Flight Director System 

 The autopilot system uses the computers. This relieves the pilots of many in-

flight tasks, allowing the plane to process navigational data and flight control 

systems. 

 Additionally, some airplanes have wing flaps that can be controlled by a 

computer.  

 Others airplanes have power systems that can be regulated by computer. 

 The computers are essential for the communication and recording the flight 

data which plays a vital role for the air traffic controllers. 
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FIG 8.15: Auto Pilot Mechanism 

 

 Flight Management System (FMS) 

 The Flight Management System (FMS) is the fundamental component of the 

modern flights. 

 It provides centralized flight deck control of the plane‟s flight path & 

performance parameters.  

 FMS is a specialized computer system that automates a wide variety of in-

flight tasks and it reduces the workload on the flight crew. 

 

 

FIG 8.16: Flight Management System 
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Chapter : 8.3 Applications of Information Technology 

Topic : 8.3.3 In Banking 

 

Applications of Information Technology in Banking 

 Information technology has been acknowledged as the life wire of banks in the 

financial sector as it promotes and facilitates the performance of banks in the 

country. 

 The banking sector is now no more confined to the narrower field of a particular 

region, state or a country. 

 Introduction of computerized application has bought a new concept of Internet 

Banking. 

 Information Technology made the banking sector as more efficient and effective. 

 Indian banking industry is the second largest spender to the IT industry. 

 The application of IT in banking sector provides enormous benefits to the banks 

as well as its consumers. 

 Information technology has been the basis of recent financial sector reforms 

aimed at increasing the speed and reliability of financial operations and of 

initiatives to strengthen the banking sector. 

 The IT revolution has set the stage for unprecedented increase in financial 

activity across the globe and it provides solution to take care of their accounting 

and back office requirements. 

 The progress of technology and the development of worldwide networks have 

significantly reduced the cost of global funds transfer. 

 This has, however, now given way to large scale usage in services aimed at the 

customer of the banks. 

 IT also facilitates the introduction of new delivery channels in the form of  

 Automated Teller Machines (ATM). 

 Net Banking. 

 Mobile Banking. 
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 Credit card. 

 

            

           

FIG 8.17: Role Of IT In Banking 

 Banks are interconnecting their computer systems not only across branches in a 

city, but also to other geographic locations with high-speed network 

infrastructure, and setting up local area and wide area networks and connecting 

them to the Internet.  

 The advantages due to IT in banking is as follows 

 Anytime banking. 

 Telebanking. 

 Electronic banking. 
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 Banks can provide wide range of customer support. 

 A transaction through banks increases. 

 Banks can manage the user accounts easily. 

 Burden on bank employers got reduced. 
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Chapter : 8.3 Applications of Information Technology 

Topic : 8.3.4 In Insurance 

 

Applications of Information Technology in Insurance 

 The volume of transaction is very large in any insurance organization. 

 The data and information are to be stored for a longer period because insurance 

contracts are long term especially life Insurance contracts. 

 Insurance related IT applications makes the insurance sector to provide more 

services to its clients and also it made the task of making calculations and 

maintaining records easier. 

 IT made insurance sector more effective and efficient.  

 Some of the IT applications are as follows 

 Services on Existing Policies 

 New Business  

 Renewal 

 Loans  

 Offers  

 Statistics  

 Premium  

 Valuation 

 Services on Existing Policies 

 The existing policy holders may require many services after taking the 

insurance. 

  IT applications will help them to provide instant service for the customer 

queries by using a single application. 
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 New Business  

 As and when the customer needs a new insurance, the customers previous 

available information can be used instead of getting and processing it again. 

 Renewal  

 Renewal notifications and other alerts can be sent to the available huge 

amount of customers at the right time. 

 Even birthday and festival wishes can also be sent at the right time. 

 Loans  

 The policy holders can take loans on their available policies and the records 

needed to it can be maintained easily. 

 Offers  

 According to the punctuality and business of the users, special offers can the 

given to the valuable customers. 

 Statistics  

 The statistics and overall performance of the company and a product can be 

obtained by processing the huge data stored in the database. 

 It will help to improve the service and the business. 

 Premium  

 Calculation of premium amount for each month based on policy duration and 

interest due to any fine amount can be calculated easily. 

 Valuation  

 Calculation of policy matured amount involves many strategies; it can be 

done with the help of policy management applications. And they are more 

accurate too. 
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FIG 8.18: Role of IT in Insurance 
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Chapter : 8.3 Applications of Information Technology 

Topic : 8.3.5 In Inventory Control 

 

Applications of Information Technology in Inventory Control 

 An inventory control system is the hardware or software component which is 

used to manage all aspects of company's inventories; purchasing, shipping, 

receiving, tracking, warehousing and storage, turnover and reordering. 

 Computerization has revolutionized inventory management, as technologies 

ranging from automatic scanners to radio frequency identification chips. 

 Inventory control is important to ensure quality control in businesses that handle 

transactions revolving around consumer goods. 

 Inventory control software keeps track of all information about the company 

builds, buys, stores and sells. 

 There are many applications of Inventory control software, some of them are 

 Receipt of Goods 

 Retail Turnover 

 Stock Management and Cost Reduction 

 Receipt of Goods 

 A retail store or a central warehouse uses bar code or radio-frequency 

identification scanning at the point of receipt of goods.  

 Scanning individual items or shipment pallets allows a company to itemize all 

shipments from the supplier, which can be compared against the purchase 

order for errors or losses in transit.  

 When your business ships these goods out of the warehouse to their point of 

sale, a second scan can automatically tally the remaining stock in the 

warehouse, and send messages to the purchasing managers indicating that it 

is time to reorder. 

 And also the receipt of the product will also get generated by storing the sales 

details in the database which can be used later for sales analysis. 
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 Retail Turnover 

 The sales records are used to calculate the total turnover and available stock 

details. 

 Many businesses use similar scanning techniques at the point of checkout. 

 As of 2010, bar code scanners are more popular than RFID for this purpose. 

 Both will automatically enter the correct price at the register and prevent data 

entry errors.  

 With the help of the sales details, the business statistics and the growth of the 

company can be calculated. This will helps to improve the business and to 

provide great service to the customers. 

 The overall profit, loss and expense of the company can be calculated easily. 

 Stock Management and Cost Reduction 

 The process of moving goods through a company's pipeline is always 

economically inefficient.  

 The purchase of the goods represents an investment of the company, and the 

company won't get profit until the inventory is sold.  

 Computerization provides a real-time picture of this entire workflow process, 

and allows managers to reduce purchasing costs through  

 Minimizing inventory. 

 Increase the efficiency of internal shipping systems. 

 Reduce the possibility of theft or damage by being able to track each item 

down to the individual staffer who takes responsibility for it. 

 Inventory control system has many benefits such as 

 Improves customer satisfaction. 

 Minimizes the investment in stocks. 

 Time efficient in maintaining stock and sales details. 

 Avoids overstocks. 

 Some of the inventory control software are 

 PartKeepr. 

 Inventory Tracker. 
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 SOS Inventory. 

 inFlow. 

 Retail Inventory. 

 ABC Inventory. 

 

      

     

FIG 8.19: Role Of IT In Inventory Control 
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Chapter : 8.3 Applications of Information Technology 

Topic : 8.3.6 In Financial Systems 

 

Applications of Information Technology in Financial Systems 

 Information Technology allows finance to function on a global level.  

 Financial markets can be thought of as the first organized, global information 

markets operating through networked computers. 

 

 

FIG 8.20: Role Of IT In Financial Systems 

 

 Without information technology, financial markets couldn't react to global 

developments and finance companies couldn't consistently acquire information at 

the same time as their competitors. 

 Reserve Bank of India undertook important steps covering IT infrastructure and 

implementation of new applications to ensure safety, security, soundness, 

efficiency, accessibility and authorization in the payment and settlement systems. 

 Due to the impact of Information Technology, many new technologies are 

introduced in the financial sector. They are as follows 



E-Content of 

IT TOOLS AND BUSINESS SYSTEMS 

 Core Banking Solutions (CBS)  

 Automated Teller Machines (ATMs)  

 Electronic Clearing Service (ECS)  

 Real Time Gross Settlement (RTGS)  

 Prepaid Payment Systems  

 Core Banking Solutions (CBS)  

 Core Banking Solutions (CBS) is networking of branches, which enables 

customers to operate their accounts and avail of banking services from any 

branch of the Bank on CBS network, regardless of where the customer 

maintains his/her account.  

 Thus, CBS is a step towards enhancing, customer convenience through, 

Anytime-Anywhere Banking. 

 Automated Teller Machines (ATMs)  

 It is one of the great services provided by the banks to the customers.  

 Account holders can collect money from any nearby ATMs, at any time.  

 There is no need of carrying money during travel. 

 Electronic Clearing Service (ECS)  

 Electronic Clearing Service (ECS) is an electronic mode of payment / receipt 

for transactions that are repetitive and periodic in nature.  

 ECS is used by institutions for making bulk payment of amounts towards 

distribution of dividend, interest, salary, pension, etc. Essentially, ECS 

facilitates bulk transfer of money from one bank account to many bank 

accounts or vice versa. 

 Real Time Gross Settlement (RTGS)  

 This Real Time Gross Settlement (RTGS) is a continuous settlement of funds 

transfer individually on an order by order basis. 

 „Real Time‟ means the processing of instructions at the time they are received 

rather than at some later time.  

 „Gross Settlement‟ means the settlement of funds transfer instruction occurs 

individually. 
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 Prepaid Payment Systems  

 Prepaid payment facilitates the purchase of goods and services against the 

value stored in the user accounts.  

 The pre-paid payment can be made with the help of smart cards, magnetic 

stripe cards, internet accounts, internet wallets, mobile accounts, mobile 

wallets, paper vouchers, etc. 

 There are also several other features such as internet banking and mobile 

banking which are explained in previous sections. 

 

 

FIG 8.21: Electronic Clearing service 

 

FIG 8.22: Role Of IT in Banking Services
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Chapter : 8.3 Applications of Information Technology 

Topic : 8.3.7 In Hotel Management 

 

Applications of Information Technology in Hotel Management 

 Advertisement And Online Booking 

 The information Technology plays a vital role in advertising a hotel. 

 The hotel wants to be visited by many clients .Hence the hotels make a 

website that contains the location of the hotels and what are the amenities. By 

doing these tourist from all parts of the world will know the hotel. 

 The advertisement of hotels will also be available in several tickets booking 

websites. 

 Thus the IT makes the hotels grow in their business. 

 Social networking portals like Facebook, Twitter, etc., are increasingly playing 

a dominant role in strategies of hotels all over.  

 User generated feedbacks and reviews on such websites play a huge role in 

popularizing the hotel. 

 It is easy for hotels to stay in touch with and maintain relationships with ex-

clients by making use of online tools. 

 The users can easily book the hotels according to their needs and budget 

with the help of android applications and websites. 

 List of websites to book hotel rooms are 

 goibibo.com 

 ixigo.com 

 yatra.com 

 easemytrip.in 
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FIG 8.23: Online hotel booking 

 Room Allocation And Management 

 The hotels will use the room management software to know about the 

available vacant rooms and room vacating time and the details of the 

customers staying in the hotel. 

 It helps them to maintain customer records for future use and also to have 

future relationship with their customers. 

 Intercom and several other security features can be installed in hotels with the 

help of IT. 

 

 

FIG 8.24: Hotel Management Application 
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 Taking Orders And Billing 

 In several coffee shops the orders and billing are made using the software 

applications. 

 The customers can use the discount coupons to avail their offers. 

 The payment is made using the credit or debit cards. 

 iPod and other devices are used to orders from the customers. 

 

FIG 8.25: Billing in Coffee Shops 

 

Application of Information Technology in Education 

 The Role of Information Technology in Education is exploring the potential for 

technology to redefine the terms of teaching and learning. 

 Books are limited in their advantages.  

 They cannot be updated and they are accessible only to the persons who are 

physically present. 

 Digital information technology surpasses books in every way.  

 The information may be saved anywhere and also it can be easily shared, the 

Internet allows universal access and search ability and it can be easily updated. 
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FIG 8.26: Information Technology in Education 

 Information Technology has made the greatest impact on classroom experience. 

 The modern internet technology allows the instructor, the possibility of providing 

immediate access to the world wide data sources to the students. 

 IT made the students think wider and also to search for more information about a 

topic. 

 The technologies such as PowerPoint, MS Word, etc. decreased the cost spent 

on study materials and it made data sharing easier. 

 IT made the teaching and learning through a variety of available resources. 

Information about any topic can be easily accessed. 

  It made the information available at anytime and anywhere. 

 Due to the impact of IT, it is easy to get authentic and up-to-date information. 

 Multimedia concept of learning and teaching came into effect in the field of 

education, which is more interactive and interesting. 

 Smart class systems are being implemented in all educational institutions. 

 The concepts of Collaborative learning made it easy to study as well as teach in 

groups or in clusters. 
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 Internet supports thousands of different kinds of operational and experimental 

services which is called as an online library. Plenty of information can be 

gathered from it. 

 The concept of distance education has emerged which does not needs the 

students to be physically present in the classroom. 

 Information Technology has made the drastic changes in teaching the disabled 

persons, by introducing many software applications. 

 New technologies can be learnt from the online tutorials available in internet. 

 Now a days there are many android applications are available, which are 

education oriented, such as E-books, tutorials, etc. We can download and install 

those things from play store. 

 Applying for several public exams and college entrance exams are all done in 

online. Even online exams are also conducted through internet. 
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Chapter : 8.3 Applications of Information Technology 

Topic : 8.3.9 In Video Games 

 

Application of Information Technology in Video Games 

 Video games are the electronic games that make humans to get relaxed. 

 It gets the input from user and generates a visual feedback. 

 Video games have become an important part of contemporary global 

entertainment and media. 

 In olden days the video games were played only on television. But now 

computers and smart phones are the major components of games. 

 Games can assist in the development of skills and proficiency by making users 

interact with digital objects and manipulate variables.  

 Their development involves educational scientists, learning psychologists and 

game developers in order to state learning objectives, which can be achieved 

with relevant activities. 

 Due to the growth of Information Technology, new technologies and games are 

being introduced. Thus the number of game players is always increasing, 

irrespective of the age of people. 

 Mobile games and play stations are the latest technologies in gaming. 

 In social gaming user can connect two or more players through internet and play 

games along with them. It can also be done with Bluetooth also. 

 Video games are great partners to the players when they feel bored, lonely and 

mentally disturbed. 

 There are many types of video games. They are 

 Casual Games 

 Serious Games 

 Educational Games 

 Casual Games  
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 They are simple and easy to understand. And also while playing casual 

games one can jump in and out of the play on demand. It includes video 

games such as Solitaire or Minesweeper which can commonly be found pre-

installed with many versions of the Microsoft Windows Operating System. 

 Serious Games 

 They are designed primarily to convey information or a learning experience of 

some sort to the player. Some serious games may even fail to qualify as a 

video game in the traditional sense of the term. 

 Educational Games 

 The educational video games have the purpose of teaching their users about 

a chosen subject, expanding existing knowledge or assisting in acquiring a 

certain skill while playing. Educational video games exist for children and 

adults alike and on different platforms. 

          

      

FIG 8.27: Information Technology In Video Games 
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Chapter : 8.3 Applications of Information Technology 

Topic : 8.3.10 In Telephone Exchanges 

 

Application of Information Technology in Telephone Exchanges 

 A telephone exchange is a telecommunications system used in the public 

switched telephone network or in large enterprises.  

 An exchange consists of electronic components that interconnect (switch) 

telephone subscriber lines or virtual circuits of digital systems to 

establish telephone calls between subscribers. 

 In the telecommunications field, a telephone exchange, or switch is a call 

transferring or switching system comprising of electronic components that 

connects telephone calls. 

 It is a central system of switches and other equipment mainly referred as a 

central office that establishes a speech link between users. 

 In 1918 manual switching of calls was being done, And it took an average time of 

15minutes to connect a long distance call. It was time taking and uneconomical. 

 Thus automatic exchanges or dial service was introduced whose major purpose 

was to eliminate the need for manual switching done by human telephone 

operators. 

 It replaced the human operators with Computerized exchanges. The brain of an 

automatic exchange is a telephone switch which is a device for routing or 

transferring calls. 

 The switching system in the exchange can be divided into three main sub units    

 Trunk groups. 

 The switching network. 

 The common control. 

 A telephone switch is a piece of equipment that connects the phone call, based 

on hardware or hardware and software (soft switch). It is used for call 

transferring, switching or routing. Switches are used in both local central offices 

and in long distance branches and centers. 
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 Soft Switch 

 Soft switches are the processing devices (to control call) that receive call 

requests for users and then assign call connections directly between the 

communication devices. Soft switches only setup these connections and do 

not actually transfer call data.  

 Soft switches were developed to replace the existing End Office (EO) 

switches which have limited interconnection capabilities. 

 To transfer the communication path connections from high capacity dedicated 

lines to other packet networks that are more efficient e.g. packet data on the 

Internet. This allows a soft switch to operate anywhere without any need to be 

connected to a high capacity trunk connection. 

 

    

FIG 8.28: Soft Switch 

 

 

 

 

 



E-Content of 

IT TOOLS AND BUSINESS SYSTEMS 

Chapter : 8.3 Applications of Information Technology 

Topic : 8.3.11 In Mobile Technology 

Application of Information Technology in Mobile Technology 

 The mobile phone is rapidly becoming the user device and it became as a part of 

our life.  

 Mobile phones have already started functioning as more than just 

communications devices. Even with the limited free games that come with basic 

phones, they are already good for "time-pass". 

 The older generation mobiles were only used to make calls and sending SMS. 

But now a days due to the huge impact of information technology, mobile phones 

had bought the entire world into our palm. 

 Mobile phones have become more compact and efficient.  

 Smart phones are the latest mobile phones, and due to the availability of android 

and other mobile applications, The usage of mobiles had reached a great extent. 

 Smart phones with internet can be used for anything. Usage of social websites 

has made the world smaller. 

 One can communicate with any other person in any part of the world easily. 

 Smart phones and emergence of Information Technology has made the life 

easier and simple. 

 Now a day's smart phones can be used as a mini computer. 

 Some of the applications of Information technology for mobile phones are as 

follows 

 Video calling and voice chats. 

 Saving contacts. 

 Sending SMS and multimedia messages. 

 To save notes and reminders for important events. 

 Scheduling works. 

 Sending and receiving mails. 

 Browsing on the internet. 
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 Camera. 

 Online shopping. 

 Photo editing. 

 Study applications. 

 Online banking. 

 Playing games. 

 Ticket booking. 

 Music player. 

 YouTube. 

 Wide usage of Social Networks. Etc. 

 Thus, Smart phones have a wide range of usages in the modern world. It makes 

our life simpler and modern. 

 

 

FIG 8.29: Usage of smart phones 

 

FIG 8.30: Social networks 
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Chapter : 8.3 Applications of Information Technology 

Topic : 8.3.12 In Information Kiosks 

Application of Information Technology In Information Kiosks 

 In Information Technology, a kiosk is a small physical structure which includes a 

computer and a display screen, that displays information for people in public 

areas or on business premises. 

 The word is of Turkish and earlier Persian origin, where it meant an outdoor 

pavilion or a portico. 

 A number of companies specialize in creating multimedia kiosks. 

 A simple kiosk can be created using HTML pages and graphics, removing the 

Web browser's toolbar so that the display screen is effectively in "kiosk mode." 

 Kiosks are commonly near the entrances of shopping malls where they provide 

shoppers with directions. 

 Kiosks are also used at trade shows and professional conferences. 

 More sophisticated kiosks let users interact and include touch screens, sound, 

and motion video. 

 The technological capabilities of the information kiosk touch screen and 

information kiosk software are virtually limitless. 

 The information kiosk touch screen eliminated many of the issues associated 

with a keyboard interface. 

 Combined with ever-improving software security, many companies and industries 

have found innovative ways to conduct business directly through these kiosks. 

 Information kiosks and Internet kiosk systems utilize similar software and 

hardware platforms to perform somewhat different functions. 

 Information kiosks are designed to provide access to one or more focused 

applications, such as browsing a store's product catalog or learning about a 

venue's available service. 
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 Internet kiosks, on the other hand, provide on-demand access to a wide variety 

of Internet sites, email, and more in exchange for a per-minute fee.  

 Recently, the line between these devices has blurred, with some newer kiosk 

systems providing aspects of both. Whether you are working on computer 

information kiosks or an Internet kiosk system, make sure that your software 

offers a secure, locked down environment and robust kiosk management tools. 

 Like other types of self-service kiosks, informational and Internet kiosks typically 

utilize a strong, industrial-strength housing along with a number of specialized 

peripherals, such as card readers and thermal receipt printers. 

 Information kiosks are mainly used in, 

 ATMs and Financial Services. 

 Casinos and Gaming. 

 Restaurants and Service Vendors. 

 Employees and the Workplace. 

 Advertisement. 

 Railway PNR status. 

 

FIG 8.31: Railway Ticket checking 
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FIG 8.32: Advertisement 

 



E-Content of 

IT TOOLS AND BUSINESS SYSTEMS 

 

Chapter : 8.3 Applications of Information Technology 

Topic : 8.3.13 In Special Effects in Movies 

 

Application of Information Technology in Special Effects in Movies 

 The special effects field involves the creation of specialty crafts and visuals for 

movies, television or websites. 

 Special effect includes stunts, animations, Make-up etc. 

 

 

FIG 8.33: Capturing with Artificial sets 

 Special effects technicians work with numerous materials or computer programs 

to create visuals and effects for entertainment purposes. 

 Special effects occupy a privileged phenomenological position insofar as in a 

world that is becoming increasingly oblique, invisible, distant, computerized, 

special effects dramatize or foreground the act of perception as such. 

 The growing use of computer animation and computer-generated imagery has 

produced increasingly elaborate and realistic visual effects. 
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 Special effects are amazing to watch. In one commercial, an object stops in mid-

air and the camera pans around it.  

 A simpler technique is used in this concept. A collection of still cameras (for 

example, 30) is set up around the object. At the moment when the action should 

freeze, all 30 cameras fire at once. The images they capture are played one after 

another to show the rotation. 

 Not only the rotation occur, but the object is also moving in slow motion during 

the rotation. At least five different special-effect techniques are combined to 

create the final image. 

 A large number of still cameras capture the scene, but they fire sequentially 

around the actor rather than all at once. 

 The cameras shoot the object on a blue-screen background. The object is 

suspended with a wire from the ceiling so that it can fall only part-way or 

appear to float in mid-air. 

 

 

FIG 8.34: Making the object as it floats in air 

 

 Once the scene is shot, software similar to morphing software interpolates 

between the images to allow the slow-motion feel. The filmmaker can 

therefore slow down or speed up the action at will. 

 Computer-generated backgrounds are then superimposed onto the film. 
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 A technician deals with these entire imperfections one image at a time using a 

computer and digitized versions of the images. Once the still images are perfect, 

the morphing software interpolates between them. Then the background images 

are laid into the blue area.  

 

 

FIG 8.35: Capturing on Blue screen 

 A technician has to build a complete 3-D computer model of the computer-

generated scene and then key the rotation through this scene to the position of 

the camera in each frame of the film. 

 Some of the software used for animation are as follows 

 Autodesk 3dsmax. 

 Autodesk Maya. 

 Motion Builder. 

 Stop Motion Pro. 

 Adobe After Effects. 

 Final Cut Pro. 

 GameBryo. 
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FIG 8.36: Changing the background as real environment 
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Chapter : 8.4 Summary 

Topic : Summary 

 

 In this class, we have learnt about 

 Information Technology and Society. 

 Indian IT act. 

 Applications of Information Technology  

 Intellectual Property Rights. 
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Chapter : 8.5 Model Questions 

Topic : Model Questions 

 

Model Questions 

 What is Information Technology and Society. 

 What are the pros and cons of Information Technology 

 Explain Indian IT act. 

 Brief note on Intellectual Property Rights. 

 List out the applications of Information Technology  
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Assessment 1  

1. Accessing Bank account details, mail id password, photos, conversations, etc., 

these types of offenses are called________. 

a) Stealling 

b) Cyber crime 

c) Network crime 

d) Threat 

2. There are how many types of intellectual property rights have_______. 

a) Five 

b) Six 

c) Seven 

d) Eight 

3. _________ switches are the processing devices that receive call requests for users 

and then assign call connections 

a) Soft 

b) End 

c) Handwired 

d) All of the above 

4. In Information Technology, a __________ is a small physical structure which 

includes a computer and a display screen, that displays information for people in 

public areas or on business premises. 

a) Mobile 

b) Kiosks 

c) Education 

d) Hotel management 

5. ___________ System controls Time efficient in maintaining stock and sales details. 

a) Inventory 

b) Insurance 

c) Financial 

d) Education 

Answers: 

1.b 

2.c 

3.a 

4.b 

5.a 
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Assessment 2 (True/False) 

1. Indian banking industry is the second largest spender to the IT industry. 

a) True 

b) False 

2. Security screening machines such as luggage scanning, face recognition rely on 

the computers. 

a) True 

b) False 

3. Confidential information is any information that a business regards as secret.  

a) True 

b)  False 

 

Answers: 

1.a 

2.a 

3.a 
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